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DriveRight FMS Help 

Welcome to DriveRight Fleet Management Software 

Click on the topics below for help using DriveRight® Fleet Management Software (FMS) version 
3.9.3: 
  

Getting Started - How to get your DriveRight software rolling. 

Quick Reference - Basic info and quick links for routine tasks. 

Menu Commands - Everything you can do in DriveRight FMS. 

Troubleshooting - Help when you have problems. 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

September 17, 2009 

Getting Started Menu 

Getting Started Menu 

The following help topics will help you getting started with DriveRight Fleet Management 
Software. 

 

Introduction to FMS 

What's New for DriveRight FMS 3.9.3 

Release Notes for Versions 3.9.2, 3.9.1, 3.8, 3.7.2, 3.7.1, 3.7, 3.6, 3.5, 3.4, 3.3, 3.2, 3.1, and 3.0 

Architecture 

Database Selection Guidelines 

Converting VMS 2.04-2.06 Data for FMS 

Setup Overview 

Tool Bar 

 

Back to Home 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Introduction to DriveRight FMS 
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The DriveRight Fleet Management Software (FMS) allows you to store, view, and manipulate 
DriveRight data on your Windows-compatible computer. More specifically, FMS provides tools for 
acquiring, sorting, tracking, analyzing and printing data, and viewing and printing reports for a 
number of individual DriveRight consoles and CarChip devices at a number of different locations.  

DriveRight FMS features include: 

 Tracking drivers, vehicles, locations, and service 

 Viewing, graphing, printing and saving "accident log" information 

 Multiple user levels  

 Ability to download DriveRight information via the optional SmartCard System  

 Ability to download DriveRight and CarChip information via the optional Wireless 
Download System 

 Tamper logs 

 Sorting data and creating reports according to user-defined selection criteria 

 Summarize data by day and by trip 

 Integrated Microsoft MapPoint, Google EarthTM, and Google MapsTM support for mapping 
of GPS data 

 Compare vehicles, drivers, or groups of drivers 

 FTP Export / FTP Import data 

See also: 

Architecture 

Copyrights 

Back to Getting Started 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

What's New for DriveRight FMS 3.9.3 

DriveRight Fleet Management Software version 3.9.3 includes the following changes: 

 FMS is now compatible with MapPoint 2009. 

 A Graphical Day Report has been added and can be accessed from Reports > Graphical 
Day Report menu. 

 A Hard Acceleration Report has been added to Reports > Exception Reports. 

 CarChip "restore settings" feature has been added to this release and can be accessed 
from the CarChip > CarChip Settings > Restore. This command will reset the CarChip 
settings with the database record of the selected CarChip. 
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 A "Set Anomalous Vehicle" command is now available in FMS.  The anomalous vehicle 
can be set using Add New CarChip wizard.  It can also be set through CarChip > Set 
Anomalous Vehicle or CarChip > CarChip Settings > Set command.  Please note that this 
feature is not for pre-CAN versions of CarChip.  Supported excepted vehicles and 
protocols depend on the firmware version. 

 Oracle login password has been encrypted to improve security. 

 Connection and query timeout for Microsoft SQLServer has been increased to 120 
seconds. 

 Calculation of Time Over Speed has been improved to be more accurate. 

 The calculation of Max Download Days in the Driver Safety Score report has been 
modified for accuracy. 

 SmartCard Reader Driver has been upgraded in FMS Setup programs. 

 Print and Print Preview for the Accident Log Report have been fixed. 

 This release was built with CarChip.dll 3.2.2.0. 

 

Back to Getting Started 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Prior Release Notes 

DriveRight Fleet Management Software v3.9.2 Release Notes 

DriveRight Fleet Management Software version 3.9.2 includes the following changes: 

 Google EarthTM and Google MapsTM are added as additional mapping tools to MapPoint. 
Users may select their mapping tool from  
Mapping > Select Mapping Tool. Once a mapping tool is selected, Trip Maps, Day Maps 
and Accident Log maps will be generated using the selected mapping tool. Mapping with 
Google Maps requires an internet connection and a web browser to work. Mapping with 
Google Earth requires a copy of that program, which may be downloaded at no charge 
from Google’s web site.  

 New wireless device firmware version 10E0 is available in this release. User may update 
the firmware of Base Stations and Wireless On-Board Modules through Wireless > 
Upgrade Firmware. 

 To improve performance and reduce the file size of the Access database, FMS will 
compact the database when the user exits if MS Access is the database type currently in 
use. This process will not require the user's confirmation. In case of error, an error 
message will be logged in EventLog.txt. 

 Import/Export, FTP Import/Export, and Backup/Restore features are now supported for 
the database table TroubleCodes and ReadinessCodes.  
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 The Database > Maintenance menu is now enabled/disabled properly according to user's 
privileges. 

 In filter dialogs of Driver Safety Score report and Driver Safety Score Summary report, 
the current location is used as default selection for Company Locations list. 

 The Company Name field in Add/Edit Company Location dialog is fixed to allow company 
name up to 40 characters and will automatically scroll horizontally. 

 In Trip Summary Report, dashes are displayed for the Idle Time column if the trips are 
from DR500. 

 This release was built with CarChip.dll 3.2.1.0. 

  

DriveRight Fleet Management Software v3.9.1 Release Notes 

DriveRight Fleet Management Software version 3.9.1 includes the following changes: 

 A new comprehensive report is added to this release to show Vehicle Activities. Users 
can generate a report for a date range, selected vehicles, or drivers with exception limit 
settings. This report can be viewed in FMS report viewer or in an Excel file. It can be 
accessed from the Reports menu, and Email support has also been added to this report.  

 Weekend and Night settings have been moved from the Usage Report to the system 
level and can be accessed from  
Setup->Preferences. These settings are now shared by the Usage Report, Wireless 
Download, and the Vehicle Activity Report. 

 The GPS map has been improved to show coordinates within (-3, 3). 

 This release was built with CarChip.dll 3.2.1.0. 

 

DriveRight Fleet Management Software version 3.9. was a Beta Release, and included the 
following changes: 

 Idle time feature (CarChip only) is implemented in this release. Idle time for each trip is 
stored in database Trips table.  A user may run the Trip Summary Report to show the idle 
time for each trip and total idle time for a driver or vehicle. The report can be viewed in 
FMS report viewer or in an Excel file, and Email support has also been added to this 
report.  

 FMS is improved to handle trouble codes during download to avoid trouble codes missing 
problems.  

 Oracle database migration issues to FMS 3.8 release are solved. 

 A problem was corrected wherein DriveRight type was not being displayed when adding 
a new DriveRight device. 

 The text limit for user name and password was increased for FTP Import and Export. 

 This release was built with CarChip.dll 3.2.1.0. 
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DriveRight Fleet Management Software 3.8 Release Notes 

DriveRight Fleet Management Software version 3.8 includes the following changes: 

 The CarChip Fleet Pro (#  8246) model is now supported in this release.  

 GPS has been implemented for CarChip Fleet Pro and is included in the CarChip 
Settings and Add New CarChip Wizard -Parameters/GPS Settings dialog boxes in the 
CarChip menu. The GPS setting allows you to turn on the GPS logging and subsequent 
mapping feature. This setting works only with a CarChip Fleet Pro model connected to 
the optional GPS (# 8251, 8128) modules. The GPS data is stored in the database and 
allows you to create Trip Maps, Day Trips Maps and Accident Maps. 

 DriveRight Wireless Download System functionality has now been added for CarChip 
Fleet Pro. Along with the CarChip Fleet Pro GPS/Wireless Interface Module (# 8251), the 
Base Station (# 8130), Wireless On-Board Module (# 8129), and the Configuration Cable 
for Wireless On-Board Module (# 8131) give your fleet the ability to download data 
directly from CarChip Fleet Pro models to FMS without physically removing the 
DriveRight devices from the vehicle. The data moves wirelessly from the vehicle to the 
FMS database. The actions that can be taken when wirelessly downloading a Carchip 
Fleet Pro can be edited in the Edit CarChip dialog box. 

 The Download Options dialog box has changes to give you more flexibility in the speed 
sample downloading settings.  

 The Carchip Parameter Logs database table has been added to the Database Menu. 
The following dialog boxes have been added to supplement the CarChip Parameter Logs 
database table: Filter for CarChip Parameter Logs, Print CarChip Parameter Logs, and 
Filter for Deleting CarChip Parameter Logs. 

 Audible alarm volume can now be adjusted in the Set CarChip Alarm dialog box for the 
CarChip Fleet Pro model of Carchip. 

 Trouble codes are recorded during trips more accurately. 

 The Add New User and Edit User dialog boxes have been changed to add Corporate 
Structure as one of the application options. 

 The factors in the Driver Safety Report Formula are improved to make the performance 
score more accurate. 

 MSDE installation is no longer supported by FMS installation. MSDE must be installed 
manually before FMS is installed if MSDE is the database you which to use. 

DriveRight Fleet Management Software 3.7.2 Release Notes 

DriveRight Fleet Management Software version 3.7.2 includes the following changes: 

 Fixed an issue regarding the PIN code transferred by the SmartCard Reader not being 
recognized by the DriveRight Device. 

 Duplicate database record error issue was resolved. 

DriveRight Fleet Management Software 3.7.1 Release Notes 
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DriveRight Fleet Management Software version 3.7.1 includes the following changes: 

 Password encryption has been added for better security. 

 The ability to add multiple Super Users to the database added. Open the Update User 
Privileges dialog box or Add New User dialog box to add or edit Users and change the 
User Type. 

 The Driver Safety Score and Excessive Speed Report changed to accurately calculate 
when Km/hr is selected as the unit of measure in the Units dialog box. 

 The CarChip database table automatically updates if any changes, such as Alarm and 
LED state, have been made by the user in FMS. 

 The ACS SmartCard Desktop Reader Proprietary Driver is the only driver to be used with 
FMS.  The ACS Proprietary Driver installation process has now been simplified. If the 
PC/SC driver was installed, it must be removed and the ACS Proprietary Driver must be 
installed. 

 Database configuration process has been improved to enforce database security and 
avoid object ownership problems in MS SqlServer database. 

DriveRight Fleet Management Software 3.7 Release Notes 

DriveRight Fleet Management Software version 3.7 includes the following changes: 

 DriveRight Wireless Download System functionality is added to FMS. The Wireless Menu 
contains commands for configuring wireless devices, controlling the wireless 
communication and downloading features for the Wireless Download System. These new 
features, along with the Base Station (# 8130), Wireless On-Board Module (# 8129), and 
the Configuration Cable for Wireless On-Board Module (# 8131) give your fleet the ability 
to download data directly from the DriveRight devices to FMS without physically removing 
the DriveRight devices from the vehicle. The data moves wirelessly from the vehicle to 
the FMS database. The features that are added to support wireless download are: 

o Wireless Menu - The Wireless Menu, in conjunction with the Wireless On-Board 
Module (# 8129), Base Station for Wireless Download System (# 8130), and the 
Configuration Cable for Wireless On-Board Module (# 8131) allows you to create a 
wireless connection between your fleet vehicles and the FMS software. 

o Manual Wireless Download Icon added to FMS toolbar.  

 

o Wireless Devices database table, Edit Base Station, Edit Wireless On-Board Module, 
and Select Wireless Device Fields to Print added to the Database Menu. 

o Wireless Download Status Report added to the Reports Menu. 

 FTP Export dialog box now include the Wireless Download database table in the list of 
possible database tables that you can export. 

 Add Users dialog box now permits user accessibility definitions for the 
DriveRight\Wireless Download System, CarChip and SmartCard Devices. 
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 Improved many features regarding the FMS database installation and configuration. See 
The Database Selection Guide for more information and for the installation procedures 
regarding these new improvements. The database improvements are: 

o Fixed a previous issue with the User's PC name being used as a server alias name in 
the SQLServer database configuration process.  

o Stored procedures for installing and configuring the Oracle database are now 
integrated into the FMS installation process. There is no need to create the stored 
procedures manually unless FMS encounters problems when creating them.  

o Database migration from a previous release to the current release has now become a 
seamless feature. In previous releases, after FMS was upgraded, the connection with 
the database had to be re-established. Now, FMS automatically uses the previously 
configured database. 

 Data validation added to make sure that the ID numbers assigned to each CarChip and 
DriveRight are unique. 

 The Pin Code and the Driver Logout time can now be transferred to the DriveRight via 
the SmartCard. 

 The Current Location is now displayed in the FMS title bar. 

DriveRight Fleet Management Software 3.6 Release Notes 

DriveRight Fleet Management Software version 3.6 includes the following changes: 

 Disable Console Login feature added to the Security Settings tab in the Review 
DriveRight Security Settings dialog box, DriveRight Device Settings dialog box, and the 
 Default DriveRight Settings dialog box. The Disable Console Login feature disables the 
Login feature on a DriveRight console if a SmartCard Reader is present. This feature is 
available for DriveRight 600E devices only. 

 Disable Console Login column added to the DriveRight database table. The Disable 
Console Login column displays the Console Login status of each DriveRight in the 
database.  

 Disable Console Login added to DriveRight database table Print dialog box.  

 Set Odometer has been disabled for the DriveRight 600E device only. 

DriveRight Fleet Management Software 3.5 Release Notes 

DriveRight Fleet Management Software version 3.5 includes the following changes: 

 The current selected location is now displayed on the title bar of FMS. This allows you to 
know which location's data is currently being viewed through any window or table in the 
FMS software. 

 Three new options in Database Menu: Readiness Code Database, Trouble Code 
Database, and Batch Editing.  

 The Readiness Code Database allows you to view all the monitored readiness 
codes and the status of each code if you use the CarChip Fleet device. 
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 The Trouble Code Database allows you to review any trouble code records 
recorded in a vehicle using the CarChip Fleet device. 

 The Batch Editing feature allows you to re-assign drivers or adjust speeds 
displayed in all the tables in the database of various trips. 

 The CarChip database table has changed to display the interval the CarChip device now 
logs speed measurements. 

 Miscellaneous Settings has been added to the Add CarChip Wizard and to the CarChip 
Settings dialog box. Miscellaneous Settings allows you to control the settings for extra 
features on the CarChip, such Alarm and LED. The CarChip Settings dialog box also 
allows you to chose the update interval the CarChip device now records speed. 
Previously, the Vehicle Speed and Update Interval boxes were defaults and could not 
be user defined. Now, the Interval at which vehicle speed is sampled can be selected. 

 A new option was added to the Download Options dialog box that allows you to specify 
the number of hours of GPS data you want the DriveRight device to store. 

 Fixed a previous issue with the DriveRight and FMS software not recording a second trip 
that happens within the same minute as a previous trip. The DriveRight device and FMS 
software now display all trips, even those having the same starting times. 

 New database stored procedures have been added. If the software is accessing a 
database run on a MS SQL Server or Oracle server, some specialized installation may be 
required. See The Database Selection Guide for more information and complete 
instructions. 

DriveRight Fleet Management Software 3.4 Release Notes 

DriveRight Fleet Management Software version 3.4 includes the following changes: 

 New option in Setup Menu: Corporate Structure. The Corporate Structure option allows 
you to create a hierarchical representation of fleets and how they are distributed 
company wide. This feature is used in conjunction with the Driver Safety Score Report in 
the Reports Menu. 

 A new option in the Drive Safety Score Report: Specify Drivers with Mileage option, 
which displays all drivers with mileage for the specified time period. 

 The Serial Port options for both DriveRight and CarChip changed to Communication Port 
in the Setup Menu, with added USB support. 

 USB support for Fleet CarChips added. 

DriveRight Fleet Management Software 3.3 Release Notes 

DriveRight Fleet Management Software version 3.3 includes the following changes: 

 The Inclusion of using an on-board and desktop reader and SmartCard system to transfer 
data from the DriveRight 600 unit to a computer. This added feature has created the 
following changes to the FMS software. 

o New menu option in the Setup Menu: SmartCard Reader. Lets you select the 
SmartCard reader type. The SmartCard Reader requires USB driver installation 
before the SmartCard Reader can be determined and set up. 
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o New menu: SmartCard Menu. The SmartCard menu contains several menu 
options for setting up, monitoring, and maintaining all the SmartCards and 
DriveRights using the SmartCard System. The SmartCard menu options are: 

 Download  - Downloads information stored on a card to a selected base from a 
SmartCard Reader. 

 Setup Card - Allows you to select user and vehicle information for a card. 

 Transfer to DriveRight - Uses the card to transfer settings and information to a 
DriveRight or multiple DriveRight devices. 

 Clear Transfer Data - Clears the settings and data that sets the DriveRight 

 Erase - Erases all data stored on the SmartCard 

 GPS Settings included in the DriveRight Settings dialog box in the Setup, DriveRight 
and SmartCard menus. Allows you to turn the GPS logging and subsequent mapping 
feature on. Works only with DriveRight 600 units with GPS modules. 

DriveRight Fleet Management Software 3.2 Release Notes 

DriveRight Fleet Management Software version 3.2 includes the following changes: 

 Automated mapping of GPS data. 

 New Report: Driver Safety Score Summary. The Drive Safety Score Summary report 
calculates driver scores and average scores for each month for a  3, 6, or 12 month time 
period. Each driver’s score is calculated for each selected month and displayed in an 
excel file. The data generated by this report is saved in the Safety Score table in the FMS 
database. You can sort this report by end date score, report average scores, or driver 
name and can choose to group the drivers by their location if multiple locations are 
selected. 

 New database table: Safety Score. This table is generated by the Driver Safety Score 
Summary Report. 

 Driver Safety Score Report replaces Driver Performance Score Report. 

 Driver Safety Score Report Formula replaces Driver Performance Score Formula. 

 Exclusive Driver option added to the Vehicles Table. Selecting this option will cause all 
trip data to be assigned to the default driver even if other drivers are listed in the data. 

 The Tamper Log Report now displays the time between unplugging from a vehicle and 
downloading a DriveRight as well as the time between downloading a DriveRight and 
reconnecting it to a vehicle. 

DriveRight Fleet Management Software 3.1 Release Notes 

The most important change in DriveRight Fleet Management Software version 3.1 is support for 
the CarChip Fleet device. DriveRight FMS 3.1 also includes two new reports.  

CarChip Fleet Support 

 Download CarChip Fleet data into the DriveRight FMS database. 
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 Store trip info, accident logs, and tamper logs. 

 View and set CarChip Fleet configuration in both the device and FMS database. 

Note: DriveRight FMS 3.1 does not store engine data and diagnostic trouble logs in the database. 
This information can be downloaded and viewed using the CarChip software included on your 
DriveRight FMS 3.1 CD. 

New Reports 

 Time Over Speed Limit Exception Report 

 Days Since Last Download Report 

DriveRight Fleet Management Software 3.0 Release Notes 

DriveRight 3.0 is a total redesign of the earlier versions of the software. We designed and 
developed the software with an aim to provide: 

 Robust database server support, to be able to handle large data. 

 Flexibility to configure and connect to more than one DataBase Management System 
(DBMS). 

 Better Reports for both viewing and printing. 

 Improved Database Browser. 

 Better organization of data coming from different locations. 

 Improved user interface. 

Important Features in DriveRight 3.0 

 Flexible Database support for almost any relational database which supports SQL 
language, and has a OBDC driver. 

 Supports the following relational database servers: MySQL, Microsoft SQL Server and 
Oracle. 

 Free support for MS Access and MSDE, which are ideal for small fleets with a single 
user. 

 A location field was added to the database tables to facilitate ”r;rolling up” data which 
makes it possible to manage data from many locations in one database. 

 FTP export and import data through the internet making it easier to move data from one 
location to another. 

 Automatic backup and ”r;zipping” of data  with the option of  keeping a fixed number of 
months in the database to help speed up operations. 

 The ”r;Add DriveRight” wizard makes adding a DriveRight to the program simpler and 
less prone to mistakes. 

 Elimination of redundant reports and the addition of several new reports. 

 Reorganized reports menu with several new and redesigned reports. 
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 Improved viewing and printing of reports. 

 New ”r;usage” report to help trace night and weekend driving. 

 Improved exception reports for Excessive Speed, Hard Braking, and Night Driving. 

 A ”r;Relationship” report that shows a list of all DriveRights, which vehicles they are 
assigned to, along with a default driver if one has been assigned.  

 Improved browser with user-configurable colors, fonts, and field widths. 

 Simplified filter support to make it easier to select what you want. 

 Use of standard calendar control for specifying dates. 

 Email support for all Excel generated reports. 

 Supports Palm PDA download of DriveRight consoles. 

Operational differences between DriveRight 3.0 and earlier versions 

The operation of DriveRight 3.0 is very similar to 2.x, but there are some fundamental changes 
that you should be aware of.    

 In 2.x the vehicle table contained all the information about a particular DriveRight, in 
addition to information on the vehicle.  However, in 3.0 a new table was introduced, the 
DriveRights table,  which stores DriveRight console information. Vehicle information is 
stored in the vehicle table, and DriveRight information is stored in the new DriveRights 
table.  In 3.0 , a DriveRight must be ”r;assigned” to a vehicle.   When your old data is 
converted, for each vehicle in 2.x  a new DriveRight and vehicle is created in the 3.0 
database.   

Note: A DriveRight is identified using it’s DriveRight ID, and a particular vehicle is identified 
using it’s Vehicle ID.   

Note: A ”r;relationship” report was added to the program to help clarify the relationship 
between vehicles, DriveRights, and drivers.    

 The ”r;Set DriveRight” option in 2.06/2.6.1 appears as ”r;View/Set” in the 
”r;DriveRight/DriveRight Settings” menu.  Unlike 2.06/2.6.1, when changes are made to a 
DriveRight using this option, they are also stored in the DriveRight table.  

 Adding a new DriveRight to the program can now be done more easily using the Add 
New DriveRight wizard which steps you through the process and helps clarify where you 
stand with respect to the calibration of the DriveRight. 

 You will also notice that every table now has a ”r;location” field.  The location field was 
added to facilitate ”r;rolling up” of data from many locations so they can be managed in 
one database. 

   
Back to Getting Started 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Architecture 
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DriveRight Fleet Management Software (FMS) architecture allows the software to be connected 
to any of the Database Servers we support. The communication between DriveRight FMS and 
Database is done through an OBDC connection by means of an OBDC driver. Currently 
DriveRight FMS supports MS Access, My SQL, MSDE, SQL Server and Oracle databases. Other 
databases may be added in the future. 

The following figure illustrates how DriveRight FMS connects to the back-end Database Server. 

 

 

Note: DriveRight can only be connected to one database at a time. 

When DriveRight FMS is opened for the first time, the user is prompted to select the database 
type to be used for this installation. Based on the user's selection, a connection is established to 
one of the OBDC drivers. The database type is stored in the configuration file. 

See also: 

Database Selection Guidelines 

Setup Overview 

Back to Getting Started 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Database Selection Guidelines 
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Please refer to the DriveRight FMS Database Selection Guide for information on choosing and 
installing a database for your installation. We included a printed copy of the Database Selection 
Guide with your DriveRight FMS as well as a PDF version that can be found in the DriveRight 
FMS program folder. The Database Selection Guide can also be downloaded from the 
Automotive Support section of our web site. 

DriveRight Fleet Management Software (FMS) supports the following databases. 

Single-User Databases: 

o MS Access (Microsoft Access) 

o MSDE (Microsoft Desktop/Data Engine) 

Multi-User Databases: 

o MySQL 

o MS SQL Server (Microsoft SQL Server) 

o Oracle  

See also: 

Architecture 

Setup Overview 

Back to Getting Started 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Converting 2.04-2.06/2.6.1 Database to DriveRight FMS 
Format 

A separate conversion utility, OldToNew, has been included with the DriveRight FMS software to 
allow the conversion of existing DriveRight 2.04, 2.05, 2.06 and 2.6.1 database files for use with 
DriveRight FMS. 

Note: This conversion utility can only be used with databases created by DriveRight 2.04, 2.05, 
2.06 or 2.6.1. If you are using an earlier version of the DriveRight software you must first upgrade 
to one of the supported versions. 

Use the following procedure to convert your existing DriveRight database for use with DriveRight 
FMS: 

1. Install and run DriveRight FMS before you convert your data to the new format.   

2. Verify the current location in DriveRight FMS using the Current Location command in the 
Setup Menu. This location information will be associated with all the 2.x data when 
converted into the new database format.  
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3. To import data to a new location, select the Company Locations command in the 
Database Menu in DriveRight FMS, then click the Add New button in the Company Locations 
browse window.  

 

4. Go to Startup>Programs>DriveRight and run OldToNew. 

5. To import data, select the location from the drop down list. 

 

6. Click the Browse button to select the DriveRight 2.x tables directory (By default it is 
C:\Program Files\DriveRight Software\tables).  

7. Click the Convert button to start the conversion. Once the data is converted you will see a 
success message. 
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Note: The conversion process can take a long time depending on the size of your 2.x database. 
You can interrupt the conversion at any time by clicking the stop button, but this is not 
recommended. 

8. All the 2.x data has been converted into the new database format for DriveRight FMS. 

9. Go to DriveRight FMS and view various tables using the Database Menu commands to 
make sure the data has been converted properly. 

 

Back to Getting Started 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Setup Overview 

The initial setup of your DriveRight FMS consists of the following operations: 

1. Select and Install Database  

Before you run the software for the very first time you will need to select the database to be used 
with DriveRight FMS. Refer to the Database Selection Guide for information on choosing and 
installing a database.  

If you select MS Access, DriveRight FMS will install the necessary components during the FMS 
installation. If you select MySQL, MSDE, MS SQL Server, or Oracle, you will need to install and 
configure the database before installing DriveRight FMS. See Database Selection Guidelines for 
more information. 

2. Install DriveRight FMS 

Insert the DriveRight FMS CD and follow instructions. 

3. Initial Program Configuration when you first run DriveRight FMS. 

Refer to the DriveRight FMS Getting Started Guide for initial program configuration information.  

4. Install the drivers for accessories you want to use. 

Install drivers for the SmartCard Desktop Reader and wireless devices if you want to use them. 
Refer to the DriveRight FMS Getting Started Guide for instructions on installing the accessory 
drivers. See Wireless Device Communication Problems for help with installing or re-installing your 
wireless device driver. See SmartCard Reader Device Communication Problems for help with 
installing or re-installing your SmartCard Desktop Reader Device driver. 

5. Converting DriveRight 2.04, 2.05 & 2.06 Databases 

If you have a DriveRight database created using version 2.04, 2.05, or 2.06 of the DriveRight 
Vehicle Management Software, it needs to be converted for use with DriveRight FMS. Click this 
link to display  a help window that explains how to convert these databases (Convert Database) 

 

6. DriveRight FMS Software Setup 

Check the following configuration preferences and make any necessary changes: 
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Set Units - Select your unit preferences for the data displayed in the dialog boxes, 
database browser, and reports. 

Backup Options - Allows you to set the number of months of data to keep in the current 
database. 

Download Options - Use this option to: 

 Synchronize the DriveRight device date and time with your computer after each 
download.  

 Choose how the software will treat the Driver ID, If a downloaded device is either a 
500, 600 or 600E model. Once set, this preference will be uniform for all devices.  

 Customize the download options for CarChip devices. 

 To determine how the speed samples taken from the CarChip Fleet and CarChip 
Fleet Pro are saved in the database. 

7. Set Default DriveRight Settings Wizard 

The values entered in this setup are used as default settings when you add new DriveRight 
devices to the database. You can set DriveRight default values using the Default DriveRight 
Settings Wizard in the Setup Menu. Check the default settings to make sure they suit your 
application. 

8. Set Default CarChip Settings 

The values entered in this setup are used as default settings when you add new CarChip devices 
to the database. You can set CarChip default values using the Default CarChip Settings 
command in the Setup Menu. Check the default settings to make sure they suit your application. 

Note: If you are using both DriveRight and CarChip devices in your fleet, be sure to set the Safety 
Settings uniformly for both types of devices.  

9. Select the Communications Port and Test Communications 

 Select Communications Port - DriveRight from the Setup Menu to select the 
communications port used to connect to a DriveRight device.  

 Select Communications Port - CarChip from the Setup Menu to select the 
communications port used to connect to a CarChip device.  

 Click Auto Detect in the Communications Port dialog box to test communication. 

10. CarChip / DriveRight Considerations 

 If both a CarChip device and DriveRight console are installed in the same vehicle, you 
will need to create duplicate entries in the DriveRight FMS databases for the vehicle and 
driver. Otherwise you will see duplicate trip data in your DriveRight FMS reports. 

 If you have multiple communications ports, you can connect a CarChip to one 
communications port and DriveRight to another. If you do not have multiple 
communications ports we recommend you buy a serial switch box to switch between the 
two devices or a serial extension cord to make plugging and unplugging the download 
cables more convenient. 

11. Building Your Database Tables 
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 When you add a DriveRight or a CarChip you will need to assign a default vehicle. When 
you add a vehicle you will need to assign a default driver. So, it is most efficient to add 
the drivers first, the vehicles second and the DriveRights third. 

1. Add all drivers. 

2. Add all vehicles. 

3. Add all DriveRights and CarChips. 

 When you add a CarChip you will need to assign it to either a vehicle or a driver. If you 
assign CarChip to a vehicle, all the downloaded data is assigned to the default driver of 
that vehicle. If you assign a CarChip to a driver, all the downloaded data is assigned to 
that driver and the vehicle will be unallocated. 

o If a CarChip will only be used in one vehicle, assign it to that vehicle. 

o If a CarChip will be used by only one driver, assign it to that driver. A CarChip 
assigned to a driver can be used in multiple vehicles. 

12. Using the Software 

You are now ready to start using DriveRight FMS. 

Back to Getting Started 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Tool Bar 

To get information about an FMS menu or tool bar icon, click on the command or icon in the 
illustration: 
 

 

Note: To see the full toolbar, expand the Online Help window to full screen. 

List of Toolbar Icons 

Database Icons 

View Trips Database 

View DriveRight Database 

View CarChip Database 

View Drivers Database 
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View Vehicles Database 

Add Device Icons 

Add New DriveRight Wizard 

Add New CarChip Wizard 

Report Icons 

Driver Safety Score Report 

Trip Summary Report 

Vehicle Activity Report 

Usage Report 

Odometer Report 

Accident Log Report 

File Menu Command Icons 

Print 

Print Preview 

Clear Screen 

Data Download/Export Icons 

Download DriveRight 

Download CarChip 

Download Palm 

Export GPS Data to MapPoint 

Manual Wireless Download 

18 



DriveRight FMS Help 

Help Icon 

Help Topics 

 

Back to Getting Started 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Quick Reference 

FMS Quick Reference 

Get More Information About: 

Data Management  

CarChip  

DriveRight 

Mapping 

The Wireless Download System 

Back to Home 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

Data Management 

Data Management Reference Menu 

Database Backup Considerations 

Active Database Size Recommendations 

Backup 

Restore 

Export Menu 

Import Menu 

 

Back to Quick Reference Menu 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Database Backup Considerations 

If you have GPS-enabled DriveRight and CarChip Fleet Pro devices, you will rapidly accumulate 
a large amount of data in the GPS table due to the frequency of GPS logging and to the CarChip 
Parameter Logs database table due to the frequency of vehicle speed logging. 

To avoid the database from becoming unmanageable, you can export both the GPS and CarChip 
Parameter Logs database tables more frequently than your normal backup interval, and delete 
GPS and Carchip Parameter Log data by using the Maintenance. By doing this you still have trip 
data for your reports while at the same time decreasing the database size.  

The following is an example of backing up and exporting information from the GPS table:  

1. Set the Backup Options (Preferences command in the Setup Menu) to select the 
number of months you want to keep active in the database.  

2. Suppose that you have some DriveRights and CarChips with GPS data enabled. Your 
GPS Table will grow much more rapidly than the Trips Table. But you still want to keep 
the last three (3) months of trip data for reporting purposes. 

3. Since DriveRight FMS does not support backup of individual database tables, use Export 
to create individual backups of the GPS Table.  

4. Refer to the Database Size Recommendations Table to determine how frequently you 
should Export the GPS Table. Once you determine the export frequency, you will need to 
manually repeat this process.  

5. In this example, you want to keep one month of GPS data active in the database. 

6. Select Export GPS from the Export Menu.  

7. Enter a file name for the GPS export data similar to this: gps_10_apr_2007.txt. 

Note: Be careful about naming the GPS export file so that you don't lose previously exported 
data. 

9. Go to the Database > Maintenance > GPS command and delete all GPS data older than 
your export frequency from Step 5. In this example it is one month. 

Note: The same process can be followed for exporting and deleting CarChip Parameter Log 
records you no longer want to keep in your active database. 

See also: 

Active Database Size Recommendations 

Preferences: Backup Options 

Export Menu 

Maintenance 

Back to Quick Reference Menu 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Active Database Size Recommendations 

The following recommendations are based on tests and calculations made with these 
assumptions: 

o 10 trips per day per vehicle 

o Trip duration: 1 hour (10 hours driving time per day per vehicle) 

o GPS data logged every 10 seconds 

Note: If your fleet size exceeds the scenarios shown below, we recommend that you use a multi-
user database. 

Note: For multi-user databases, theoretically there is no fleet size limit. Still, we recommend that 
you backup data once a month, keeping only the amount of data required for reporting purposes 
in the active database, typically 3-6 months. 

Recommendations Table 

Scenario  Number 
of 

Vehicles  

Amount of 
Active 
Data in 

Database  

Remarks and Recommendations 

25  Up to 1 year  Backup data once a month for application 
performance. Using backup options you can set 
maximum of 1 year of data in the active 
database 

50  Up to 9 months  

 

Backup data once a month for application 
performance. Using backup options you can set 
maximum of 9 months of data in the active 
database 

No GPS  

100  Up to 6 months  Backup data once a month for application 
performance. Using backup options you can set 
maximum of 6 months of data in the active 
database 

MSDE 
with GPS  

5  Up to 1 month  Backup data every month for application 
performance. Using backup options you can set 
maximum of 1 months of data in the active 
database 

MS 
Access 
with GPS  

10  Up to 1 month  Backup data every month for application 
performance. Using backup options you can set 
maximum of 1 months of data in the active 
database 
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See also: 

Active Database Size Recommendations 

Preferences: Backup Options 

Back to Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Backup 

The Backup command is used to archive old data as a zip file. The backup files are stored in the 
Backup sub-directory in the DriveRight FMS install directory. The Backup sub-directory is created 
the first time you back up your data.  

The backup zip files are named based on the start and end dates chosen for the backup. For 
example, if you pick the dates between March 6, 2003 and March 27, 2003, the backup file will be 
named 6March2003_27March2003.zip. 

You can configure how much data to keep active after a backup by setting up your Preferences: 
Backup Options in the Setup menu. Limiting the amount of data in the active database helps 
prevent the database from growing into an unmanageable size. 

To backup data: 

1. Click Backup in the File menu. The Backup Files To dialog box is displayed. 

 

2. From the Backup Files To dialog box select the folder where the backup file will be 
written. The Backup Options dialog box is displayed.  
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Note: The Backup Options dialog box will not be displayed the first time you back up DriveRight 
data. 

 

3. In the Backup Options dialog box check your last backup date and specify whether to 
backup the whole database or only those records falling within a specified time period. The start 
date will always be initialized to the last backup date. 

4. Click OK to initiate the backup or click Cancel to exit the dialog box without backing up 
your database. 

5. When the backup is finished, click OK to return to the program. 

See Also: 

Restore 

Preferences: Backup Options 

Back to File Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Restore 

The Restore command is used to get a previously Backed up data back into the active database. 
In this process you can pick one or more tables to be restored. 

To restore data: 

1. Click Restore in the File menu. The Restore Files From dialog box is displayed. 
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2. From the Restored Files From dialog box select a single zip file to restore, and then 
click Restore. DriveRight FMS unzips the file and displays all the tables in the dialog, and 
displays the following dialog box: 

 

Note: You can only restore one .zip file at a time. 

Note: The backup file filename is based on the start and end dates chosen for the backup. 

3. You can either restore all the database tables or restore individual database tables. Click 
Yes in the dialog box to restore all the tables. Click No to restore selected database tables. 

4. If you are restoring selected database tables, select each table to be restored. Hold down 
the Control key on your keyboard to select multiple tables. When you have finished making your 
selection, click Restore to restore the tables or click Cancel to exit without restoring the tables.  

24 



DriveRight FMS Help 

 

5. When the files have been restored, click OK to return to the program. 

See Also: 

Backup 

Back to File Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Export Menu 

Use the export menu options to export DriveRight FMS data. 

FTP Export - Use the FTP Export command to export database data to a remote site. 

Export GPS to MapPoint - Use the Export GPS to Mapping Software command to export GPS 
data in a format designed to be imported into mapping software. 

Export Accidents to MapPoint - Use the Export Accidents to Mapping Software command to 
export accident GPS data in a format designed to be imported into mapping software. 

Other Export Commands - Use the other export commands to export the indicated type of data in 
a tab-delimited text file. 

Back to File Menu 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Import Menu 

Use the Import Menu options to import DriveRight database data into DriveRight. 

Import: FTP Import 

Import: Import Data From 
 
Import GPS Data into MapPoint 

Back to File Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

CarChip Quick Reference 

CarChip Quick Reference 

CarChip Considerations 

Adding Drivers, Vehicles and CarChips 

CarChip Settings 

Downloading CarChip Guidelines 

Download CarChip 

 

 

Back to Quick Reference Menu 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

Adding Drivers, Vehicles and CarChips 

Please refer to the following guidelines when adding new drivers, vehicles, and CarChips 
devices. 

 A CarChip device must be assigned to either a vehicle or a driver. 

 Unlike DriveRight devices, a CarChip device can be easily switched from vehicle to 
vehicle, as long as all the vehicles provide a supported OBDII port. 
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 If a CarChip is assigned to a vehicle, the default driver of that vehicle will appear as the 
driver on all downloaded data from that CarChip. 

 If a CarChip is assigned to a driver, then all data downloaded from that CarChip will be 
associated with that driver and the vehicle will be listed as UNKNOWN VEHICLE.  

 If you just want to add a CarChip and you don’t yet have a vehicle or driver to assign, you 
can select "UNKNOWN VEHICLE". 

 Based on your specific situation, you should carefully consider the options before 
assigning a CarChip to either a vehicle or driver. 

 The Add New CarChip command opens a wizard that will guide you through the process 
of adding CarChips. It will also allow you to add drivers and vehicles if they are not 
already in the database. 

 

Back to Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

CarChip Considerations 

o If both a CarChip device and DriveRight console are installed in the same vehicle, you 
will need to create two entries for the driver and two entries for the vehicle in the 
DriveRight FMS database. Otherwise you will see duplicate trip data in your DriveRight 
FMS reports. 

o If you have multiple serial ports, you can connect CarChip to one serial port and 
DriveRight to another. If you do not have multiple serial ports we recommend you buy a 
serial switch box to switch between the two devices or a serial extension cord to make 
plugging and unplugging the download cables more convenient. 

o If you are using both CarChip and DriveRight devices, make sure both types of devices 
use the same safety settings.  

 Speed Band 3 in CarChip should match Speed Limit in DriveRight. 

 Hard Braking in CarChip should match Decel Limit in DriveRight. 

 Hard Acceleration in CarChip should match Accel Limit in DriveRight. 

o Unlike DriveRight, a CarChip can be assigned either to a vehicle or to a driver.  

Back to Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

CarChip Settings 

The following commands allow you to view or change the settings on a CarChip: 

View/Set 
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Restore 

 

Back to CarChip Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

Downloading CarChip Guidelines 

You cannot download a CarChip device if any of the following conditions exist: 

 CarChip not present in the database. 

 CarChip not assigned to a Vehicle or to a Driver. 

 Unless every thing is configured properly, you cannot download from the device. 

 

Back to Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Download CarChip 

Use this command to download data from your CarChip data logger into your computer. 

To download CarChip data: 

1. Connect your CarChip device to your computer. 

2. Select Download CarChip from the CarChip menu or select the Download CarChip 
Icon from the tool bar. The Downloading Data dialog box appears. 

 

2. The dialog box disappears when the download is complete. 

3. Click Cancel only if you wish to abort the download before it is finished. 

See also: 

Downloading CarChip Guidelines 

Back to CarChip Menu 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight Quick Reference 

DriveRight Quick Reference 

DriveRight Configuration 

Adding Drivers, Vehicles and DriveRights 

DriveRight Settings 

Verify DriveRight Calibration 

Setup GPS 

Downloading Requirements 

Download DriveRight 

Download Palm 
 
Database Menu 
 
Reports Menu 

Back to Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Adding Drivers, Vehicles and DriveRights 

Please refer to the following guidelines when adding new drivers, vehicles, and DriveRight 
devices. 

 The Add New DriveRight command opens a wizard that will guide you through the 
process of adding DriveRights. It will also allow you to add drivers and vehicles if they are 
not already in the database. 

 If you are adding a new driver, vehicle, and DriveRight, you should add the driver first, 
the vehicle second, and the DriveRight last. 

 If you just want to add a vehicle and you don’t yet have a driver to assign, you can select 
"UNALLOCATED DRIVER". 

 If you just want to add a DriveRight and you don’t yet have a vehicle to assign, you can 
select "UNKNOWN VEHICLE". 

Important: If you selected either a UNALLOCATED DRIVER or UNKNOWN VEHICLE, you 
should change them to real entries before actually using the DriveRight in the field and 
downloading it. Otherwise, the data will be assigned to the wrong entities and will affect the 
results when you run Reports, etc. 

29 



DriveRight FMS User's manual 

See also: 

Add New DriveRight 

Back to Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight Settings 

The following commands allow you to view and or change the settings on a DriveRight device: 

View/Set 

Restore 

Setup GPS 

Verify DriveRight Calibration 

 

Back to DriveRight Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight Settings: Verify DriveRight Calibration 

The Calibrate DriveRight dialog box allows you to verify DriveRight calibration settings. 

 The Calibration Setting dialog box shows two installation methods. VSS (vehicle speed 
sensor) installation and Reed Switch.  

To verify the  DriveRight console calibration: 

1. Click on DriveRight Settings from the DriveRight Menu. 

2. Select Verify DriveRight Calibration from the drop-down menu. A DriveRight 
Calibration Message dialog box is displayed. 

3. Click OK, Set or Cancel to continue, depending on the displayed message. The 
Calibrate DriveRight dialog box is displayed. 
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4. If the DriveRight is using a reed switch for the speed sensor, make sure the Installation 
Method indicates Reed Switch. 

o Reed Switch: If the DriveRight device has been previously calibrated in the 
vehicle or through the software, then DriveRight FMS automatically calculates 
the Calibration number for your vehicle. We strongly recommend that you do not 
change these values. The PPR for a reed switch is always &rdquor;1”. 

5. If the DriveRight is using the vehicle's VSS for the speed sensor, make sure the 
Installation Method indicates VSS. 

o VSS: If the DriveRight device has been previously calibrated in the vehicle or 
through the software, then DriveRight FMS automatically calculates the VSS 
PPM (Pulses Per Mile), PPR (pulses per reading) and Calibration number for 
your vehicle. Otherwise you must specify the PPM for your vehicle. Depending 
on your selection, software calculates the PPR (pulses per reading) and 
calibration values and fills the edit boxes with them. 

6. If you are using the VSS, you can adjust the pulses per mile (PPM) from the drop down 
list or enter the PPM in the edit box if necessary. We recommend that you not change these 
settings if the DriveRight has been previously calibrated.  

7. Click OK to save changes to the calibration, or click Cancel to exit without saving 
changes. 

 

Back to DriveRight Menu | DriveRight Settings 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight Settings: Setup GPS 

Use this command to view and/or modify the GPS settings on a DriveRight device. 

Note: This command only works with the DriveRight 600. 
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To setup GPS logging: 

1. Select DriveRight Settings from the DriveRight Menu. 

2. Select Setup GPS from the DriveRight Settings drop down list. The Setup GPS 
Logging Interval dialog box is displayed. 

 

3. Set GPS Logging to On, Off, or DriveRight Speed Only. 

o Select On to enable GPS logging. 

o Select Off to disable GPS logging. 

o Select DriveRight Speed Only to log the DriveRight speed without the GPS 
coordinates. No GPS unit is required to enable this option. 

4. Enter the desired logging interval and indicate a time unit of either seconds (Sec) or 
minutes (Min). Logging Hours indicates how much data can be stored at the selected interval. 

5. Click Set to save the changes or click Cancel to exit without changing the settings 

 

Back to DriveRight Menu | DriveRight Settings 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Downloading Requirements 

You cannot download a DriveRight if any of the following conditions exist: 

 DriveRight not present in the database. 

 DriveRight not assigned to a Vehicle. 

Note: The same conditions also apply to Host Mode and Palm Download. 

Back to Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Download DriveRight 

The Download DriveRight command transfers trip data from the connected DriveRight device to 
the DriveRight database.  

To download your DriveRight: 

1. Connect your DriveRight console to your computer and make sure the DriveRight is 
"awake". Press the MODE key if there is nothing on the LCD display. 

2. Select Download DriveRight in the DriveRight Menu. The following Download Status 
box is displayed: 

Note: You will see the Cancel button only if you are downloading a DriveRight 600. 

 

3. You may lose GPS data for earlier trips if the DriveRight console is not downloaded for 
an extended period of time. In this case you will see a warning message similar to this: 

 

4. If the calibration in the DriveRight console does not match the calibration in the database, 
you will see a warning message similar to this: 
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5. When the data has finished downloading the following dialog box is displayed: 

 

6. Press Enter or click OK to continue. 

See also: 

Downloading DriveRight Guidelines 

Back to DriveRight Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Download Palm 

Versions of DriveRight FMS 3.0 and later offer a feature to download data from multiple 
DriveRight devices from a Palm device. You will need the DriveRight Palm Download Kit, #8181, 
in order to use this command. 

Note: To download a DriveRight console data into the software using Palm Download, the 
DriveRight should be present in the database. If you try to download a DriveRight which is not 
present in the database, you will get an error message.  

 

To download your Palm: 

1. Select Download Palm in the DriveRight Menu.  

2. The first time you download a Palm, the following dialog box is displayed. Select the 
directory which contains your Palm backup databases and click OK. 
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3. Each time after the first time, when you use the Download Palm command, the following 
dialog box appears showing the selected Palm backup directory.  

 

4. Click Browse to select a different backup directory, click OK to use this displayed 
directory, or click Cancel to exit. 

5. If you click OK, the Download Status dialog box is displayed.  
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6. When the data has finished downloading the Palm Download, Download Successful 
dialog box is displayed: 

 

7. Click OK to continue. 

 

Back to DriveRight Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Mapping Quick Reference Menu 

Mapping Quick Reference Menu 

How to Create Maps 

How to View Maps 

Mapping Menu 

DriveRight FMS Mapping Requirements 

Back to FMS Quick Reference Menu | Mapping Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

 

How to Create Maps 

How to Create Maps 

DriveRight FMS can create three different maps from your GPS data. You can also export GPS 
data for use in third-party mapping software such as MS MapPoint. 

Creating a Trip Map 

Creating a Day Map 

Creating an Accident Log Map 

Export: GPS to MapPoint 

Export: Accidents to MapPoint 
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Import GPS Data Into MapPoint 

 

Back to  FMS Quick Reference | Mapping Quick Reference 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

Creating a Trip Map 

Click the Map button in the Trips browse window to create a map from a trip record.  

To create a Trip Map: 

1. Select the Trips command in the Database menu. The Filter For Trips dialog box is 
displayed. 

2. Select your desired Trips filter options.  

3. Click OK to show the Trips browse window. 

4. Highlight a trip record then click Map to generate a Trip Mapping Report for that trip.    

Depending on the mapping tool you have selected, the map is displayed in the DriveRight 
FMS program window, Google EarthTM, or Google MapsTM in a web browser. 

Note: If you are using Internet Explorer as your web browser and have selected Google Maps as 
your mapping tool, you may see the following message when Internet Explorer begins to create a 
Trip Map: 

 

To allow Internet Explorer to finish creating the map, click on the message and then click "Allow 
Blocked Content" in the resulting pop-up message. When the Security Warning window 
displays, click "Yes" and Google Maps will generate the Trip Map. 

See also: 

Viewing Trip Maps 

Map Navigation 

Viewing GPS Plot Information 

Back to Mapping Overview  

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Creating a Day Map 

Click the Map button in the Days browse window to create a map for all trips taken on the same 
day. 

To create a Day Map: 

1. Click Days in the Database menu. The Filter for Days is displayed. 

2. Select your desired filter options.  

3. Click OK to show the Days browse window. 

4. Highlight a day record, then click Map to generate the Day Mapping Report.  

Depending on the mapping tool you have selected, the map is displayed in the DriveRight 
FMS program window, Google EarthTM, or Google MapsTM in a web browser. 

Note: If you are using Internet Explorer as your web browser and have selected Google Maps as 
your mapping tool, you may see the following message when Internet Explorer begins to create a 
Day Map: 

 

To allow Internet Explorer to finish creating the map, click on the message and then click "Allow 
Blocked Content" in the resulting pop-up message. When the Security Warning window 
displays, click "Yes" and Google Maps will generate the Day Map. 

 

See also: 

Viewing Day Maps 

Map Navigation 

 

Back to Mapping Overview  

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

Creating an Accident Log Map 

You can create an Accident Log Report Map by selecting the Output to: Map or Output to: Both 
Map and Excel options when you create the Accident Log Report.  

To create a Accident Log Map: 
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1. Select the Accident Log command in the Reports menu. The Filter for Accident Logs is 
displayed. 

2. Select the desired Accident Log filter options, being sure to select Map or Both Map and 
Excel for the report output. 

3. Click OK to create the Accident Log Mapping Report.  

 

Note: If you are using Internet Explorer as your web browser and have selected Google Maps as 
your mapping tool, you may see the following message when Internet Explorer begins to create 
an Accident Log Map: 

 

To allow Internet Explorer to finish creating the map, click on the message and then click "Allow 
Blocked Content" in the resulting pop-up message. When the Security Warning window 
displays, click "Yes" and Google Maps will generate the Accident Log Map. 

 

See also: 

Viewing Accident Log Maps 

Back to Mapping Overview  

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

Export: GPS to MapPoint 

Note: This feature is only enabled if you have chosen MapPoint as your mapping tool. This 
feature is not supported in Google MapsTM or Google EarthTM. 

To export GPS data: 

1. Go to File > Export. 

2.  Select GPS to MapPoint in the drop-down Export menu.  

The GPS Fields dialog box displays. 
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3. Click Select All to check all fields. Click Clear All to clear all fields. Click in the box for 
each field to toggle the check on and off.  
 
Note: Only the checked GPS fields will be exported. These key fields should always be selected: 
GPS DateTime, Speed, High Speed, Latitude and Longitude. 
  

4. Click OK in the GPS Fields box to continue, click Cancel to exit. If you click OK, the 
Export GPS To dialog box is displayed. 

 

3. The default file name is GPS.TXT and the default directory is the DriveRight FMS install 
directory. You can edit or change the file name directly in the text box. You can also change the 
directory in which the exported GPS data file will be saved.   
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4. Click Set Filter  to narrow the selection of GPS data to be exported.   

5. Click Browse to view the GPS data before you export it. 

6. Click OK when you are ready to export the GPS data or click Cancel to exit without 
exporting data. If you click OK, the exported GPS data will be saved in a file ready to be imported 
into your mapping software. 

See also: 

Import GPS Data Into MapPoint 

Back to File Menu | Export Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Export: Accidents to MapPoint 

Note: This feature is only enabled if you have chosen MapPoint as your mapping tool. This 
feature is not supported in Google MapsTM or Google EarthTM. 

To export accident log data: 

1. Go to File > Export. 

2. Select Accident to MapPoint.  

The Export AccidentLogs To dialog box is displayed. 

 

2. Select the file directory in which to save the accident log files. 
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3. Verify the file name for the accident log file. You can edit the name in the dialog box if 
desired. 

4. Click Export to create the accident log data file or click Cancel to exit.  If you click OK, 
the exported Accident Log data will be saved in a file ready to be imported into your mapping 
software. 

To import data into MapPoint: 

1. Start the MapPoint application. 

2. Select Import Data Wizard from the Data menu. 

3. Using the File dialog box find select the ACCIDENTLOGS.TXT file and click on Open. 

4. "Tab" should be selected to separate the data. Click Next. 

5. All the fields you exported will appear in the next dialog.  Column headings are included 
and should be detected by the program.  All the columns should have <Other Data> as 
their data type except Lat and Long.   Check to make sure the Lat and Long were 
detected correctly.  If they are not, correct them.  Click Finish. 

6. Select Multiple Symbol and click Next. These instructions show you how to color code 
accident log points by speed at T0. T0 is the middle point of the accident log.   

7. In "Select the data filed or column to map" list, select time_TO.  In "Divide the data you 
chose above by" list, select <None>. In "Show the data by" list, select Latitude & 
Longitude. Click Next. 

8. Enter the speed divisions you want to use and the color for each division. 

9. Click Finish to plot the points. 

10. In the left frame, right click on "time_T0 by Latitude & Longitude". Select "Properties". 
Open the Balloon tab and select time_T0, accidentDateTime and any other fields you 
want to view. 

11. Zoom in enough to see individual points, right click on a point, and pick "Show 
Information", to look at data for that particular point. 

12. MapPoint allows you to navigate around on the map pretty well.  Some useful keystrokes 
are ’r;+’ to zoom in and ’r;-’r; to zoom out.  Also, you can draw a box around an area and 
then click in it to zoom into it.  You can scroll the map using your mouse by just 
positioning the mouse cursor on the side of the map you want to scroll into.   

Back to File Menu | Export Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

Import GPS Data Into MapPoint 

Exported GPS Data can be easily importing into MS MapPoint using the MapPoint Import Data 
Wizard. 

 

To import GPS data into MapPoint: 
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1. Start the MapPoint application. 

2. Select Import Data Wizard from the Data menu. 

3. Using the File dialog box find select the GPS.TXT file and click Open. 

4. "Tab" should be selected to separate the data. Click Next. 

5. All exported fields appear in the next dialog box. Column headings are included and 
should be detected by the program.  All the columns should have <Other Data> as their 
data type except Latitude  and Longitude. Check to make sure the Latitude and 
Longitude were detected correctly.  If they are not, correct them.  Click Finish. 

6. Select Multiple Symbol and click Next. These instructions show you how to color code 
accident log points by speed at T0. T0 is the middle point of the accident log.   

7. In "Select the data filed or column to map" list, select highSpeed.  In "Divide the data you 
chose above by" list, select <None>. In "Show the data by" list, select Latitude & 
Longitude. Click Next. 

8. Enter the speed divisions you want to use and the color for each division. 

9. Click Finish to plot the points. 

10. In the left frame, right click highSpeed by Latitude & Longitude. Select Properties. 
Open the Balloon tab and select gpsDateTime, highSpeed and any other fields you want 
to view. 

11. Zoom in enough to see individual points, right click on a point, and select  Show 
Information, to look at data for that particular point. 

12. MapPoint allows you to navigate around on the map pretty well.  Some useful keystrokes 
are &rsquor;+’ to zoom in and &rsquor;-&rsquor; to zoom out.  Also, you can draw a box 
around an area and then click in it to zoom into it.  You can scroll the map using your 
mouse by just positioning the mouse cursor on the side of the map you want to scroll into. 
  

 

See also: 

Export: GPS to Mapping Software 

 

Back to File Menu | Export Menu 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

How to View Maps 

How to View Maps 

Viewing Trip Maps 

Viewing Day Maps 
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Viewing Accident Log Maps 

 

Back to  FMS Quick Reference | Mapping Quick Reference 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Viewing Trip Maps 

The following topics will help you view and understand Trip Maps. 

Trip Map Features 

Click this link for information on Trip Map features in MapPoint, Google Maps, and Google Earth. 

Map Navigation 

Click this link for explanations of navigating in map windows in MapPoint, Google Maps, and 
Google Earth. 

Viewing GPS Plot Information 

Click this link for an explanation of viewing GPS plot information in MapPoint. 

 

Back to  Mapping Quick Reference Menu | How to View Maps 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Viewing Day Maps 

The following topics will help you view and understand Day Maps. Click on any topic for more 
details on using Day Maps. 

Day Map Features 

Map Navigation 

Viewing GPS Plot Information 

 

Back to  Mapping Quick Reference Menu | How to View Maps 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Viewing Accident Log Maps 

The following topics will help you view and understand Accident Log Maps. Click on any link for 
more details on using Accident Log Maps. 

Accident Log Map Features 
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Map Navigation 

Viewing GPS Plot Information 

Back to  Mapping Quick Reference Menu | How to View Maps 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Accident Mapping 

Accident Log Map Features 

If you are using MapPoint as your mapping tool, an Accident Log Map consists of the following 
key elements: 

Title Bar 

The title bar at the top of the map window shows the type of map, the company location, 
DriveRight ID, driver name, and date of the trip. 

 

 

Overview Map 

The overview map shows the general area of the map and is located on the left side of the 
window just below the title bar.  

 

 

Legend 

 A legend of map symbols is located just below the Overview Map. 

 Each Accident Log pushpin represents an Accident Log record. Pushpins are indicated 
by yellow triangles on Accident Log Maps viewed with MapPoint, as shown below. 
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Map Window 

The Accident Log Report map puts an accident pushpin on the location of each accident in the 
Accident Log Report. 

 To see a summary of the accident information, click an accident log pushpin. In 
MapPoint, these pushpins are indicated by a yellow triangle, as shown in the Map 
Window legend. 

. 

 To see a Trip Map of the trip in which an accident occurred, double-click the accident 
pushpin. Refer to Viewing Trip Maps for information on viewing the Accident Trip Map. 

 
Full Map View  
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If you are using Google Maps as your mapping tool, an Accident Log Map consists of the 
following key elements (click any heading to display more detail): 

Views 

In the upper-right corner of the window, you can click the Map, Satellite, or Terrain buttons to 
display different views, including aerial images and street-level imagery. 

 

Navigation Controls 

Use this tool to navigate left, right, up, or down, or to zoom in or out in the Google Map window. 
You can also click and drag anywhere on the map to move it in any direction, or use your 
keyboard's up, down, left, or right arrows to move north, south, east, or west, respectively. 
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Legend 

Each Accident Log pushpin represents an Accident Log record. Pushpins are indicated by yellow 
triangles on Accident Log Maps viewed with Google Maps, as shown below. 

 

 

 

Info Window 

This window displays additional information when you click on any accident pushpin. 
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For more detailed instructions on all of the controls and features of Google Maps, go to Basics - 
The Google Maps User Guide at: 

http://maps.google.com/support/bin/answer.py?hl=en&answer=68259.  

 

If you are using Google Earth as your mapping tool, an Accident Log Map includes the following 
key elements (click any heading to display more detail): 

Navigation Controls 

Use this tool to navigate left, right, up, or down, or to zoom in or out in the Google Earth window. 
You can also click and drag anywhere on the 3D map to move it in any direction, or use your 
keyboard's up, down, left, or right arrows to move north, south, east, or west, respectively. 
Because the Google Earth map is a 3D image, when you "pan" in any direction, you are 
presented with an image that simulates that you are rotating the Earth on its axis. 

A detailed explanation of how to use the "North-up" button, the Look and Move joysticks, and the 
Zoom slider are listed below the image. 
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1. Click the north-up button to reset the view so that north is at the top of the screen. Click 
and drag the ring to rotate your view.  

2. Use the Look joystick to look around from a single vantage point, as if you were turning 
your head. Click an arrow to look in that direction or continue to press down on the 
mouse button to change your view. After clicking an arrow, move the mouse around on 
the joystick to change the direction of motion.  

3. Use the Move joystick to move your position from one place to another. Click an arrow to 
look in that direction or continue to press down on the mouse button to change your view. 
After clicking an arrow, move the mouse around on the joystick to change the direction of 
motion.  

4. Use the zoom slider to zoom in or out (+ to zoom in, - to zoom out) or click the icons at 
the end of the slider. As you move closer to the ground, Google Earth swoops (tilts) to 
change your viewing angle to be parallel to the Earth's surface. You can turn off this 
automatic tilt (Tools > Options > Navigation > Navigation controls; Mac: Google Earth > 
Preferences > Navigation > Navigation controls).  

Hide/Show Sidebar 

Click this control (at the top of the window) to conceal or display the side bar (Search, Places and 
Layers panels).  

 

Legend 

Each Accident Log pushpin represents an Accident Log record. Pushpins are indicated by yellow 
triangles on Accident Log Maps viewed with Google Earth, as shown below. 
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Info Window 

This window displays additional information when you click on any accident pushpin. 

 

For more detailed instructions on all of the controls and features of Google Earth, go to The 
Google Earth User Guide at: 

http://earth.google.com/intl/en/userguide/v4/#navcontrols. 

 

Back to  Mapping Quick Reference Menu | Mapping Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

 

Day Mapping 

Day Map Features 

If you are using MapPoint as your mapping tool, a Day Map consists of the following key 
elements. Click any of these five headings for additional details about each element of MapPoint 
Day Maps. 

Title Bar 

The title bar at the top of the map window shows the type of map, the company location, 
DriveRight ID, driver name, and date of the trip. 

 

Overview Map 

The overview map shows the general area of the map and is located on the left side of the 
window just below the title bar.  
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Legend 

 A legend of map symbols is located just below the Overview Map. 

 Each pushpin in the Day Map indicates a GPS record. A different pushpin color identifies 
each trip taken on the selected day. 

 You can create a single trip map for any trip in a Day Map by double-clicking a pushpin 
from that trip. See Viewing Trip Maps for more info on viewing a single trip map. 

 Double-clicking on a pushpin in the mapped trip will return the map to the normal Day 
Map showing multiple trips. 

 

Map Window 

The Day Map plots all of the trips taken by a vehicle on the selected day. A different color Day 
Map pushpin is used for each trip From inside the map window you can move the area shown in 
the window,  zoom a selected area, zoom in and out, and view GPS data.  
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Full Map View  
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If you are using Google Maps as your mapping tool, a Day Map consists of the following key 
elements (click any heading to display more detail): 

Views 

In the upper-right corner of the window, you can click the Map, Satellite, or Terrain buttons to 
display different views, including aerial images and street-level imagery. 

 

Navigation Controls 

Use this tool to navigate left, right, up, or down, or to zoom in or out in the Google Map window. 
You can also click and drag anywhere on the map to move it in any direction, or use your 
keyboard's up, down, left, or right arrows to move north, south, east, or west, respectively. 
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Legend 

In Google Maps, Day Trips can be viewed in two ways: 

1. as an Overview, showing all of the trips for one day in a single view 

2. as individual trips, showing each trip by itself 

Viewing Trips in Overview Mode 

To see all of the trips for one day in Overview mode, click the pulldown menu in the upper-left 
corner and select Overview. 

 

When viewing all trips in Overview mode, the colored symbols at the bottom left corner of the 
map indicate which symbols on the Overview correspond to individual trips for that day. 

 

DriveRight FMS supports up to 64 trips (represented on the map by eight shapes and eight 
colors) on a single Day Map. The eight shapes and eight colors are used to represent multiple 
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trips, and are shown below. The shapes and colors are used in the order shown. This means 
that Trip 1 is shown with a black circle, Trip 2 with a red circle, and Trip 8 with a purple circle. Trip 
9 will be shown with a black star, trip 10 with a red star, and so on, to a maximum of 64 trips. 

Shapes:  

Colors:  

Viewing Individual Trips 

To see a single trip for the selected day, click the pulldown menu in the upper-left corner and 
select any one of the indicated time periods. 

 

When viewing a single trip on the Day Map, the colored circles at the bottom left corner of the 
map now indicate the vehicle's speed range at each GPS plot point during the selected trip 
shown on the map. Also, Trip Start and Trip End pushpins are shown, which indicate the start and 
end of the selected trip. 
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Info Window 

This window displays additional information when you click on any trip marker. 

 

For more detailed instructions on all of the controls and features of Google Maps, go to Basics - 
The Google Maps User Guide at: 

http://maps.google.com/support/bin/answer.py?hl=en&answer=68259.  

 

If you are using Google Earth as your mapping tool, a Day Map includes the following key 
elements (click any heading to display more detail): 

Navigation Controls 

Use this tool to navigate left, right, up, or down, or to zoom in or out in the Google Earth window. 
You can also click and drag anywhere on the 3D map to move it in any direction, or use your 
keyboard's up, down, left, or right arrows to move north, south, east, or west, respectively. 
Because the Google Earth map is a 3D image, when you "pan" in any direction, you are 
presented with an image that simulates that you are rotating on the Earth's axis. 

A detailed explanation of how to use the "North-up" button, the Look and Move joysticks, and the 
Zoom slider are listed below the image. 
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1. Click the north-up button to reset the view so that north is at the top of the screen. Click 
and drag the ring to rotate your view.  

2. Use the Look joystick to look around from a single vantage point, as if you were turning 
your head. Click an arrow to look in that direction or continue to press down on the 
mouse button to change your view. After clicking an arrow, move the mouse around on 
the joystick to change the direction of motion.  

3. Use the Move joystick to move your position from one place to another. Click an arrow to 
look in that direction or continue to press down on the mouse button to change your view. 
After clicking an arrow, move the mouse around on the joystick to change the direction of 
motion.  

4. Use the zoom slider to zoom in or out (+ to zoom in, - to zoom out) or click the icons at 
the end of the slider. As you move closer to the ground, Google Earth swoops (tilts) to 
change your viewing angle to be parallel to the Earth's surface. You can turn off this 
automatic tilt (Tools > Options > Navigation > Navigation controls; Mac: Google Earth > 
Preferences > Navigation > Navigation controls).  

Hide/Show Sidebar 

Click this control (at the top of the window) to conceal or display the side bar (Search, Places and 
Layers panels).  

 

Legend 

In Google Earth, Day Maps can be viewed in two ways: 

1. as an Overview, showing all of the trips for one day in a single view 

2. as individual trips, showing each trip by itself 

Viewing Trips in Overview Mode 

58 



DriveRight FMS Help 

To see all of the trips for one day in Overview mode, locate the Places section of the legend on 
the left side of the Google Earth Day Map. Click the Overview button in the Temporary Places 
folder for your selected day and a Day Map will display showing all of the trips for the selected 
day. 

 

When viewing all trips in Overview mode, the colored symbols at the bottom left corner of the 
map indicate which symbols on the Day Mapcorrespond to individual trips for that day. 

 

DriveRight FMS supports up to 64 trips (represented on the map by eight shapes and eight 
 colors) on a single Day Map. The eight shapes and eight colors are used to represent multiple 
trips, and are shown below. The shapes and colors are used in the order shown. This means 
that Trip 1 is shown with a black circle, Trip 2 with a red circle, and Trip 8 with a purple circle. Trip 
9 will be shown with a black star, trip 10 with a red star, and so on, to a maximum of 64 trips. 

Shapes:  

Colors:  

  

Viewing Individual Trips 
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To see a single trip for the selected day, click any of the "time-period" buttons below the Overview 
button, and a new map is displayed showing the selected trip. 

 

When viewing a single trip on the Day Map, the colored circles at the bottom left corner of the 
map now indicate the vehicle's speed ranges during the selected trip shown on the map. Also, 
pushpins are displayed showing the Trip Start and Trip End points, as shown below. 

 

Info Window 

This window displays additional information when you click on any trip marker. 
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For more detailed instructions on all of the controls and features of Google Earth, go to The 
Google Earth User Guide at: 

http://earth.google.com/intl/en/userguide/v4/#navcontrols. 

  

Back to  Mapping Quick Reference Menu | Mapping Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

 

Trip Mapping 

Trip Map Features 

If you are using MapPoint as your mapping tool, a Trip Map consists of the following key 
elements: (Click any heading to display more detail.) 

Title Bar 

The title bar at the top of the map window shows the type of map, the company location, 
DriveRight ID, driver name, and date of the trip. 
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Overview Map 

The overview map shows the general area of the map and is located on the left side of the 
window just below the title bar.  

 

 

Legend 

 A legend of map symbols is located just below the Overview Map. 

 A realistic looking pushpin indicates the starting and stopping points in a Trip Map.  

 Round pushpins indicate the GPS plot points in a trip.  

 When viewing a trip map, the round pushpin colors indicate vehicle speed.  

 Use the Set Speed Ranges command in the Mapping Menu to set the number of speed 
ranges and the speeds included in each range.  

 

 

Map Window 

The Trip map window plots the GPS record to show where the vehicle went, when the trip started 
and stopped, and indicates vehicle speed over the course of the trip. From inside the map 
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window you can navigate around the map's location, zoom in and out, and view data for individual 
GPS records.  
 

 

Full Map View  
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If you are using Google Maps as your mapping tool, a Trip Map consists of the following key 
elements (click any heading to display more detail): 

Views 

In the upper-right corner of the window, you can click the Map, Satellite, or Terrain buttons to 
display different views, including aerial images and street-level imagery. 

 

Navigation Controls 

Use this tool to navigate left, right, up, or down, or to zoom in or out in the Google Map window. 
You can also click and drag anywhere on the map to move it in any direction, or use your 
keyboard's up, down, left, or right arrows to move north, south, east, or west, respectively. 
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Info Window 

This window displays additional information when you click on any trip marker. 

 

Legend 

 In Google Maps a legend of map symbols is located just below the Overview Map. 

 Realistic looking pushpins indicate the starting and stopping points on a Trip Map, and 
each one is labeled with the start and stop time. 

 

65 



DriveRight FMS User's manual 

 Round pushpins indicate the GPS plot points in a trip.  

 The different colored round pushpins indicate different vehicle speeds at different GPS 
plot points, as shown in the legend of map symbols (below). 
  

 

 

 

For more detailed instructions on all of the controls and features of Google Maps, go to Basics - 
The Google Maps User Guide at: 

http://maps.google.com/support/bin/answer.py?hl=en&answer=68259.  

 

If you are using Google Earth as your mapping tool, a Trip Map includes the following key 
elements (click any heading to display more detail): 

Navigation Controls 

Use this tool to navigate left, right, up, or down, or to zoom in or out in the Google Earth window. 
You can also click and drag anywhere on the 3D map to move it in any direction, or use your 
keyboard's up, down, left, or right arrows to move north, south, east, or west, respectively. 
Because the Google Earth map is a 3D image, when you "pan" in any direction, you are 
presented with an image that simulates that you are rotating on the Earth's axis. 

A detailed explanation of how to use the "North-up" button, the Look and Move joysticks, and the 
Zoom slider are listed below the image. 
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1. Click the north-up button to reset the view so that north is at the top of the screen. Click 
and drag the ring to rotate your view.  

2. Use the Look joystick to look around from a single vantage point, as if you were turning 
your head. Click an arrow to look in that direction or continue to press down on the 
mouse button to change your view. After clicking an arrow, move the mouse around on 
the joystick to change the direction of motion.  

3. Use the Move joystick to move your position from one place to another. Click an arrow to 
look in that direction or continue to press down on the mouse button to change your view. 
After clicking an arrow, move the mouse around on the joystick to change the direction of 
motion.  

4. Use the zoom slider to zoom in or out (+ to zoom in, - to zoom out) or click the icons at 
the end of the slider. As you move closer to the ground, Google Earth swoops (tilts) to 
change your viewing angle to be parallel to the Earth's surface. You can turn off this 
automatic tilt (Tools > Options > Navigation > Navigation controls; Mac: Google Earth > 
Preferences > Navigation > Navigation controls).  

Hide/Show Sidebar 

Click this control (at the top of the window) to conceal or display the side bar (Search, Places and 
Layers panels).  

 

Info Window 

This window displays additional information when you click on any trip marker. 
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Legend 

 In Google Earth a legend of map symbols is located just below the Overview Map. 

 Realistic looking pushpins indicate the starting and stopping points on a Trip Map, and 
each one is labeled with the start and stop time. 

 

 Round pushpins indicate the GPS plot points in a trip.  

 The different colored round pushpins indicate different vehicle speeds at different GPS 
plot points, as shown in the legend of map symbols (below). 
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For more detailed instructions on all of the controls and features of Google Earth, go to The 
Google Earth User Guide at: 

http://earth.google.com/intl/en/userguide/v4/#navcontrols. 

  

 

Back to  Mapping Quick Reference Menu | Mapping Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

 

 

Mapping Menu 

Note: DriveRight FMS Mapping requires Microsoft MapPoint, Google EarthTM, or Google MapsTM. 
To use Google Earth you must have the Google Earth application installed on your computer (go 
to http://earth.google.com/ for a free download). To use Google Maps you must have any of the 
following three web browsers installed on your computer: 

 Internet Explorer 

 Firefox 

 Safari 

The following commands are available in the Mapping Menu: 

Open Map 

Save Map 

E-Mail Map 

Select Mapping Tool 
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Set Speed Range 

See also: 

Mapping Quick Reference Menu 

DriveRight FMS Mapping Requirements 

Back to Menu Commands 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight FMS Mapping Requirements 

The following equipment and software are required to use DriveRight FMS mapping functions: 

 For DriveRight 600: 

 DriveRight 600 (# 8156)  

 DriveRight GPS Module (# 8157) 

 For DriveRight 600E: 

 DriveRight 600e ( # 8126) 

 DriveRight GPS/Wireless Interface Module (# 8127) 

 GPS Module (# 8128) 

 For CarChip Fleet Pro: 

 CarChip Fleet Pro (# 8246) 

 CarChip GPS/Wireless Interface Module (# 8251) 

 GPS Module (# 8128) 

 MapPoint Mapping:  

 Microsoft MapPoint 2002, 2004, or 2006 

Note: Davis Instruments recommends that you do not use MapPoint version 2009. 
This version is not compatible with FMS version 3.9.2. 

 In addition to the system requirements for DriveRight FMS 3.2 or later, Microsoft 
recommends a minimum of 64 MB of memory to run MapPoint. 

 MS MapPoint or MapPoint Control Run-Time must be installed on the computer running the 
DriveRight FMS. 

 Google Mapping:  

 Google EarthTM and a web browser (Internet Explorer, Firefox, or Safari) 

 an internet connection 
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Back to Mapping Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Viewing GPS Plot Information 

Each push-pin symbol used to plot a trip represents a DriveRight GPS record. You can display 
the GPS data for one of  the plot points by clicking the push-pin. An information box opens for the 
symbol displaying the GPS coordinates, DriveRight ID, GPS date and time, day of the week, and 
driver ID. 

To modify the MapPoint GPS data display: 

Note: Your GPS data can only be modified if you have chosen MapPoint as your mapping tool. If 
you have chosen Google MapsTM or Google EarthTM as your mapping tool, you cannot change the 
displayed GPS data. 

1. Place the cursor inside the plot symbol legend window. 

2. Select the Properties right-click mouse command. 

3. Click on the Balloon tab at the top right of Properties dialog box. All the available GPS 
data parameters are listed in the dialog box.  

4. Check a parameter to include it in the displayed plot information. 

5. Removing a check will remove that parameter from the summary. 

Back to  Mapping Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

Wireless Quick Reference Menu 

Wireless Quick Reference Menu 

The Wireless Menu lets you configure the wireless devices in your Wireless Download System, 
perform wireless scans and downloads, and upgrade wireless device firmware. The following 
quick reference menu helps you get started using the Wireless Download System. 

How to Add a Base Station 

How to Add a Wireless On-Board Module 

How to Select an Operating Region 

How to Scan for Wireless On-Board Modules 

How to Set Up an Automatic Wireless Download 

How to Start a Manual Wireless Download 
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How to Upgrade Firmware 

Back to FMS Quick Reference Menu | Wireless Menu 
  

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

How to Add a Base Station 

The Add New Base Station dialog box configures the Base Station to wirelessly communicate 
with Wireless On-Board Modules and allows you to assign a position to it that makes it easily 
identifiable throughout FMS. 

To add a new Base Station: 

1. Connect your Base Station to the computer's USB port. 

2. Select Add New Base Station from the Wireless Menu. If this is the first time a Base 
Station or Wireless On-Board Module has been added to FMS, the Select Operating 
Region dialog box displays. 
 

 

3. Select among the three choices displayed: North America, Europe, or Other. The 
operating region determines the power level of the wireless devices. Select Europe if the 
power levels of the wireless devices must not exceed CE certification requirements of 
less than 10 dBm. Select North America if the power levels of the wireless devices must 
not exceed FCC or IC certification requirements of less than 30 dBm. Select Other if the 
operating region is not North America or Europe.     

4. Click OK to save the operating region information or click Cancel to exit without saving. 
The Add New Base Station dialog box displays. 
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The dialog box displays the location and the Position text field. If the Base Station 
belongs to a different location, select the correct location from the Current Location dialog 
box before adding the Base Station. 

5. Enter a position description in the Position text box. The maximum number of characters 
for the Position text box is 32. 

6. Click Add to add the new Base Station or Cancel to exit the dialog box without saving 
the new Base Station. 
 
If you clicked Add, a dialog box is displayed to confirm that the Base Station has been 
added to FMS. 
 

 
  

7. Click OK to exit the dialog box. 

 

Back to FMS Quick Reference Menu | Wireless Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

How to Add a Wireless On-Board Module 

To add a new Wireless On-Board Module: 

1. Use the Configuration Cable to connect the Wireless On-Board Module to your computer. 

2. Select Add New Wireless On-Board Module from the Wireless Menu.  
 
If this is the first time a Base Station or Wireless On-Board Module has been added to 
FMS, the Select Operating Region dialog box displays. 
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3. Select among the three choices displayed: North America, Europe, or Other. The 
operating region determines the power level of the wireless devices. Select Europe if the 
power levels of the wireless devices must not exceed CE certification requirements of 
less than 10 dBm. Select North America if the power levels of the wireless devices must 
not exceed FCC or IC certification requirements of less than 30 dBm. Select Other if the 
operating region is not North America or Europe.     
 
Once an operating region has been selected, the Add New Wireless On-Board Module 
dialog box displays. 
 

 
 
The dialog box displays the location the Wireless On-Board Module belongs to and the 
Vehicle ID/Lic. Plate drop-down list box.  

4. Select a Vehicle ID or license plate number from the Vehicle ID/Lic Plate drop-down list 
box, or select Automatic. Selecting a Vehicle ID or License plate from the drop down list 
assigns the Wireless On-Board Module to that vehicle. Click Browse to display the 
Vehicles database table. Review the full list of available vehicles to better determine the 
vehicle that gets assigned to the Wireless On-Board Module. Select Automatic if you do 
not want to select a vehicle at this time. The next time either Scan Wireless On-Board 
Modules or Start Manual Wireless Download is selected, or an Automatic Wireless 
Download has occurred, the correct Vehicle ID will be assigned to the Wireless On-Board 
Module based on the vehicle information stored on the DriveRight device.  

5. Click Add to add the new Wireless On-Board Module or Cancel to exit the dialog box 
without saving the new Wireless On-Board Module. 
 
If you clicked Add, the New Wireless On-Board Module dialog box displays, confirming 
that the Wireless On-Board Module has been added to FMS and is configured for use 
with your wireless fleet. 
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6. Click OK to exit the dialog box. 

Once the Wireless On-Board Module has been added to the FMS database, it can be installed in 
its assigned vehicle or any vehicle in your fleet if you selected Automatic in the Vehicle ID/Lic 
Plate drop-down list box. See the DriveRight GPS/Wireless System Installation Manual for 
more information on its installation and proper usage. 

Note: The Wireless On-Board Module should only be installed to its assigned vehicle unless 
Automatic is selected when adding the module. 

 

Back to FMS Quick Reference Menu | Wireless Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

How to Select an Operating Region 

The Select Operating Region dialog box lets you select an operating region to the wireless 
device(s). Selecting a region adjusts the operating legal power of the  wireless device(s). 

1. Select Select Operating Region from the Wireless Menu. The Select Operating 
Region dialog box displays. 
 
The Select Operating Region dialog box displays automatically the first time you select 
Add New Base Station, Add New Wireless On-Board Module, or Upgrade Firmware from 
the Wireless Menu. The same operating region selection applies to all wireless devices 
added to the database. 
 

 

2. Select among the three choices displayed: North America, Europe, or Other. The 
operating region determines the power level of the wireless devices. Select Europe if the 
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power levels of the wireless devices must not exceed CE certification requirements of 
less than 10 dBm. Select North America if the power levels of the wireless devices must 
not exceed FCC or IC certification requirements of less than 30 dBm. Select Other if the 
operating region is not North America or Europe. 

3. Click OK to save the operating region information or click Cancel to exit without saving. 

Note: Changing the operating region at any time only affects the settings of the subsequently 
added wireless devices, not the ones that have been previously added to the system. To re-
configure the setting for previously added devices, remove the wireless device(s) from the 
Wireless Devices database table in the Database menu, reconnect the device(s), change the 
operating region for the device(s), then add the wireless device(s) back into the database. 

 

Back to FMS Quick Reference Menu | Wireless Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

How to Scan for Wireless On-Board Modules 

The Scan Wireless On-Board Modules dialog box uses the Base Station(s) to scan all of the 
Wireless On-Board Modules in the current location and displays the wireless communication 
status of each Wireless On-Board Module. 

Note: At the top of each hour, the Wireless On-Board Module is turned off by the DriveRight or 
Carchip device for up to five minutes. This is done to allow the DriveRight  or CarChip to turn on 
the GPS module to refresh the satellite position periodically. This occurs even without a GPS 
module being physically connected to your DriveRight or Carchip device. FMS will not be able to 
communicate with the Wireless On-Board Module(s) during this time. 

1. Select Scan Wireless On-Board Modules from the Wireless Menu. The Scan Wireless 
On-Board Modules displays a list of all the Wireless On-Board Modules in your 
database associated with the currently selected location. 
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2. Click Start to scan all of the Wireless On-Board Modules. As the Base Station scans for 
the Wireless On-Board Modules, the status of each of the modules displays under the 
Status column.  
 

 
 
  

The color box provides a visual representation of the status for each of the Wireless On-Board 
Modules in the database. The color is updated throughout the scan process. The Status column 
on the right hand side of the dialog box also documents the status for each module. The possible 
statuses are: 
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  Not Yet - The Base Station has not yet scanned for the Wireless On-Board Module. 
 

  Searching for Vehicle - The Base Station is currently searching for the Wireless On-
Board module. 
 

  Successful - The Base Station has successfully found and communicated with 
Wireless On-Board Module. 
 

  Failed - The Base Station has not successfully communicated with or found errors in 
communicating with the Wireless On-Board Module. The scan will continue to search for 
the "Failed" Wireless On-Board Modules until the maximum of 10 retries has been 
reached. The following is a status list that corresponds to the red color box: 

 Vehicle ID Mismatch  - The Wireless On-Board Module is not installed in the assigned 
vehicle. To correct this problem, select the Wireless On-Board Module's record in the 
Wireless Devices database table and click Edit. The Edit Wireless On-Board Module 
dialog box displays information about the On-Board Module. Change the Vehicle ID field 
of the Wireless On-Board Module to Automatic to allow FMS to find the Vehicle's ID 
automatically. You can also install the Wireless On-Board Module into the assigned 
vehicle. 

 Device Not Assigned - The DriveRight has not been assigned to a vehicle, the Carchip 
has not been assigned to a vehicle or a driver, or the DriveRight or CarChip has not been 
added to the FMS Database. Add the DriveRight or CarChip and assign it to the 
corresponding vehicle or driver. 

 Device Not Available - FMS is able to communicate with the Wireless On-Board 
module, but is not able to get a response from the device (DriveRight or CarChip) which 
is connected to the Wireless On-Board Module. Try to restore power to the device or 
reconnect the device to fix the problem. 

 Vehicle Not Found - The Vehicle and Wireless On-Board Module are not within range of 
the Base Station. This status also occurs when there is an error communicating with the 
DriveRight or CarChip device. See Wireless Device Communication Problems for more 
information. 

3. Click Stop to abort the scan before it is completed or click Close to close the dialog box 
once the scan has completed. Please note that if you stop scanning before it completes the scan, 
the last vehicle it scans automatically contains a failed status. 

Note: Since it is not required to select a vehicle when adding a new Wireless On-Board Module, 
Unknown is displayed under the Vehicle ID column to indicate that a vehicle has not been 
assigned to a Wireless On-Board Module. 

 

Back to FMS Quick Reference Menu | Wireless Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

How to Set Up an Automatic Wireless Download 

The Setup Automatic Wireless Download dialog box lets you select when to automatically 
download some or all vehicles that are wirelessly connected to FMS.  

Note: FMS has to be running for the Automatic Wireless Download to occur. 
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1. Select Setup Automatic Wireless Download from the Wireless Menu. The Setup 
Automatic Wireless Download dialog box lets you select the vehicles you want to 
automatically download daily.  
 
By default, a vehicle associated with a newly added Wireless On-Board Module is 
automatically placed in the Vehicles in Download Queue list. This also applies to 
"Unknown" vehicles.  
 

 
 
The Available Vehicles list shows all available vehicles for the current location. The 
Vehicles in the Download Queue list shows the vehicles selected for automatic wireless 
download. 

2. Click >>, All>>,  <<, or All<< to move the vehicles between these two lists. 

3. Enter the time FMS will begin the automatic download process in the Start Time box or 
click the Up or Down arrow buttons to change the start time. The default time is 6:00 PM.  

4. Enter the amount of time you would like FMS to search for the selected vehicles in the 
Duration box or click the Up or Down arrow buttons to increment or decrement the 
hours. The duration allows you to prolong the time for retries when the Wireless On-
Board Modules are not immediately available for download, because they are either out 
of range or currently powered off. 

5. Check the Include Weekend box to automatically download all seven days of the week. 
"Weekend" is defined in the Night and Weekend Settings dialog box. If the start time 
selected in this dialog box falls within the "weekend"  time frame selected in the Night 
and Weekend Settings dialog box, download will not take place during the day or days 
included in the "weekend" definition unless the Include Weekend box is checked. 
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6. Click OK to save the automatic wireless download settings and prepare FMS to 
automatically download the Wireless On-Board Modules or click Cancel to exit without 
saving. 

Note: Since it is not required to select a vehicle when adding a new Wireless On-Board Module, 
Unknown is displayed under the Vehicle ID column to indicate that a vehicle has not been 
assigned to a Wireless On-Board Module.  

Note: Only one wireless download process is allowed at a time. If an automatic download is 
scheduled during a manual download, the automatic download will be delayed until the manual 
download is completed. If the duration period for the Automatic Download has expired before the 
manual download has finished, Automatic Download will not take place for that day.  

 

Back to FMS Quick Reference Menu | Wireless Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

How to Start a Manual Wireless Download 

Different from the Automatic Wireless Download, The Start Manual Wireless Download dialog 
box lets you select some or all vehicles in your fleet to wirelessly download immediately once you 
press Start Download.  

1. Select Start Manual Wireless Download from the Wireless Menu or click the Manual 
Wireless Download Icon from the toolbar. The Start Manual Wireless Download dialog 
box lets you select the vehicles you want to download at this time.  
 

 
 
The Available Vehicles list shows all available vehicles for the displayed location. The 
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Vehicles in the Download Queue list shows the vehicles selected for manual wireless 
download. 

2. Click >>, All>>,  <<, or All<< to move the vehicles between these two lists. 

3. Enter the amount of time you would like FMS to search for the selected vehicles in the 
Duration box or click the Up or Down arrow buttons to increment or decrement the 
hours. The duration allows you to prolong the time for retries when the Wireless On-
Board Modules are not immediately available for download, because they are either out 
of range or currently powered off. 

4. Click Start Download to start the download or click Cancel to cancel the manual 
download. 
 
The Wireless Download Status dialog box displays when you click Start Download. 

Note:  Since it is not required to select a vehicle when adding a new Wireless On-Board Module, 
Unknown is displayed under the Vehicle ID column to indicate that a vehicle has not been 
assigned to a Wireless On-Board Module. 

Note: Only one wireless download process is allowed at a time. If you select Start Manual 
Wireless Download from the Wireless Menu while an automatic wireless download is in progress 
or the Wireless Download Status dialog box is currently displaying, the Do You Want to Suspend 
Automatic Wireless Download dialog box displays. If you click Yes, the Automatic Download will 
be suspended until the manual download is completed. If the duration period for the Automatic 
Download  expires before the manual download has finished, Automatic Download will not take 
place for that day.  

 

   
Back to FMS Quick Reference Menu | Wireless Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

How to Upgrade Firmware 

The Upgrade Firmware dialog box lets you update the firmware for both the wireless Base 
Station and Wireless On-Board Modules. 

Note: To upgrade the firmware, connect the wireless device(s) to the USB port(s) of the 
computer. Both the Wireless On-Board Module and the Base Station share the same firmware. 

To upgrade the firmware: 

1. Select Upgrade Firmware from the Wireless Menu.  
 
If this is the first time any wireless device has been connected  to FMS, the Select 
Operating Region dialog box displays. 
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2. Select among the three choices displayed: North America, Europe, or Other. The 
operating region determines the power level of the wireless devices. Select Europe if the 
power levels of the wireless devices must not exceed CE certification requirements of 
less than 10 dBm. Select North America if the power levels of the wireless devices must 
not exceed FCC or IC certification requirements of less than 30 dBm. Select Other if the 
operating region is not North America or Europe.  
 
Once an operating region has been selected, the Upgrade Firmware dialog box 
displays. 
 

 
  

3. Select a wireless device that you would like to upgrade from the Select Device to 
Upgrade drop-down list. The device is listed either as Base Station or Wireless On-Board 
Module. If you have multiple Base Stations connected, select the Base Station by its 
position. 

4. Click Upgrade if the Current Firmware Version is not the same as the Latest Firmware 
Version to upgrade the device firmware. A dialog box is displayed to confirm that the 
firmware has been upgraded successfully: 
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5. Click OK to exit the dialog box. 

6. Click Refresh if you have connected another device to your computer. The Select 
Device to Upgrade drop-down list refreshes to include the newly connected device(s).  

7. Click Close once you are finished upgrading all the wireless devices. 

   
Back to FMS Quick Reference Menu | Wireless Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Menu Commands 

Menu Commands Menu 

The following commands are available in the Main Menu: 

 

File Menu 

Setup Menu 

DriveRight Menu 

CarChip Menu 

SmartCard Menu 

Wireless Menu 

Database Menu 

Reports Menu 

Mapping Menu 

Help Menu 

 

Back to Home 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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File Menu 

File Menu 

The following commands are available in the File Menu: 

 

Backup 

Restore 

Import 

Export 

Print 

Print Preview 

Print Setup 

Clear Screen 

Exit 

 

 

Back to Menu Commands 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

Backup 

The Backup command is used to archive old data as a zip file. The backup files are stored in the 
Backup sub-directory in the DriveRight FMS install directory. The Backup sub-directory is created 
the first time you back up your data.  

The backup zip files are named based on the start and end dates chosen for the backup. For 
example, if you pick the dates between March 6, 2003 and March 27, 2003, the backup file will be 
named 6March2003_27March2003.zip. 

You can configure how much data to keep active after a backup by setting up your Preferences: 
Backup Options in the Setup menu. Limiting the amount of data in the active database helps 
prevent the database from growing into an unmanageable size. 

To backup data: 

1. Click Backup in the File menu. The Backup Files To dialog box is displayed. 
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2. From the Backup Files To dialog box select the folder where the backup file will be 
written. The Backup Options dialog box is displayed.  

Note: The Backup Options dialog box will not be displayed the first time you back up DriveRight 
data. 

 

3. In the Backup Options dialog box check your last backup date and specify whether to 
backup the whole database or only those records falling within a specified time period. The start 
date will always be initialized to the last backup date. 

4. Click OK to initiate the backup or click Cancel to exit the dialog box without backing up 
your database. 

5. When the backup is finished, click OK to return to the program. 
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See Also: 

Restore 

Preferences: Backup Options 

Back to File Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Restore 

The Restore command is used to get a previously Backed up data back into the active database. 
In this process you can pick one or more tables to be restored. 

To restore data: 

1. Click Restore in the File menu. The Restore Files From dialog box is displayed. 

 

2. From the Restored Files From dialog box select a single zip file to restore, and then 
click Restore. DriveRight FMS unzips the file and displays all the tables in the dialog, and 
displays the following dialog box: 
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Note: You can only restore one .zip file at a time. 

Note: The backup file filename is based on the start and end dates chosen for the backup. 

3. You can either restore all the database tables or restore individual database tables. Click 
Yes in the dialog box to restore all the tables. Click No to restore selected database tables. 

4. If you are restoring selected database tables, select each table to be restored. Hold down 
the Control key on your keyboard to select multiple tables. When you have finished making your 
selection, click Restore to restore the tables or click Cancel to exit without restoring the tables.  

 

5. When the files have been restored, click OK to return to the program. 

See Also: 

Backup 

Back to File Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Import Menu 

Import Menu 

Use the Import Menu options to import DriveRight database data into DriveRight. 

Import: FTP Import 

Import: Import Data From 
 
Import GPS Data into MapPoint 

Back to File Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Import: FTP Import 

FTP (File Transfer Protocol) Import allows you to import DriveRight data from a remote site. Use 
this procedure for FTP Import only. Use the Import: Other Import Commands procedure for all 
other import commands.  

Note: Before you start this operation, contact your systems administrator for your FTP account 
information. 

 

To use FTP Import: 

1. Select Import from the File Menu. 

2. Select FTP Import from the Import drop-down menu. The FTP Import dialog box is 
displayed. 
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3. In the FTP HostName edit box, type the name of the FTP server that you want to import 
the database tables from. eg: toolbox.davisnet.com 

4. In order to access the FTP site you must have a user account on the FTP site. Enter your 
user name and password in the edit boxes. 

5. In the Remote Path edit box, you can enter a specific directory path in the FTP server.  

6. Default port for the FTP site is 21. Use the default port unless the FTP site listens on a 
different port. 

7. Default connection to the FTP site is active mode. Some FTP sites allow only passive 
mode connections.(check the passive mode check box in that case). For details, contact your 
system administrator. 

8. Click Import. The following FTP Import dialog box displays, which displays the 
directories and files located at the specified location on the FTP server. 
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9. Locate and select the sub-directory named for the DriveRight FMS location from which 
you want to import the database tables. Click Import to open the directory. 

10. Locate and select the zip file containing the database tables you wish to import. Click 
Import to import the tables. 

11. When the files have been successfully imported, click OK to return to the program. 

Note: You can quit at anytime during importing by clicking the Cancel button. 

See also: 

Import: Other Import Commands 

Back to File Menu | Import Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Import: Import Data From 

Use the Import tables command to import individual DriveRight Tables into your database. This is 
the procedure for all import commands except FTP Import. 

 

To import data: 

1. Select Import in the File Menu. 

2. Select the table you wish to import (Drivers, Vehicles, Trips, etc.) from the list. 
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3. When the Import dialog box displays, go to the directory where the file to be imported are 
located. Select the file to be imported and click Import to import the data or click Cancel 
to exit without importing. 

 

See also 

Import: FTP Import 

Back to File Menu | Import Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Import GPS Data Into MapPoint 

Exported GPS Data can be easily importing into MS MapPoint using the MapPoint Import Data 
Wizard. 

 

To import GPS data into MapPoint: 

1. Start the MapPoint application. 

2. Select Import Data Wizard from the Data menu. 

3. Using the File dialog box find select the GPS.TXT file and click Open. 

4. "Tab" should be selected to separate the data. Click Next. 
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5. All exported fields appear in the next dialog box. Column headings are included and 
should be detected by the program.  All the columns should have <Other Data> as their 
data type except Latitude  and Longitude. Check to make sure the Latitude and 
Longitude were detected correctly.  If they are not, correct them.  Click Finish. 

6. Select Multiple Symbol and click Next. These instructions show you how to color code 
accident log points by speed at T0. T0 is the middle point of the accident log.   

7. In "Select the data filed or column to map" list, select highSpeed.  In "Divide the data you 
chose above by" list, select <None>. In "Show the data by" list, select Latitude & 
Longitude. Click Next. 

8. Enter the speed divisions you want to use and the color for each division. 

9. Click Finish to plot the points. 

10. In the left frame, right click highSpeed by Latitude & Longitude. Select Properties. 
Open the Balloon tab and select gpsDateTime, highSpeed and any other fields you want 
to view. 

11. Zoom in enough to see individual points, right click on a point, and select  Show 
Information, to look at data for that particular point. 

12. MapPoint allows you to navigate around on the map pretty well.  Some useful keystrokes 
are &rsquor;+’ to zoom in and &rsquor;-&rsquor; to zoom out.  Also, you can draw a box 
around an area and then click in it to zoom into it.  You can scroll the map using your 
mouse by just positioning the mouse cursor on the side of the map you want to scroll into. 
  

 

See also: 

Export: GPS to Mapping Software 

 

Back to File Menu | Export Menu 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

Export Menu 

Export Menu 

Use the export menu options to export DriveRight FMS data. 

FTP Export - Use the FTP Export command to export database data to a remote site. 

Export GPS to MapPoint - Use the Export GPS to Mapping Software command to export GPS 
data in a format designed to be imported into mapping software. 

Export Accidents to MapPoint - Use the Export Accidents to Mapping Software command to 
export accident GPS data in a format designed to be imported into mapping software. 
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Other Export Commands - Use the other export commands to export the indicated type of data in 
a tab-delimited text file. 

Back to File Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Export: FTP Export 

The FTP (File Transfer Protocol) Export feature shows all the available database tables that you 
want to export to the FTP site. By default all tables are selected. You can un-check the tables that 
you don’t want to export. 

Note: Before you start this operation, contact your systems administrator for your FTP account 
information. 

 

Steps to follow: 

1. Select Export in the File Menu. 

2. Select the FTP Export from the menu list. The FTP Export dialog box is displayed. 
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3. In the FTP Host Name box, type the name of the FTP server to which you want to export 
the database tables.  

4. Enter your user name and password in the appropriate boxes. To access the FTP site 
you must have a user account on the FTP site.  

5. Enter a specific directory path in the FTP server to which to export your files in the 
Remote Path box  

6. Enter a port number in the Port box. The default port for the FTP site is 21. Use the 
default port unless the FTP site listens on a different port. 

7. Click Use Passive Mode if the FTP site uses passive mode. The default connection to 
the FTP site is active mode. Some FTP sites allow only passive mode connections. Check the 
Passive Mode check box in that case. For details, contact your system administrator. 

8. Select the database tables to be exported by clicking the box for each table. Click a 
second time to de-select the table. 

9. Select the Export data between box to specify the time interval you want to export. The 
default start date for the interval is the date of the last export. The default end date is the current 
date. You can change the start and end dates as required. If you have exported data previously, 
the last date of export is displayed in the dialog box. 

10. Click Export once you are done with the above steps or click Cancel to exit without 
exporting data. The program creates a sub-directory with your current location name on the FTP 
site, if it doesn't already exist, and then exports a ZIP file to the sub-directory. The default name 
for the export ZIP file is "day" + "month" + "year".zip (20jan2007.zip). 

 

Back to File Menu | Export Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Export: GPS to MapPoint 

Note: This feature is only enabled if you have chosen MapPoint as your mapping tool. This 
feature is not supported in Google MapsTM or Google EarthTM. 

To export GPS data: 

1. Go to File > Export. 

2.  Select GPS to MapPoint in the drop-down Export menu.  

The GPS Fields dialog box displays. 
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3. Click Select All to check all fields. Click Clear All to clear all fields. Click in the box for 
each field to toggle the check on and off.  
 
Note: Only the checked GPS fields will be exported. These key fields should always be selected: 
GPS DateTime, Speed, High Speed, Latitude and Longitude. 
  

4. Click OK in the GPS Fields box to continue, click Cancel to exit. If you click OK, the 
Export GPS To dialog box is displayed. 

 

3. The default file name is GPS.TXT and the default directory is the DriveRight FMS install 
directory. You can edit or change the file name directly in the text box. You can also change the 
directory in which the exported GPS data file will be saved.   
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4. Click Set Filter  to narrow the selection of GPS data to be exported.   

5. Click Browse to view the GPS data before you export it. 

6. Click OK when you are ready to export the GPS data or click Cancel to exit without 
exporting data. If you click OK, the exported GPS data will be saved in a file ready to be imported 
into your mapping software. 

See also: 

Import GPS Data Into MapPoint 

Back to File Menu | Export Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Export: Accidents to MapPoint 

Note: This feature is only enabled if you have chosen MapPoint as your mapping tool. This 
feature is not supported in Google MapsTM or Google EarthTM. 

To export accident log data: 

1. Go to File > Export. 

2. Select Accident to MapPoint.  

The Export AccidentLogs To dialog box is displayed. 

 

2. Select the file directory in which to save the accident log files. 
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3. Verify the file name for the accident log file. You can edit the name in the dialog box if 
desired. 

4. Click Export to create the accident log data file or click Cancel to exit.  If you click OK, 
the exported Accident Log data will be saved in a file ready to be imported into your mapping 
software. 

To import data into MapPoint: 

1. Start the MapPoint application. 

2. Select Import Data Wizard from the Data menu. 

3. Using the File dialog box find select the ACCIDENTLOGS.TXT file and click on Open. 

4. "Tab" should be selected to separate the data. Click Next. 

5. All the fields you exported will appear in the next dialog.  Column headings are included 
and should be detected by the program.  All the columns should have <Other Data> as 
their data type except Lat and Long.   Check to make sure the Lat and Long were 
detected correctly.  If they are not, correct them.  Click Finish. 

6. Select Multiple Symbol and click Next. These instructions show you how to color code 
accident log points by speed at T0. T0 is the middle point of the accident log.   

7. In "Select the data filed or column to map" list, select time_TO.  In "Divide the data you 
chose above by" list, select <None>. In "Show the data by" list, select Latitude & 
Longitude. Click Next. 

8. Enter the speed divisions you want to use and the color for each division. 

9. Click Finish to plot the points. 

10. In the left frame, right click on "time_T0 by Latitude & Longitude". Select "Properties". 
Open the Balloon tab and select time_T0, accidentDateTime and any other fields you 
want to view. 

11. Zoom in enough to see individual points, right click on a point, and pick "Show 
Information", to look at data for that particular point. 

12. MapPoint allows you to navigate around on the map pretty well.  Some useful keystrokes 
are ’r;+’ to zoom in and ’r;-’r; to zoom out.  Also, you can draw a box around an area and 
then click in it to zoom into it.  You can scroll the map using your mouse by just 
positioning the mouse cursor on the side of the map you want to scroll into.   

Back to File Menu | Export Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

Export: Export Data To 

Use the Export "data type" command to export the data in the database to a file. The exported 
files are in a tab-delimited text file format and can be used to exchange information within your 
company, with your clients, etc. 

To export data: 
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1. Select Export in the File Menu. 

2. Select the data type you wish to export (Drivers, Vehicles, Trips, Costs, etc.) from the 
drop-down menu. The Export "data type" To window is displayed. The Export Trips To 
window is shown here as an example. 

 

3. Create a name for the file you wish to export on the Export File Name box (for example: 
Trips.txt). 

4. Use the browse function in the Export Data Type To dialog box to select a destination 
where you wish to place the file. 

5. In some cases, you can use the Set Filter option to more specifically specify the data to 
be exported (for example: export only information related to one driver, or a group, or a period of 
time, etc.). 

6. Ivied the file before exporting by clicking Browse . This will give you the opportunity to 
view the selected records that will be exported. 

7. If the data is correct, you can click Export to create the export data file.  

 

Back to File Menu | Export Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Print 

Use the Print command to print a DriveRight report that is displayed on your screen. 

To print: 
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1. Click Print in the File menu. The print dialog box appears. 

2. Select your desired print options. 

3. Click OK to print or click Cancel to exit the dialog box without printing. 

Note: The Print command is only enabled when a report is being displayed. 

 

Back to File Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Print Preview 

To preview a print job: 

1. On the File menu, click Print Preview.  

2. Use the buttons on the toolbar to look over the page or make adjustments before printing.  

 

Back to File Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Print Setup 

To setup your print options:  

1. On the File menu, click Print Setup.  

2. Select your desired print options. 

3. Click OK to save the settings or click Cancel to exit the dialog box without saving. 

 

Back to File Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Clear Screen 

Use the Clear Screen command to clear reports from the main program window. 

 

To clear the screen: 

1. Click Clear Screen in the File menu. The main program window is cleared. 
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2. You can also use the Clear Screen icon to clear the screen: 
 

 

 

Back to File Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Exit 

Use the Exit command to close the DriveRight software. 

 

To exit the software: 

1. Click Exit in the File menu. The software quits. 

 

Back to File Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Setup Menu 

Setup Menu 

The following commands are available in the Setup Menu: 

 

Current Location 

Users 

Preferences 

Host Mode 

Communications Port - DriveRight 

Communications Port - CarChip 

SmartCard Reader 

Default DriveRight Settings 

Default CarChip Settings 

Digital Input Labels 
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Corporate Structure 

 

 

Back to Menu Commands 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Current Location 

All data is organized according to location.  All information is stored as part of the Current 
Location. Set the Current Location value properly for proper data storage. Once current location 
name is set, the corresponding location ID is stored in all the downloads. All operations like 
database browsing, reporting, etc, are performed with respect to the current location.  

To change the current location: 

1. Select Current Location command in the Setup Menu. The Set Current Location 
dialog box is displayed: 

 

2. Select the desired location from the drop-down list. 

3. Click Set to change the location or click Cancel to exit without changing the current 
location. 

Note: A new location can be added by going to Database->Company Locations, and clicking Add 
New in the Browser. 

 

Back to Setup Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Users Menu 

Users Menu 

The Users Menu commands allow you to log in and to change your password. If you are the 
Super User you can also browse the list of registered users. 

Login 
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Browse/Add Users  

Change Password 

 

Back to Setup Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Users: Login 

The Users Login command allows you to change the User without exiting the program. You must 
be a registered user to access program functions. 

 

To change the current user: 

 

1. Select Login from the Users  sub-menu in the Setup Menu. The Login dialog box is 
displayed. 

 

2. Enter your User Name and Password. 

3. Click OK to log in, or click Cancel to exit the dialog box without changing the current 
user. 

 

Back to Setup Menu | Users Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Users: Browse/Add 

102 



DriveRight FMS Help 

The Users Browse/Add command opens the Users browse window showing you a list of all 
registered users, including their passwords. From this window you can add new users or edit the 
privileges of existing users. 

Note: You must be logged in as the Super User to access this command. 

To open the Users browse window: 

1. Select Browse/Add from the Users command in the Setup Menu. The Users browse 
window is displayed. 

2. Click on Add New to add a new user. 

3. To change a user's settings, click on the user in the browse window and then click on 
Edit. 

4. To delete a user, click on the user in the browse window and then click Delete. 

5. To print the browse window, click Print. 

6. Click Close to exit the window, or click on the close icon in the upper right corner of the 
window. 

 

See also: 

Add New User 

Edit User 

Back to Setup Menu | Users Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Users: Change Password 

The Users Change Password command allows you to change your DriveRight password.  

 

To change your password: 

 

1. Select Change Password from the Users command in the Setup Menu. The New 
Password dialog box is displayed. 
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2. Enter your new password, then retype your new password.  

3. If the retyped password doesn't match, you will be prompted to check the retyped 
password.  

Note: In order to change your password the new password and the retyped new password 
must match exactly. 

4. Click OK to change your password or click Cancel to exit the dialog box without changing 
your password. 

 

Back to Setup Menu | Users Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Preferences Menu 

Preferences Menu 

You can set the following program preferences in DriveRight FMS: 

Units 

Backup Options 

Download Options 

Night and Weekend Settings 

Database Browser 
  

Back to Setup Menu 

   
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Preferences: Units 
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The Units dialog box allows you to select the units used for distance and speed and also control 
the display of the time and date. 

To set units: 

1. Choose Units from the Preferences command in the Setup menu.  

The Units dialog box appears. 

 

2. Select the desired distance/speed, date, and time options. 

3. Choose OK when you are satisfied with the settings, choose Cancel to exit without 
changing the settings. 

 

Back to Setup Menu | Preferences Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Preferences: Backup Options 

Use the Backup Options command to set the number of months of records to keep in the 
database after every backup. Refer to Active Database Size Recommendations and Database 
Backup Considerations for more information. 

To set your backup options: 

1. Choose Backup Options from the Preferences command in the Setup menu.  

The Backup Options dialog box displays. 
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2. Check the Keep X months of records active in the database after every backup box 
then select the number of months from the drop down list to keep the selected number of 
months active in the database after a backup. All data recorded before the specified period 
of time will be removed from the active database.  

3. Click OK to accept backup options or click Cancel to exit the dialog box without saving 
the changes. 

See also: 

Database Backup Considerations 

Active Database Size Recommendations 

Back to Setup Menu | Preferences Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Preferences: Download Options 

Use Download Options in the Preferences Menu to set up the automatic synchronization of the 
DriveRight's clock after each download and to determine how the software will handle the Driver 
ID set in the Trip 500AL, DriveRight 600, and  600E consoles. Also, use this dialog box to 
determine how the speed samples taken from the CarChip Fleet and CarChip Fleet Pro are 
saved in the database. 

To set your download options: 

1. Choose Download Options from the Preferences sub-menu in the Setup menu.  

The Download Options dialog box displays. 
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2. Select Synchronize time and date after every download to have your DriveRight or 
CarChip device's clock automatically reset to match your computer after each download. 

Note: If you choose this option, all DriveRight consoles and CarChip devices including remote 
units downloaded through host mode will be reset to the computer’s time and date, even if the 
remote DriveRight is in a different time zone. 

3. If you are using DriveRight Trip 500AL DriveRight 600, or 600E console, set the DriverID 
as either the Location ID or the Driver ID. You may specify a Driver ID using the code on the 
DriveRight. If only one driver uses a vehicle, the code may be used as a Location ID. To specify 
an ID for each Location ID, select Database>Trip Addresses. 
 
At the beginning of each trip, specify the Trip Address ID in the DriveRight device. When 
downloading a DriveRight device, DriveRight FMS interprets each ID as the destination of a trip 

4. If you are using a CarChip Fleet or CarChip Fleet Pro, select one of the radio buttons 
pertaining to how the speed sample logs are saved in the CarChip Parameter Logs database 
table. Select Include all Speed Sample logging to store all speed sample information for every 
CarChip download. Select Include last ___ hours of Speed Sample logging to determine the 
number of hours of speed data recorded by the CarChip that the FMS software keeps. Select 
Include no Speed Sample logging to stop any of the Speed Sample information from being 
downloaded into the database.  
 
By design, CarChip accumulates speed sample records according to the frequency set in the 
CarChip Device Settings dialog box. This speed sampling can be as frequent as every second. 
Frequent speed sampling can take up large amounts of database space.  
 
To save database space, the default setting of one hour is used, saving the last hour of speed 
interval data that gets displayed in the CarChip Parameter Logs database table. Select this check 
box and enter the number of hours of  Speed Sample logging data you want to keep. This setting 
can be changed to log all speed samples, log any number of hours of samples (from one to 96 
hours), or not to save any samples from the downloaded CarChip. 
 
As long as the CarChip is not cleared after the download, all the speed sample data still exists in 
the CarChip’s memory. If this data is needed, the CarChip can be downloaded again with this 
setting changed to include more speed sample data. This data can also be seen in detail by 
downloading the CarChip information into the retail CarChip Software included on the FMS 
software disk. 
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5. Click OK to save the changes, click Cancel to exit without saving. 

 

Back to Setup Menu | Preferences Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Night and Weekend Settings 

The Night and Weekend Settings window allows you to define night driving based on the time of 
day. You can define weekend driving based on day of the week and the time of day. 

To change the Night and Weekend Settings: 

1. Select Preferences from the Setup menu. 

2. Select Night and Weekend Settings from the Preferences menu. 

3. The Night and Weekend Settings dialog box displays. 

 

3. You can change the times used to define when Night begins and end in the formula by 
entering the new time directly in the After and Before edit boxes or by selecting the hour, minute, 
second or AM / PM positions and using the up and down scroll arrows to change the setting. 

4. Change the days of the week used to define weekend driving by selecting the day of the 
week and time you want the weekend to start in the From box and the day of the week and time 
you want the weekend to end in the To box.  

5. Click OK to save the formula or click Cancel to exit the dialog box without saving the 
formula. 

Note: The days and times selected here will affect the days and times that automatic wireless 
download occurs in the Setup Automatic Wireless Download, Vehicle Activity Report, and Usage 
Report dialog boxes. 
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Back to Setup Menu | Preferences Menu 
  

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Preferences: Database Browser 

Use the Database Browser commands to change the text font and color and the background 
color used in the Browser windows. 

Text Font and Color 

Background Color 

Back to Setup Menu | Preferences Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Host Mode Menu 

Host Mode Menu 

Host Mode allows drivers to dial in remotely and download their DriveRight using a modem. 

 

Host Mode On 

Host Mode Setup 

Remote Modem Setup 

 

Back to Setup Menu 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

Host Mode On 

This is the mode that your modem should be in when someone wants to call in from outside to 
transfer data from one or more DriveRight devices. A dialog box appears indicating that the 
modem is being initialized. After the initialization has been completed successfully, the other party 
can call in. When the Host Mode is on, all other software operation are suspended. 

Tip: It’s a good idea to set a schedule for remote drivers to call into the Host computer. For 
example, setting the rules to call outside business hours, then leaving the computer in Host Mode 
as the last task of the day will give drivers flexibility to call in. Alternatively, one computer can be 

109 



DriveRight FMS User's manual 

dedicated as the Host, and data can be exported from it periodically to another computer where 
analysis and reporting are performed. 

 The user connects his modem to the DriveRight (showing the CURRENT screen) using 
the remote download Kit (item #8188, purchased separately).  

 The host mode is a well-protected function. You can only communicate as long as a 
DriveRight is connected to your PC. In all other cases, communication is lost. 

 For details on how to install a remote modem to enable it to participate in the Host Mode, 
please consult the instructions accompanying the Remote Download Kit. 

 The History Window displays status information for downloaded DriveRights.   

 Hang Up:  Generally, you will not need this button because the software will hang up 
automatically. However, if necessary you can manually hang up the phone using this 
button. 

 Reinitialize Modem: Resets the modem initialization. 

 Exit Host Mode:  Exit host mode and resume normal program operation. 

See also: 

Host Mode Menu 

Host Mode Setup 

Host Mode: Remote Modem Setup 

Back to Setup Menu | Host Mode Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Host Mode Setup 

Host Mode Setup allows you to configure your computer’s modem to accept calls. 

To be able to communicate with the DriveRight and transfer data over a modem, the 
communications port should be defined for your modem. Furthermore, set the modem of your PC 
to Auto-Answer when there is a call. Refer to your modem manual for Auto-Answer. 

 Select the COM Port that your modem is connected too.   

 The default initialization strings are "AT E1 Q0 &B1 &N0 V1" and "ATS0=3" for string 1 
and string 2.   

 Click Detect Modem to detect the serial port to which the modem is connected. 

 If you are going to download just DriveRight 500 AL and earlier models just check that 
box.  See description below for explanation as to why this is necessary. 
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Note: Because the DriveRight 500 and earlier versions of DriveRight communicate at 2400 baud 
and the DriveRight 600 communicates at 19,200 baud, you must configure your computer to 
communicate with either the DriveRight 600 or with earlier models.  

See also: 

Host Mode On 

Host Mode: Remote Modem Setup 

Back to Setup Menu | Host Mode Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Remote Modem Setup - Using Hyper Terminal 

The external modem at the site where the DriveRight is connected is called the "remote" modem. 
The DriveRight owner, when he wants to download his information, connects the DriveRight to 
this modem using the interface box and modem adapter included in the Remote Modem Kit. He 
then turns the modem on, and it will dial the host computer and the download will be initiated. 
However, before the modem will dial up the host computer and download correctly it must be set 
up correctly. The following instructions explain how to do this manually for a US Robotics Courier 
V. Everything modem and the Windows 95 accessory program Hyper Terminal. In addition, the 
setups for US Robotics 56K Fax Ext are included.   

Unfortunately, not all modems have the same command set or act the same way on power up. If 
you are using a modem other than the one described, read the instructions below and then refer 
to your specific modem documentation to determine if your modem can be used. 

Note: When you are asked to type a command, do not type the quotes.  Type all commands in 
upper case. 
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1. Take the modem out of the box and check that the DIP switches are set in the following 
way: 

Switch Number:  1  2  3  4  5  6  7  8  9 10 

Switch Setting:   0  0  0  1  1  0  0  1  0  0 

Note: 0 is short for OFF and 1 is short for ON.  These DIP switches only apply to the US Robotics 
Courier V. Everything modem. 

2. Using the Remote Modem Kit, connect the remote modem to a known serial port, and 
then turn the modem on. Make sure you use the gray phone cable included in the kit to go from 
your serial port to the modem. The black phone cable included in the DriveRight Software kit will 
not work for a modem. 

3. Run the Hyper Terminal  program. You can find the program in the Start menu under 
Programs/Accessories/Hyper Terminal. Click on one of the phones in the program group to start 
the program. 

4. Select "Properties" from he File menu and make sure you have the correct serial port 
selected. If you are not sure, you will have to use trial and error. In most cases "Direct to COM1" 
or "Direct to COM2" should work.  The File/Save As command can be used to save these settings 
under a name of your choice. You then can click on the phone with this name to start Hyper 
Terminal next time. 

5. Type the letters "AT" and press enter. If you get an OK back, you are communicating with 
the modem.  If you do not, type the following commands. 

"ATE1V1Q" and press Enter 

You should now be able to type "AT" and press enter and receive an OK back.  You 
should also be able to see the "A" and the "T" when you type them. 

If the above test fails, check your connections and then try another COM port by 
changing your selection in the Properties option in the File menu. 

6. Enter the following commands to program the modem.  You should receive an "OK" after 
each one of the commands below unless stated otherwise. 

"ATS13=16" and press Enter 

Now, you will program the phone number to be dialed.  In the example below, the host 
computer is connected to 780-6455. 

"AT&Z0=780-6455" and press Enter 

Now the modem will dial this number when it is turned on. 

"AT&W" and press Enter 

This setup is now saved in non-volatile memory which is loaded when the modem is 
turned on. 

"AT&M4" and press Enter 

This tells the modem to use a standard error detection protocol which should be used 
to insure the data transfer is done error free. 

"ATE0Q1" and press Enter 
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You will not receive an "OK" after this command.  "Q1" tells the modem to operate in 
"quiet" mode. This is necessary so the DriveRight does not interpret any responses 
from the modem as commands. Note also, command will no longer be echoed. If you 
type AT Enter, you will see nothing; however, this is what we want and why we waited 
to do this on the last step. 

7. Exit Hyper Terminal: You are now ready to test your programming. If you have two 
separate phone lines and the DriveRight software you can completely test your setup. Plug in a 
working phone line to the remote modem and the "correct" phone line into your computers 
internal or external modem. The "correct" line is the one belonging to the number you 
programmed in step 5. Run the DriveRight software and put it in "host" mode by selecting "Host 
Mode On"  in the Setup/Host Mode menu. Connect the DriveRight to be downloaded to the 
external modem through the interface box and the black cable, not the gray cable you used to 
program the modem. Turn the modem off and then back on again. The modem should dial the 
host, the computer should answer the call and download the data. The DriveRight owner knows 
the download is completed when the CD light goes off. Under any circumstances, the download 
should be completed in no more than 5 minutes. 

Below are the modem configurations for the US Robotics modems used during testing. 

FIELD MODEM: 

For DriveRight 500 make sure &N3 (if DriveRight 600 not selected in Host Mode Setup 
&N0 will also work.) 

For DriveRight 600 make sure &N0 or &N10. 

USRobotics Courier V.Everything Settings... 

   B0  C1  E0  F1  M1  Q1  V1  X1 

   BAUD=19200  PARITY=N  WORDLEN=8 

   DIAL=TONE   ON HOOK   TIMER 

   &A1  &B0  &C1  &D2  &G0  &H0  &I0  &K1  &L0  &M4  &N3 

   &P0  &R1  &S0  &T5  &U0  &X0  &Y1  %N6  #CID=0 

   S00=000  S01=000  S02=043  S03=013  S04=010  S05=008  S06=002  S07=060 

   S08=002  S09=006  S10=014  S11=070  S12=050  S13=016  S14=001  S15=000 

   S16=000  S17=000  S18=000  S19=000  S20=000  S21=010  S22=017  S23=019 

   S24=150  S25=005  S26=001  S27=000  S28=008  S29=020  S30=000  S31=000 

   S32=009  S33=000  S34=000  S35=000  S36=000  S37=000  S38=000  S39=000 

   S40=000  S41=000  S42=126  S43=200  S44=015  S45=000  S46=000  S47=000 

   S48=000  S49=000  S50=000  S51=000  S52=000  S53=000  S54=064  S55=000 

   S56=000  S57=000  S58=000  S59=000  S60=000  S61=000  S62=000  S63=000 

   S64=000  S65=000  S66=000  S67=000  S68=000  S69=000  S70=000 

   LAST DIALED #: T293-3529 

Switch 4,5, and 8 ON all others off. 
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FIELD MODEM: 

For DriveRight 500 make sure &N3. 

For DriveRight 600 make sure &N0 or &N10. 

U.S. Robotics 56K FAX EXT Settings... 

   B0  E0  F1  M1  Q1  V1  X1  Y0 

   BAUD=19200  PARITY=N  WORDLEN=8 

   DIAL=TONE    ON HOOK   CID=0 

   &A1  &B0  &C1  &D2  &G0  &H0  &I0  &K1 

   &M4  &N10  &P0  &R1  &S0  &T5  &U0  &Y1 

   S00=004  S01=000  S02=043  S03=013  S04=010  S05=008  S06=004 

   S07=060  S08=002  S09=006  S10=014  S11=070  S12=050  S13=016 

   S15=000  S16=000  S18=000  S19=000  S21=010  S22=017  S23=019 

   S25=005  S27=000  S28=008  S29=020  S30=000  S31=128  S32=002 

   S33=000  S34=000  S35=000  S36=014  S38=000  S39=000  S40=001 

   S41=000  S42=000 

   LAST DIALED #: T2933529 

SWITCH 4,8 ON all others OFF. 

HOST MODEM: 

U.S. Robotics 56K FAX EXT Settings... 

   B0  E1  F1  M1  Q0  V1  X1  Y0 

   BAUD=19200  PARITY=N  WORDLEN=8 

   DIAL=TONE    ON HOOK   CID=0 

   &A1  &B1  &C1  &D2  &G0  &H0  &I0  &K1 

   &M4  &N0  &P0  &R1  &S0  &T5  &U0  &Y1 

   S00=004  S01=000  S02=043  S03=013  S04=010  S05=008  S06=004 

   S07=060  S08=002  S09=006  S10=014  S11=070  S12=050  S13=000 

   S15=000  S16=000  S18=000  S19=000  S21=010  S22=017  S23=019 

   S25=005  S27=000  S28=008  S29=020  S30=000  S31=128  S32=002 

   S33=000  S34=000  S35=000  S36=014  S38=000  S39=000  S40=001 

   S41=000  S42=000 

   LAST DIALED #: 

SWITCH 3,8 ON all others OFF. 
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DriveRight Software Host Mode Setup 

Inititialization String 1: AT E1 Q0 &B1 &N0 V1 

Inititialization String 2: ATS0=3 

See also: 

Host Mode On 

Host Mode Setup 

Back to Setup Menu | Host Mode Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Communications Port - CarChip Settings 

Use the Communications Port - CarChip Settings command to select the communications port 
used to connect a CarChip device to your computer. 

 

To select a Communications port: 

 

1. Choose the Communications Port - CarChip from the Setup Menu. The 
Communications Port Settings dialog box is displayed: 

 

2. Select USB if using a USB connection or the correct COM port for the serial port 
connection from the list provided. DriveRight FMS supports USB and COM1 through COM8. 

3. If you are not sure which communications port you are using, connect your CarChip to 
your computer, click the Auto Detect button. If the CarChip is found by the software, the following 
message is displayed and the correct communications port is selected in the dialog box. 
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4.  Click OK to save the communications port selection or click Cancel to exit the dialog box 
without changing the communications port information. 

Note: If you are working on a network, ask the network administrator to assist you in selecting the 
correct communications port.  

 

Back to Setup Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Communications Port - DriveRight Settings 

Use the Communications Port - DriveRight Settings command to select the communications port 
used to connect a DriveRight device to your computer. 

 

To select a communications port: 

1. Select the Communications Port - DriveRight command in the Setup Menu. The 
Communications Port Settings dialog box is displayed: 

 

2. Select the communications port from the list provided. DriveRight FMS supports COM1 
through COM8. 

3. If you are not sure which communication port you are using, connect your DriveRight to 
your computer: 

o Press the Mode button on the DriveRight if necessary to make sure the device is 
on. 
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o Click Auto Detect  

o If the DriveRight is found by the software, the following message is displayed and 
the correct communications port is selected in the dialog box. 

 

4. Click OK to save the serial port selection or click Cancel to exit the dialog box without 
changing the port. 

Note: If you are working on a network, ask the network administrator to assist you in selecting the 
correct communications port.  

 

Back to Setup Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

SmartCard Reader 

The SmartCard Reader dialog box lets you test the SmartCard Desktop Reader used to read, 
download and setup the SmartCards used as part of the DriveRight system for transferring data 
from the DriveRight back your computer. 

Note: In order to setup up and test your SmartCard reader, you must install the necessary drivers 
included with the DriveRight FMS software first. See the FMS Getting Started Guide for more 
information. 

To test your SmartCard Desktop Reader device: 

1. Connect your SmartCard Desktop Reader to your computer and insert a SmartCard into 
the SmartCard Desktop Reader.  

2. Select SmartCard Reader from the Setup menu. The SmartCard Reader Setup dialog 
box is displayed. 
 

 
 
If the SmartCard Driver is installed properly, "ACS ACR38USB" displays in the Card 
Reader text box. 
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3. Click Test Reader to verify that the SmartCard Reader is successfully reading and 
transmitting the data back to your computer. If the test is successful, the following dialog 
box is displayed. 
 

 
  

4. Click OK and click OK  again in the SmartCard Reader Setup dialog box to accept the 
reader settings. 

 

Back to Setup Menu  

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Default DriveRight Settings Menu 

Default DriveRight Settings Menu 

Use the Default DriveRight Settings Wizard to create default device settings which are used by all 
new DriveRights added to the system. Use the View/Set command to review or edit the default 
settings. 

 

View/Set 

Setup Wizard 

 

 

Back to Setup Menu 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

Default DriveRight Settings Wizard 

The values entered in this setup are used as default settings when you add new DriveRight 
devices to the database. If you click this menu option , a dialog box pops up that contains a brief 
description about the Default DriveRight Settings Wizard.  
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To edit the Default DriveRight Settings:  

1. Select Default DriveRight Settings in the Setup Menu.  

2. Select Setup Wizard from the list of commands. The Default DriveRight Wizard dialog 
box is displayed. 

 

3. If you select OK, the Default DriveRight Settings Wizard takes you through the dialog 
boxes listed below: 

 Unit Settings: Select the date, time and unit modes and click OK. 

 Safety Settings: Enter the speed, acceleration and deceleration limits and click 
OK. 

 Timer Settings:Enter the trip stop time and driver log out time and click OK. 

 Alarm Settings: Select the alarm mode. Warn if not logged in is an option. 

 Security Settings: Enter the security code (PIN code). Tamper indicator is an 
option. Disable Console Login is also an option. 

 GPS Settings: Create default GPS settings that can be used by all the vehicles in 
your fleet. 

4. Once you are finished with the above five dialog boxes, a tab control dialog box appears 
with all the above six dialog boxes. You can navigate through them, change any of the settings, 
and save the settings by clicking OK. 
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Back to Setup Menu | Default DriveRight Settings Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Default DriveRight Settings View/Set 

Default DriveRight Settings View/Set 

Use the Default DriveRight Settings View/Set command to view or edit the DriveRight FMS 
default DriveRight console settings..  

 

To view or edit the Default DriveRight Settings:  

1. Select Default DriveRight Settings in the Setup Menu.  

2. Select View/Set from the list of commands. The Default DriveRight Settings dialog box 
is displayed. 
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3. Select a tab to view or edit the following default settings: 

 Unit Settings: Select the date, time and unit modes and click OK. 

 Safety Settings: Enter the speed, acceleration and deceleration limits and click 
OK. 

 Timer Settings:Enter the trip stop time and driver log out time and click OK. 

 Alarm Settings: Select the alarm mode. Warn if not logged in is an option. 

 Security Settings: Enter the security code (PIN code). Tamper indicator is an 
option.  

 GPS Settings: Turn the GPS logging and subsequent mapping feature on and off 
and select mapping features. Works only with DriveRight 600 units with GPS 
modules. 

4. When your are finished, click OK to save any changes or click Cancel to exit without 
saving changes. 

 

 

Back to Setup Menu | Default DriveRight Settings Menu 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

Unit Settings 
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Use this command to create default unit settings that can be used by all the vehicles in your fleet. 

 

To set default unit settings: 

1. Select View/Set from the Default DriveRight Settings submenu from the Setup menu. 
The Unit Settings tab in the Default DriveRight Settings dialog box is displayed. 

 

3. Edit the unit settings for your fleet.  

o Date Mode settings control the way month, day, and year are displayed. 

o Time Mode settings control the time of day display. 

o Distance Unit settings allows you to select miles and miles per hour or kilometers 
and kilometers per hour as your speed and distance units. 

4. Click OK to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 

See also: 

Safety Settings 

Timer Settings 

Alarm Settings 

Security Settings 

GPS Settings 
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Back to Setup Menu | Default DriveRight Settings | Default DriveRight Settings - View/Set 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Safety Settings 

Use this command to create default DriveRight safety settings. 

To set default safety settings: 

1. Select View/Set from the Default DriveRight Settings submenu from the Setup menu 
The Default DriveRight Settings dialog box is displayed. 

2. Select the Safety Settings tab near the top of the dialog box. The safety options are 
displayed. 

 

4. Set the Speed Limit, which is the maximum allowable vehicle speed. 

5. Set the Accel Limit, which is the maximum allowable rate of acceleration. 

6. Set the Decel Limit, which is the maximum allowable rate of deceleration. 

7. Click OK to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 

See also: 

Unit Settings 

Timer Settings 
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Alarm Settings 

Security Settings 

GPS Settings 

Back to Setup Menu | Default DriveRight Settings | Default DriveRight Settings - View/Set 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Timer Settings 

Use this command to create default timer settings that can be used by all the vehicles in your 
fleet. 

 

To set Fleet default timer settings: 

1. Select View/Set from the Default DriveRight Settings submenu from the Setup menu. 
The Default DriveRight Settings dialog box is displayed. 

2. Select the Timer Settings tab near the top of the dialog box. The timer options are 
displayed. 

 

3. Set the trip stop time in minutes. The trip stop time is the number of minutes that elapse 
after a vehicle stops before the DriveRight stops recording trip data. 

4. Set the Driver ID Logout Time in minutes. Use a logout time of "0" to never log out the 
driver. The Driver ID Logout Time is the number of minutes that elapse after a vehicle stops 
before the driver is logged out of the DriveRight. 
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5. Click OK to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 

See also: 

Unit Settings 

Safety Settings 

Alarm Settings 

Security Settings 

GPS Settings 

Back to Setup Menu | Default DriveRight Settings | Default DriveRight Settings - View/Set 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Alarm Settings 

Use this command to create default alarm settings that can be used by all the vehicles in your 
fleet. The alarm settings control the audible alarms used to indicate when the safety settings 
thresholds are exceeded. 

To set default alarm settings for all DriveRight devices: 

1. Select View/Set from the Default DriveRight Settings submenu in the Setup Menu. The 
Default DriveRight Settings dialog box is displayed. 

2. Select the Alarm Settings tab near the top of the dialog box. The Alarm settings options 
are displayed. 
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4. Set the Alarm Mode to On or Off. This controls audible alarm reporting by the DriveRight 
device. 

5. Enable "Warn if not Logged in" to have the DriveRight device give an audible alarm if the 
vehicle is operated without the driver first entering his or her driver code. 

6. Click OK to save the Alarm Settings, click Cancel to exit without saving the settings, or 
click on another tab to make additional changes to the DriveRight default settings. 

See also: 

Unit Settings 

Safety Settings 

Timer Settings 

Security Settings 

GPS Settings 

Back to Setup Menu | Default DriveRight Settings | Default DriveRight Settings - View/Set 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Security Settings 

Use this command to create default DriveRight security settings. 
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To set default security settings: 

1. Select View/Set from the Default DriveRight Settings submenu from the Setup menu 
The Default DriveRight Settings dialog box is displayed. 

2. Select the Security Settings tab near the top of the dialog box. The security options are 
displayed. 
 

 

3. Set the Pin Code, which is required to set the calibration and alarm settings on the 
DriveRight device. 

4. If desired, you can enable the tamper indicator. If enabled, the tamper indicator on the 
DriveRight LCD screen will be displayed when a tamper event has been detected.  

5. If desired, you can disable Login from the console so that a driver can log into the device 
using only the SmartCard. Check the Disable Login on Console box to disable console 
Login. This application is available for DriveRight 600E devices only. 

6. Click OK to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight  settings. 

See Also: 

Unit Settings 

Security Settings 

Timer Settings 

Alarm Settings 

GPS Settings 

Back to Setup Menu | Default DriveRight Settings | Default DriveRight Settings - View/Set 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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GPS Settings - Default DriveRight Settings 

Use this command to create default GPS settings that can be used by all the vehicles in your 
fleet. 

Note: Even if this feature is toggled on an off, it will only work with corresponding DriveRight 600 
units with GPS modules. 

To set default GPS Logging settings: 

1. Select View/Set from the Default DriveRight Settings submenu from the Setup menu 
The Default DriveRight Settings dialog box is displayed. 

2. Select the GPS Settings tab near the top of the dialog box. The GPS options are 
displayed. 

 

3. Select On to turn the GPS logging feature on for all the units with a GPS module. Select 
Off to turn off the GPS feature for all DriveRight Devices. Select DriveRight Speed Only to log 
and track only the DriveRight Speed. This feature logs and tracks only the DriveRight speed for 
DriveRight 600 devices that are not assembled with a GPS module. 

4. If On or the DriveRight Speed only button has been selected, select the Logging interval 
time and corresponding time unit in the Log Data Every text field. The amount of logging hours 
this used for this feature are displayed in Logging Hours. 

5. Click OK to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 

See Also: 

Unit Settings 

Safety Settings 
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Timer Settings 

Alarm Settings 

Security Settings 

Back to Setup Menu | Default DriveRight Settings | Default DriveRight Settings - View/Set 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Default CarChip Settings 

Use the Default CarChip Settings command to view or edit the DriveRight FMS defaults for the 
CarChip device settings.  

To view or edit the Default CarChip Settings:  

1. Select Default CarChip Settings in the Setup Menu. The Default CarChip Settings 
dialog box is displayed. 

 

2. Edit the default settings for Hard Braking, Acceleration, and Speed Bands. 

 The CarChip settings for Hard Braking Threshold, Hard Acceleration Threshold, 
and Speed Band 3 are equivalent to the DriveRight settings for Decel Limit, Accel 
Limit, and Speed Limit. 
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 Set the Hard Braking Threshold to equal the Decel Limit used by DriveRight 
Devices. 

 Set the Hard Acceleration Threshold to equal the Accel Limit used by DriveRight 
Devices. 

 Set Speed Band 3 to equal the Speed Limit used by DriveRight Devices. 

3. Set the Logging Interval for the Vehicle Speed Parameter and select up to four other 
engine parameters. Supported time intervals range from 1 seconds to 60 seconds. 

4. Set the default Alarm Status for all CarChips. If the CarChip is CarChip Fleet Pro, you 
have the choice between three volume settings and disabling the Alarm feature. If the CarChip is 
a CarChip Fleet, you have the choice between Medium and Disabled. 

5. Set the default LED Status for all CarChips. If Enabled, the green LED on the CarChip 
flashes when plugged into a vehicle and flashes continually when the vehicle is running. If 
Disabled, the green LED does not flash while in the vehicle. 

6. Determine if the GPS feature is enabled for all CarChips and set the interval at which the 
GPS data is logged. The GPS Logging feature is available for the CarChip Fleet Pro models (# 
8246).Select On to turn the GPS logging feature for all CarChips. Select Off to turn off the GPS 
feature for all CarChips. A CarChip GPS/Wireless Interface Module (# 8251) and GPS Module (# 
8128) must be installed in a vehicle with each CarChip to log CarChip GPS data. 
 
The Estimated Logging Time box lists the approximate number of hours CarChip data can be 
logged without the CarChip rewriting over the oldest data stored. The number of hours the 
Carchip can log depends on the parameters logged, their selected logging intervals, if GPS 
logging has been enabled and the logging interval for the GPS feature. 

7. When your are finished, click Set Defaults to save any changes, click Defaults to clear 
all changes and display the original defaults, or click Cancel to exit without saving changes. 

 

Back to Setup Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Digital Input labels 

You can identify the two digital inputs signals available on a DriveRight 600 using this  dialog box. 
Digital inputs are any variable from the vehicle that produces a high and a low voltage input. The 
DriveRight device records these high and low voltage differences for the inputs that you select. 
These digital inputs get incorporated into various database displays and reports throughout the 
software, such as the Accident Log Report, the Trip Database  and the GPS database. 

 

To change the digital input labels: 

 

1. Click Digital Input Labels in the Setup menu. The Digital Input Labels dialog box is 
displayed. 
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2. Edit the labels used for digital input 1 and digital input 2. The following is a list of possible 
labels used as digital inputs: 

 Seat belts 

 Headlights 

 Braking 

 Lights 

 Windshield wipers 

Note: Depending on the selected digital input, extra setup between the DriveRight and the vehicle 
may need to happen to monitor these digital inputs correctly. For Example: To make "Seat belts" 
a digital input, locate a wire bundle underneath the driver's set, pick a wire from the bundle and 
test it's voltage during buckling and buckling. Do this until you find the wire that goes from 0 to 12 
volts when buckling and buckling and connect it to the green wire of the adapter cable supplied 
with the DriveRight. Connecting other aspects of your vehicle to be monitored by the DriveRight 
system varies. 

3. Click OK to save the changes or click Cancel to exit without saving the changes. 

 

Back to Setup Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Corporate Structure 

The Corporate Structure dialog box allows you to set up reporting structure for all the locations 
listed in a database. The resulting location structure can be used as a tool for displaying the 
Driver Safety Score Report, breaking up driver and fleet information based on locations and the 
reporting structure. 

To create and edit the corporate reporting structure: 

1. Select Corporate Structure from the Setup menu. The Corporate Structure dialog box 
is displayed. 
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2. Use the location combo boxes to create or edit the corporate location structure. Select a 
location from the Available Locations in Database box and click the >> button to move 
the Location to into the Corporate Structure box.  
 
If a selected location is a root location, meaning it is as the top of the corporate structure, 
Select the Root Location check box.  
 
To assign a location under a location, highlight the location with a higher hierarchical title 
in the Corporate Structure box, select a location from the Available Locations In 
Database box and click the >> button. The selected location displays underneath the 
highlighted location. 
 
To remove a location, or hierarchy of locations, select a location and click the << button. 
This removes the location from the corporate structure. 
 
If there are gaps or unknown reporting structures in certain structure hierarchies, the 
NULL location may be used. For example, if a location reports indirectly, or through 
unknown paths to higher hierarchical location, the NULL location can be used to signify 
the unknown path or location. 
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3. Complete your corporate structure and click OK to save the corporate information, or 
Cancel to exit without saving the information. 

 

Back to Setup Menu  

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight Menu 

DriveRight Menu 

Use DriveRight Menu commands for functions that require direct communications with the 
DriveRight console.  

Note: The DriveRight must be connected to your computer with the LCD display on and in the 
CURRENT mode in order to access the DriveRight Menu commands. 

The following DriveRight Menu commands are available: 

 

Add New DriveRight 

DriveRight Settings 

Download DriveRight 

Download Palm 

Read Accident Log 

Read Tamper Log 

Set Time and Date 

Set Odometer 

Set Service Alarms 

Set Drivers List 

Clear DriveRight 
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Back to Menu Commands 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

Add DriveRight Wizard 

DriveRight FMS includes an Add DriveRight Wizard to simplify adding DriveRight devices, 
Vehicles, and Drivers to the database.  

To add a new DriveRight device: 

1. Select Add New DriveRight from the DriveRight Menu. The Add DriveRight Wizard - 
Start dialog box is displayed. 

Note: The new DriveRight device must be connected to your computer and be turned on before 
you can add it to the DriveRight FMS database.  

 

2. Click Next to continue or click Cancel to exit the Add DriveRight Wizard. 

o If you click Next, the Add DriveRight Wizard - DriveRight ID dialog box is 
displayed. 
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3. Click Next to continue or click Cancel to exit the Add DriveRight Wizard. 

o If you click Next, the Add DriveRight - Assign to Vehicle dialog box is displayed. 

 

4. Click OK to continue, or click Cancel to exit the Add DriveRight Wizard. 

5. If you click OK, the Add DriveRight Settings dialog box is displayed. The Add 
DriveRight Settings Dialog allows you to review all of the settings for the new DriveRight, 
including those settings that are set by the DriveRight defaults.  
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6. When you are satisfied it is set up correctly, select Set to save the settings. Select 
Cancel to exit the setup dialog and abandon the DriveRight settings. 

Note: If you cancel the setup, you will lose the DriveRight settings but any vehicles or drivers you 
added to the database will remain. 

 

Back to DriveRight Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Download DriveRight 

The Download DriveRight command transfers trip data from the connected DriveRight device to 
the DriveRight database.  

To download your DriveRight: 

1. Connect your DriveRight console to your computer and make sure the DriveRight is 
"awake". Press the MODE key if there is nothing on the LCD display. 

2. Select Download DriveRight in the DriveRight Menu. The following Download Status 
box is displayed: 

Note: You will see the Cancel button only if you are downloading a DriveRight 600. 
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3. You may lose GPS data for earlier trips if the DriveRight console is not downloaded for 
an extended period of time. In this case you will see a warning message similar to this: 

 

4. If the calibration in the DriveRight console does not match the calibration in the database, 
you will see a warning message similar to this: 

 

5. When the data has finished downloading the following dialog box is displayed: 
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6. Press Enter or click OK to continue. 

See also: 

Downloading DriveRight Guidelines 

Back to DriveRight Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight Settings 

DriveRight Settings 

The following commands allow you to view and or change the settings on a DriveRight device: 

View/Set 

Restore 

Setup GPS 

Verify DriveRight Calibration 

 

Back to DriveRight Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight Settings: View/Set 

Use this command to view and/or modify the DriveRight device settings for the connected 
DriveRight device: 

 

1. Select DriveRight Settings from the DriveRight Menu. 

2. Select View/Set from the DriveRight Settings drop down list. The DriveRight Device 
Settings dialog box is displayed. 
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3. Make any desired changes. For more information on the DriveRight settings, click on the 
links below: 

Identification 

Calibration 

Units 

Safety Settings 

Timer Settings 

Alarm Settings 

Security Settings 

Note: If you assign a vehicle to a DriveRight that had been previously assigned to a CarChip 
device, the vehicle assignment for that CarChip will be changed to "UNASSIGNED VEHICLE". 

4. Click Set to save the changes or click Close to exit without saving. 

 

Back to DriveRight Menu | DriveRight Settings 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight Settings: Restore 
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Use this command to update the DriveRight device using settings stored in the database: 

 

1. Select DriveRight Settings from the DriveRight Menu. 

2. Select Restore from the DriveRight Settings drop down list. The Restore DriveRight 
Settings dialog box is displayed. 

Note: If the DriveRight has already been configured the software will automatically display the 
existing settings.  

 

3. Select the desired DriveRight ID and driver name from the drop down lists.  

Note: The software will only display DriveRight ID's for DriveRight's of the same type. If a 
DriveRight 600 is connected to your computer, you will only see ID numbers for other DriveRight 
600 devices. 

4. Click Restore to save the selected settings to the DriveRight unit, or click Cancel to exit 
without changing the settings. 

 

Back to DriveRight Menu | DriveRight Settings 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight Settings: Setup GPS 

Use this command to view and/or modify the GPS settings on a DriveRight device. 

Note: This command only works with the DriveRight 600. 

To setup GPS logging: 

1. Select DriveRight Settings from the DriveRight Menu. 

2. Select Setup GPS from the DriveRight Settings drop down list. The Setup GPS 
Logging Interval dialog box is displayed. 
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3. Set GPS Logging to On, Off, or DriveRight Speed Only. 

o Select On to enable GPS logging. 

o Select Off to disable GPS logging. 

o Select DriveRight Speed Only to log the DriveRight speed without the GPS 
coordinates. No GPS unit is required to enable this option. 

4. Enter the desired logging interval and indicate a time unit of either seconds (Sec) or 
minutes (Min). Logging Hours indicates how much data can be stored at the selected interval. 

5. Click Set to save the changes or click Cancel to exit without changing the settings 

 

Back to DriveRight Menu | DriveRight Settings 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight Settings: Verify DriveRight Calibration 

The Calibrate DriveRight dialog box allows you to verify DriveRight calibration settings. 

 The Calibration Setting dialog box shows two installation methods. VSS (vehicle speed 
sensor) installation and Reed Switch.  

To verify the  DriveRight console calibration: 

1. Click on DriveRight Settings from the DriveRight Menu. 

2. Select Verify DriveRight Calibration from the drop-down menu. A DriveRight 
Calibration Message dialog box is displayed. 

3. Click OK, Set or Cancel to continue, depending on the displayed message. The 
Calibrate DriveRight dialog box is displayed. 
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4. If the DriveRight is using a reed switch for the speed sensor, make sure the Installation 
Method indicates Reed Switch. 

o Reed Switch: If the DriveRight device has been previously calibrated in the 
vehicle or through the software, then DriveRight FMS automatically calculates 
the Calibration number for your vehicle. We strongly recommend that you do not 
change these values. The PPR for a reed switch is always &rdquor;1”. 

5. If the DriveRight is using the vehicle's VSS for the speed sensor, make sure the 
Installation Method indicates VSS. 

o VSS: If the DriveRight device has been previously calibrated in the vehicle or 
through the software, then DriveRight FMS automatically calculates the VSS 
PPM (Pulses Per Mile), PPR (pulses per reading) and Calibration number for 
your vehicle. Otherwise you must specify the PPM for your vehicle. Depending 
on your selection, software calculates the PPR (pulses per reading) and 
calibration values and fills the edit boxes with them. 

6. If you are using the VSS, you can adjust the pulses per mile (PPM) from the drop down 
list or enter the PPM in the edit box if necessary. We recommend that you not change these 
settings if the DriveRight has been previously calibrated.  

7. Click OK to save changes to the calibration, or click Cancel to exit without saving 
changes. 

 

Back to DriveRight Menu | DriveRight Settings 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Read Accident Log 

The Read Accident Log command will download accident log data from the connected DriveRight 
device, convert it to a text file, and display it using MS Notepad. 
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To read the accident log: 

1. Select Read Accident Log in the DriveRight Menu. The accident log is displayed. 

See also: 

Accident Log 

Back to DriveRight Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Read Tamper Log 

The Read Tamper Log command will download Tamper Log data from the connected DriveRight 
device, convert it to a text file, and display it using MS Notepad. The Tamper Log holds the times 
and dates when the driver disconnected the DriveRight or tried to change the DriveRight Settings. 

Note: There must be a Settings PIN-Code in the unit to enable the logging of disconnect times.  

To read the tamper log: 

1. Select Read Tamper Log in the DriveRight Menu. The tamper log is displayed. 

See also:  

Tamper Log 

Back to DriveRight Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Set Time and Date 

Use this command to set the time and date on a DriveRight device. 

 

To set the time and date on a DriveRight: 

1. Select Set Time and Date from the DriveRight Menu. The Set Time and Date dialog 
box is displayed. 
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2. Set the Date by either clicking the month, day or year in the edit box and entering the 
new information, or by clicking on the down arrow and selecting the date from the drop-down 
calendar. 

 

3. Set the time by clicking on the hour, minute or second in the edit box and entering the 
new time. You can also adjust the time settings up and down using the up and down arrows in the 
edit box. 

4. Click Set to change the time and date on the DriveRight unit or click Cancel to exit the 
dialog box without changing the settings. 

 

Back to DriveRight Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Set Odometer 

Use this command to set the vehicle odometer reading in a DriveRight device. 

Note: The Odometer can not be set for DriveRight 600E devices. An error displays if Set 
Odometer is selected when a DriveRight 600E device is connected to the computer. 

 

To set the odometer in a DriveRight: 

1. Select Set Odometer from the DriveRight Menu. The Set Odometer dialog box is 
displayed showing the current odometer reading. 
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2. You can now edit the vehicle's odometer reading. 

3. Click on OK to update the odometer reading on the DriveRight unit or click on Cancel to 
exit the dialog box without changing the settings. 

Note: When you set the odometer DriveRight FMS updates the current odometer value of the 
vehicle assigned to this DriveRight and also adds a new entry in the Odometer Logs Table. 

 

Back to DriveRight Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Set Service Alarms 

Note: Available for the DriveRight Trip 500 AL only. 

Each vehicle needs a service check from time to time. With the Set Service Alarms option you 
can specify the Odometer Readings on which the vehicle should go in for service. After defining a 
Service Schedule you can assign it to a vehicle and load it into the DriveRight Trip 500AL using 
the Set Service Alarms command in the DriveRight menu. As soon as any defined odometer 
readings are reached, a warning signal is activated in the vehicle indicating the driver to bring his 
vehicle in for a service check, or call his service center for an appointment. 

 

To set a service alarm: 

 

1. Select Set Service Alarms from the DriveRight Menu. The Set Service Alarms dialog 
box is displayed. 
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2. Enter the odometer reading for a service alarm. 

3. Click Add>>  to add the service alarm for that odometer reading. 

4. Click on an odometer reading to highlight it, then click Delete to remove a specific service 
alarm. 

5. Click Clear All to remove all service alarms. 

6. Click Set to Device to update the service alarm settings on the DriveRight unit or click on 
Cancel to exit the dialog box without changing the settings. 

 

Back to DriveRight Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Set Drivers List 

The DriveRight 600 or later device provides a security feature which lets the operator set up to 
100 drivers’ codes into the device to have access.  

 

To set the drivers list: 

1. Select Set Drivers List from the DriveRight Menu. The Set Drivers List dialog box is 
displayed. Drivers already assigned to this DriveRight are displayed in the right column. 
Drivers not assigned to this DriveRight are displayed in the left column. 
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2. Click on a driver's name to select the driver, the click on the right arrows >> to move the 
driver to the to set in DriveRight list. 

3. To remove a driver from the to set in DriveRight list, click on a driver's name to select 
the driver, then click on the left arrows << to move the driver off the DriveRight list. 

4. Click Set to Device to update the drivers list on the DriveRight unit or click Cancel to exit 
the dialog box without changing the drivers list. 

5. If you click Set to Device, the following dialog box displays if the action is successful. 
Click OK or press Enter to continue. 

 

 

Back to DriveRight Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Clear DriveRight 

The Clear DriveRight command clears all trip data in the connected DriveRight.  

To Clear your DriveRight: 

1. Select Clear DriveRight in the DriveRight Menu. The following DriveRight dialog box is 
displayed: 

 

2. Click Yes to clear the DriveRight device, click No to cancel the command. 

 

Back to DriveRight Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

CarChip Menu 

CarChip Menu 

Use CarChip Menu commands for functions that require direct communications with the CarChip 
device.  

Note: The CarChip device must be connected to your computer in order to access the CarChip 
Menu commands. 

The following CarChip Menu commands are available: 

Add New CarChip 

CarChip Settings 

Download CarChip 

Set Time and Date 

Set CarChip LED 

Set CarChip Alarm 

Set Anomalous Vehicle 

Reset Check Engine Light 

Display CarChip Memory 
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Clear CarChip Memory 

Show CarChip Info 

 

Back to Menu Commands Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Add New CarChip Wizard 

DriveRight FMS includes an Add New CarChip Wizard to simplify adding CarChips to the 
database. Click on the links provided for each of the Add CarChip Wizard dialog boxes to see 
more detailed information. 

To add a new CarChip: 

1. Select Add New CarChip from the CarChip Menu.  

Note: The new CarChip must be connected to your computer in order to add it to the DriveRight 
FMS database.  

2. The Add CarChip Wizard - CarChip ID dialog box displays. Assign an ID to the new 
CarChip by selecting the ID already assigned. You can also change the assigned ID by clicking 
inside the text box and editing the number, or by clicking on Browse CarChips to view CarChip 
IDs in use at the current location and choosing a number not in use. 

3. Click Next to continue. The Add CarChip Wizard - Assign dialog box is displayed.  

3. After assigning the new CarChip to either a vehicle or to a driver, click Next to continue 
or click Cancel to exit the Add CarChip Wizard.. 
 
If you are assigning the new CarChip to a vehicle, the Vehicles Database Table is displayed. 
Click on a vehicle record in the database table to highlight it, then click Select to assign the 
CarChip to the selected vehicle, or click Add New to add a vehicle to assign to the CarChip. 
 
If you are assigning the new CarChip to a driver, the Drivers Database Table is displayed. Click 
on a driver record in the database table to highlight it, then click Select to assign the CarChip to 
the selected driver, or click Add New to add a driver to assign to the new CarChip. 

Note: Each CarChip should be assigned to either a vehicle or driver. If it is assigned to a vehicle, 
the default driver of that vehicle appears on all the data downloaded. If a CarChip is assigned to a 
driver, then all data downloaded from that CarChip will be associated with that driver and the 
vehicle will be listed as UNKNOWN VEHICLE. This is useful if the driver uses several vehicles 
with the same CarChip. Based on your particular case, you should carefully choose between 
assigning a CarChip to a vehicle or a driver. 

4. After selecting a vehicle or driver from their respective database tables, the CarChip 
dialog box is displayed. Click Yes to continue or click No to return to the database table and 
make another selection. 
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5. If the settings in the CarChip you are adding are different from the default CarChip 
settings in the database, the CarChip Default Settings dialog box is displayed. Click Yes to 
configure the CarChip with the default settings or click No to use the existing CarChip Settings. 
 

 
  

7. The Set Anomalous Vehicles dialog box displays. Select either Vehicle with standard 
OBDII capabilities or one of the other choices and click OK to continue. 

8. The Add CarChip Wizard - Safety Settings dialog box is displayed. This shows the 
CarChip's speed band, braking, and acceleration thresholds. When you are satisfied with the 
safety settings, click Next to continue. 

9. The Add CarChip Wizard - Parameter/GPS Settings dialog box is displayed. This shows 
the engine and vehicle performance parameters that CarChip logs and the sample interval rates 
for each parameter. This dialog box also allows you to turn the GPS Setting on and off for a new 
CarChip. The GPS Logging feature is available if the CarChip Fleet Pro (# 8246) is connected to 
your computer. When you are satisfied with the parameter/GPS settings, click Next to continue. 

10. The Miscellaneous Settings dialog box is displayed. The Miscellaneous Settings dialog 
box allows you to set the CarChip's alarm volume (for CarChip Models # 8245, 8246 only) and 
LED Status. 
 
The Alarm Status options vary depending on the CarChip model currently connected to your 
computer. If CarChip Fleet Pro (# 8246) is connected, three different alarm volumes (High, 
Medium, Low) and the Disabled radio buttons are available. If a CarChip Fleet or CarChip Fleet 
with Alarm (# 8245) is connected, the alarm option is limited to Medium and Disabled. The Alarm 
setting only works with CarChip Fleet with Alarm (# 8245) and CarChip Fleet Pro (# 8246). 
 
The LED Status is available for all CarChip models. If Enabled, the green LED on the CarChip 
flashes when plugged into a vehicle and flashes continually when the vehicle is running. If 
Disabled, the green LED does not flash while in the vehicle. 
 
Click OK to continue. 

11. The Review Settings For New CarChip dialog box is displayed. This dialog box allows 
you to review the Identification, Safety, and Parameter/GPS  and Miscellaneous settings for the 
new CarChip one last time before you add it to the database. 
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12. When you are satisfied with the new CarChip settings, click Set to add the CarChip to the 
database and to update the CarChip device settings. Select Cancel to exit the Add CarChip 
Wizard without adding the CarChip to the database or updating the CarChip device settings. 

13. When the CarChip has been successfully added to the database and the CarChip 
settings have been updated, you will see the following Setup Result dialog box. 
 

 

14. Click OK to continue. 

 

Back to CarChip Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

CarChip Settings 

CarChip Settings 

The following commands allow you to view or change the settings on a CarChip: 

View/Set 

Restore 

 

Back to CarChip Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

CarChip Settings: View/Set 

Use the CarChip Settings: View/Set feature in the CarChip Menu to quickly view all CarChip 
settings for the currently connected CarChip, to add a CarChip to the database, or to edit CarChip 
Settings. 

1. Select CarChip Settings: View/Set from the CarChip Menu. CarChip Device Settings 
dialog box is displayed. The types of settings available for editing depend on the CarChip 
model currently connected to your computer.  If a CarChip Fleet Pro (#8246) is 
connected, more options are available in the Alarm Status section and the GPS Logging 
option is enabled. 
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If a CarChip Fleet (#8241 or 8245) is connected, the options are limited.  The GPS option 
is not available for these models. 

 

2. Edit the default settings for Hard Braking, Acceleration, and Speed Bands. 

 CarChip settings for Hard Braking Threshold, Hard Acceleration Threshold, and Speed 
Band 3 are equivalent to the DriveRight settings for Decel Limit, Accel Limit, and Speed 
Limit. 

 Set the Hard Braking Threshold to equal the Decel Limit used by DriveRight devices. 

 Set the Hard Acceleration Threshold to equal the Accel Limit used by DriveRight devices. 

 Set Speed Band 3 to equal the Speed Limit used by DriveRight devices. 

3. The Set Anomalous Vehicles dialog box displays. Select either Vehicle with standard 
OBDII capabilities or one of the other choices. 

4. Set the default Alarm Status for all CarChips.  If the CarChip is a CarChip Fleet Pro, you 
have the choice of three volume settings and disabling the alarm feature.  If the CarChip is a 
CarChip Fleet, you have the choice of Medium and Disabled. 

5. Set the default LED Status for all CarChips.  If Enabled, the green LED on the CarChip 
flashes when first plugged into a vehicle and flashes continuously when the vehicle is running.  If 
Disabled, the green LED does not flash while in the vehicle. 

6. Set the Logging Interval for the Vehicle Speed Parameter and select up to four other 
engine parameters.  Supported Time intervals range from  1 second to 60 seconds. 
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7. Determine whether the GPS feature is enabled for the CarChip and set the interval at 
which the GPS data is logged. The GPS Logging feature is available for CarChip Fleet Pro 
(#8246).  Select On to turn on the GPS logging feature for the connected CarChip.  Select Off to 
turn off the GPS feature for the connected CarChip.  A CarChip GPS/Wireless Interface Module 
(#8251) and GPS Module (#8128) must be installed in a vehicle with each CarChip to log 
CarChip GPS data. 
 
The Estimated Logging Time box lists the approximate number of hours CarChip data can be 
logged without the CarChip writing over the oldest data stored.  The number of hours the CarChip 
can log depends on the parameters selected, their selected logging intervals, whether or not GPS 
logging has been enabled and the logging interval for the GPS feature.  

8. When you are finished, click Set to save any changes.  Click Defaults to clear all 
changes and display the original defaults, or click Close to exit without saving changes. 

 

Back to CarChip Menu | CarChip Settings 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

CarChip Settings: Restore 

Use this command to update the CarChip device using settings stored in the database: 

 

1. Select CarChip Settings:Restore from the CarChip Menu. The Restore CarChip Settings 
dialog box is displayed. 

 

2. Select the desired CarChip or License Plate/ Driver Name from the drop down lists.  

3. Click Restore to save the selected settings to the CarChip, or click Cancel to exit without 
changing the settings. 

 

Back to CarChip Menu, CarChip Settings 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Download CarChip 

Use this command to download data from your CarChip data logger into your computer. 

To download CarChip data: 

1. Connect your CarChip device to your computer. 

2. Select Download CarChip from the CarChip menu or select the Download CarChip 
Icon from the tool bar. The Downloading Data dialog box appears. 

 

2. The dialog box disappears when the download is complete. 

3. Click Cancel only if you wish to abort the download before it is finished. 

See also: 

Downloading CarChip Guidelines 

Back to CarChip Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Set Time and Date 

Use this command to set the time and date on a CarChip device. 

 

To set the time and date on a CarChip: 

1. Select Set Time and Date from the CarChip Menu. The Set Time and Date dialog box 
is displayed. The dialog box shows your computer's current time and date.  
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2. Set the date by either clicking the month, day or year in the edit box and entering the new 
information, or by clicking on the down arrow and selecting the date from the drop-down calendar. 

 

3. Set the time by clicking on the hour, minute or second in the edit box and entering the 
new time. You can also adjust the time settings up and down using the up and down arrows in the 
edit box. 

4. Click Set to change the time and date on the CarChip device or click on Cancel to exit 
the dialog box without changing the settings. 

 

Back to CarChip Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Set CarChip LED 

Use the CarChip LED Status dialog box to view or change the CarChip LED status 
configuration. If enabled, the green LED on the CarChip flashes when plugged into a vehicle and 
flashes continually when the vehicle is running. If disabled, the green LED does not flash while in 
the vehicle. 

To change the CarChip Status LED: 

1. Select Set CarChip LED in the CarChip Menu. The CarChip LED dialog box is 
displayed showing the current LED state for the CarChip. 
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2. Click Enable if you wish to turn on the CarChip Status LED. 

3. Click Disable if you wish to turn off the CarChip Status LED. 

4. Click Set to configure the Status LED with the current setting or click Cancel to exit. 

 

Back to CarChip Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Set CarChip Alarm 

Select Set CarChip Alarm from the CarChip Menu to view or change the CarChip Alarm 
settings. 

To change the CarChip Alarm Settings: 

1. Select Set CarChip Alarm from the CarChip Menu. The CarChip Alarm dialog box 
alarm status for the CarChip currently connected to your computer.  
 
The Alarm feature options vary depending on the CarChip model currently connected to 
your computer. If the CarChip Fleet Pro (# 8246) is connected, three different alarm 
volumes (High, Medium, Low) and the Disabled radio buttons are available.  

 
 
If the CarChip Fleet with Alarm (# 8245) is connected, the Alarm option is limited to 
Medium and Disabled. 
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2. Click on the desired alarm volume or click Disabled to disable the alarm. 

3. Click Set to configure the alarm with the current setting or click Cancel to exit without 
saving the alarm changes. 

 

Back to CarChip Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Set Anomalous Vehicle 

The Set Anomalous Vehicle dialog box lets you configure your CarChip data logger to meet any 
unique specifications of the OBDII port of your vehicle.  This dialog box displays as part of the 
Add New CarChip Wizard. 

Caution: Most vehicles have standard OBDII capabilities.  If CarChip is set to work with an 
exception vehicle or protocol, it will not work with a vehicle that has standard OBDII 
capabilities. 

To select your vehicle: 

1. Click Set Anomalous Vehicles from the CarChip Menu.  The Anomalous Vehicles dialog 
box 
displays. 
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2. If your vehicle is not listed on the Specific Exceptions lit or you do not want to select a 
specific protocol, click the Vehicle with Standard OBDII Capabilities radio button. If 
your vehicle is listed, click the Specific Exceptions radio button and select the vehicle 
name.  Click the Specific OBDII Protocols radio button if the specific protocol your 
vehicle uses is on the list. 

3. Click OK to save the anomalous vehicle information, or click Cancel to exit the dialog box 
without saving the information.  

The Specific Vehicle Exceptions include: 

 Ford Focus ZXL2003 2.3L 

 Toyota Hybrid 

 Ford/Mercury Hybrid 

 Honda/Saturn Hybrid 

 Renault EOBD (Available in CarChip data loggers with firmware version 3.12 or later, 
Fleet Management Software 3.9.3 or later.) 

 Intermotive Capability Vehicles (Available in CarChip data loggers with firmware 
version 3.12 or later, Fleet Management Software version 3.9.3 or later.) 

 Ford F-Series Diesels (Available in CarChip data loggers with firmware version 3.18or 
later, Fleet Management Software version 3.9.3 or later.) 

The OBDII Protocols include: 

158 



DriveRight FMS Help 

 VPW (J1850-10.4) - Protocol used in some Chrysler, Buick, Chevy, Dodge, GMC, GM, 
Isuzu, Jeep, Mercury, Oldsmobile, Pontiac, and Saturn vehicles from 1996 to 2004. 

 PWM (J1850-41.6) - Protocol used in most Ford vehicles from 1996 to 2006. 

 ISO (ISO9141) - Protocol used in some Volkswagen, Porsche, Volvo, Toyota, Subaru, 
Nissan, Infinity, Mercedes Benz, Mazda, Landrover, and Kia vehicles from 1996 to 2004. 

 KWP (KWP2000, ISO14230) - Protocol used in some BMW, Audi, Porsche, Suzuki, 
Subaru, and Volkswagen vehicles 2003 and earlier. 

 CAN (Control Area Network ISO 11898) - Protocol used for most vehicles 2004 and 
later. 

The specific OBDII Protocols list is available for CarChip data loggers with firmware version 3.12, 
3.18 or later in Fleet Management Software version 3.9.3 or later.  See the CarChip web site for 
more information on updated CarChip firmware. 

If your vehicle is not listed in the Specific Vehicle Exceptions, but are seeing odd behavior, it may 
be that CarChip is trying to initialize a protocol that your vehicle does not use.  When CarChip is 
first connected to a vehicle, it cycles through the list of protocols to find the protocol the vehicle is 
using.  If a protocol is selected from the list, the next time CarChip is placed in that vehicle, the 
selected protocol will be used.  Do not select a specific protocol if you do not know your vehicle's 
protocol.  Contact Technical Support for assistance in selecting a specific protocol if you are 
uncertain. 

 

Back to CarChip Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Reset Check Engine Light 

Use the CarChip Reset Check Engine Light command to turn the CarChip Reset Check Engine 
Light feature on and off. Arming this feature resets the check engine light in the vehicle the 
CarChip is used in. Disarming this feature means that the CarChip does not reset the check 
engine light. 

To change the CarChip Reset Check Engine Light status: 

1. Select Reset Check Engine Light in the CarChip Menu. The dialog box is displayed 
showing the current state. 
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2. Click Arm if you wish to turn on the CarChip Alarm. Click Disarm if you wish to turn off 
the CarChip Alarm. 

3. Click Set to configure the alarm with the current setting or click Cancel to exit. 

 

Back to CarChip Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Display CarChip Memory 

Use this command to show memory usage by the CarChip device. 

1. Select Display CarChip Memory from the CarChip Menu. The CarChip Memory dialog 
box displays. 

 

2. Click OK or Cancel to close the dialog box.  

 The amount of memory is displayed in kilobytes as well as the percentage of the 
available memory used. 

 "Used" shows the amount of memory occupied by data. 

 "Free" shows amount of memory available for new data. 

 "Total" shows the total amount of memory in the data logger. 

 

Back to CarChip Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Clear CarChip Memory 

The Clear CarChip Memory command clears all trip data in the connected CarChip.  

To clear CarChip memory: 
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1. Select Clear CarChip Memory in the CarChip Menu. The following CarChip dialog box 
is displayed: 

 

2. Click Yes to clear the CarChip device, click No to cancel the command. 

 

Back to CarChip Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

SmartCard Menu 

SmartCard Menu 

Use SmartCard Menu commands for functions dealing directly with the SmartCard device or the 
DriveRight devices in your fleet that are part of the SmartCard System..  

Note: The SmartCard Reader must be connected and a valid SmartCard (meaning a card you 
wish to set up or an existing card you wish to download) must be connected to your computer to 
access SmartCard Menu commands. 

The following DriveRight Menu commands are available: 

SmartCard Download 

SmartCard Setup Card 

Transfer to DriveRight 

Clear Transfer Data 

SmartCard Erase 

 

 

Back to Menu Commands 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

SmartCard Download 
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The SmartCard Download command allows you to download data from a SmartCard containing 
data. To use this function: 

1. Insert the card you which to download into the Desktop Reader. 

Note: If you have not already done so, test the connection between the SmartCard Desktop 
Reader by using the SmartCard Reader command in the Setup Menu. 

2. Select Download from the SmartCard menu. The information in the card is automatically 
downloaded into the database for the assigned user and DriveRight, location, etc. 
 

 
 
During the download process, the software could display any of the following status messages or 
error messages. They include: 
  

 Data not properly downloaded from card. 

 Vehicle not assigned to the corresponding DriveRight device  

 If device settings don't match with the settings in the database. 

 If the card is pulled out in the middle of downloading. 

Note: The FMS software always prompts the user to download trip data before it will allow other 
information to be transferred onto the card. This ensures that the trip data is safely logged in the 
database. Adding items to transfer back to the DriveRight will overwrite trip data. 

Once download is complete, the dialog box closes. 

Back to SmartCard Menu | Menu Commands 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Setup Card 
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The Setup Card command in the SmartCard menu allows you to program new unused 
SmartCards with Driver and DriveRight information.  

To setup a new SmartCard: 

1. Insert a new unused card into the Desktop Reader. 

2. Select Setup Card from the SmartCard menu. The Setup Card dialog box is displayed. 
 

 
  

3. Select the Driver Card radio button if this card will be assigned to an individual driver or 
select Fleet Card if this card controls settings for all of your fleet. 

4. Select the driver name the card is assigned to, or select Unknown Driver (none) if all 
drivers in your fleet have privileges to the same card. If a starter interrupter is put in place 
with the SmartCard System, this means the user having the proper DriveRight ID 
assigned to the driver card will allow that driver to start the vehicle. 

5. Enter the Auto Logout Time for this card. This is the time span in which this card will 
automatically log itself out of a DriveRight System if the vehicle has not been started. 

6. Select up to 5 vehicles the assigned driver has access to using this card from the 
Vehicles in the Database combo box and click >>. The selected vehicles display in the 
Authorized Vehicles list. If you wish to take off a vehicle from the Authorized Vehicles 
list, select the vehicle name and click <<.  

7. Click Set to program the new SmartCard with this information or click cancel to exit 
without saving the new information to the SmartCard. 
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Back to SmartCard Menu | Menu Commands 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

SmartCard Transfer to DriveRight 

SmartCard Transfer to DriveRight 

Use the Transfer to DriveRight menu to assign a SmartCard information to transfer to a 
DriveRight device, such as driver identification, clock adjustment information, and driver lists. The 
commands available in the Transfer to DriveRight menu are: 

Settings 

Driver List 

Clock Adjustment 
  

Back to SmartCard Menu 

   
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

Transfer to DriveRight Settings 

Transfer to DriveRight Settings 

Use the Transfer to DriveRight Settings command to edit and transfer settings to a selected 
DriveRight Device via the SmartCard system. 

To view or edit the DriveRight Settings that can be transferred to the DriveRight via the 
SmartCard:  

1. Select Transfer to DriveRight in the SmartCard Menu.  

2. Select Settings  from the list of commands. The Review Settings for SmartCard dialog 
box is displayed. 
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3. Select a tab to view or edit the following default settings: 

 Identification Settings: Select the DriveRight ID and Driver associated with the 
card. 

 Calibration Settings: Select calibration settings that the DriveRight device should 
use. 

 Unit Settings: Select the date, time and unit modes and click OK. 

 Safety Settings: Enter the speed, acceleration and deceleration limits and click 
OK. 

 Timer Settings:Enter the trip stop time and driver log out time and click OK. 

 Alarm Settings: Select the alarm mode. Warn if not logged in is an option. 

 Security Settings: Enter the security code (PIN code). Tamper indicator is an 
option.  

 GPS Settings: Turn the GPS logging and subsequent mapping feature on and off 
and select mapping features. Works only with DriveRight 600 and 600E units with 
GPS modules. 

4. When your are finished, click OK to save any changes or click Cancel to exit without 
saving changes. 

 

Back to Transfer to DriveRight | SmartCard Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Identification Settings - SmartCard 
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Use this command to identify the DriveRight device receiving the new settings from the 
SmartCard. The Identifcation settings control which DriveRight device gets the modifications 
assigned in the Review Settings for SmartCard dialog box. 

To select the identification settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  

2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 
SmartCard dialog box is displayed. The Identification Tab is the default tab that is 
displayed upon opening the dialog box. 

 

3. Select the DriveRight device, ID, vehicle ID and default driver the device will be 
programmed to recieve. 

4. Click Set to save the Identification Settings, click Cancel to exit without saving the 
settings, or click on another tab to make additional changes to the DriveRight default settings. 

See also: 

Calibration Settings 

Unit Settings 

Safety Settings 

Timer Settings 

Alarm Settings 

Security Settings 

GPS Settings 

Back to Transfer to DriveRight | SmartCard Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Calibration Settings - SmartCard 

Use this command to modify and edit the calibration settings for a specified DriveRight device. 
The calibration settings control how the DriveRight device is calibrated and monitoring the 
selected vehicle. 

To select the calibration settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  

2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 
SmartCard dialog box is displayed. 

3. Select the Calibration Settings tab near the top of the dialog box. The calibration settings 
options are displayed. 

 

4. Describe the installation method or the type of connections/hookups used to connect the 
device to the vehicle in the Installation Method group box. 

5. Click Set to save the calibration settings, click Cancel to exit without saving the settings, 
or click on another tab to make additional changes to the DriveRight default settings. 

See also: 

Identification Settings 

Unit Settings 

Safety Settings 

Timer Settings 

Alarm Settings 

Security Settings 

GPS Settings 
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Back to Transfer to DriveRight | SmartCard Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Unit Settings - SmartCard 

Use this command to create default unit settings that can be used by all the vehicles in your fleet. 

 

To set default unit settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  

2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 
SmartCard dialog box is displayed.  

3. Select the Unit Settings tab near the top of the dialog box. 
 

 
  

4. Edit the unit settings for your fleet.  

o Date Mode settings control the way month, day, and year are displayed. 

o Time Mode settings control the time of day display. 

o Distance Unit settings allows you to select miles and miles per hour or kilometers 
and kilometers per hour as your speed and distance units. 

5. Click Set to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 

See also: 

Identification Settings 
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Calibration Settings 

Safety Settings 

Timer Settings 

Alarm Settings 

Security Settings 

GPS Settings 

Back to Transfer to DriveRight | SmartCard Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Timer Settings - SmartCard 

Use this command to create timer settings used by the DriveRight devices controlled by the 
current SmartCard. 

 

To set timer settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  

2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 
SmartCard dialog box is displayed.  

3. Select the Timer Settings tab near the top of the dialog box. 
 

 

4. Set the trip stop time in minutes. The trip stop time is the number of minutes that elapse 
after a vehicle stops before the DriveRight stops recording trip data. 
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5. Set the Driver ID Logout Time in minutes. Use a logout time of "0" to never log out the 
driver. The Driver ID Logout Time is the number of minutes that elapse after a vehicle 
stops before the driver is logged out of the DriveRight. 

6. Click Set to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 

See Also: 

Identification Settings 

Calibration Settings 

Unit Settings 

Safety Settings 

Alarm Settings 

Security Settings 

GPS Settings 

Back to Transfer to DriveRight | SmartCard Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Safety Settings - SmartCard 

Use this command to create safety settings for the specified DriveRight. 

To set safety settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  

2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 
SmartCard dialog box is displayed.  

3. Select the Safety Tab near the top of the dialog box. 
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4. Set the Speed Limit, which is the maximum allowable vehicle speed. 

5. Set the Accel Limit, which is the maximum allowable rate of acceleration. 

6. Set the Decel Limit, which is the maximum allowable rate of deceleration. 

7. Click Set to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the settings. 

See Also: 

Identification Settings 

Calibration Settings 

Unit Settings 

Timer Settings 

Alarm Settings 

Security Settings 

GPS Settings 

Back to Transfer to DriveRight | SmartCard Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Alarm Settings - SmartCard 

Use this command to create default alarm settings for a specified DriveRight device. The alarm 
settings control the audible alarms used to indicate when the safety settings thresholds are 
exceeded. 
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To set default alarm settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  

2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 
SmartCard dialog box is displayed. 

3. Select the Alarm Settings tab near the top of the dialog box. The alarm settings options 
are displayed. 

 

4. Set the Alarm Mode to On or Off. This controls audible alarm reporting by the DriveRight 
device. 

5. Enable "Warn if not Logged in" to have the DriveRight device give an audible alarm if the 
vehicle is operated without the driver first entering his or her driver code. 

6. Click Set to save the alarm settings, click Cancel to exit without saving the settings, or 
click on another tab to make additional changes to the DriveRight default settings. 

See also: 

Identification Settings 

Calibration Settings 

Unit Settings 

Safety Settings 

Timer Settings 

Security Settings 

GPS Settings 

Back to Transfer to DriveRight | SmartCard Menu 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Security Settings - SmartCard 

Use this command to create security settings for the specified DriveRight. 

To set security settings: 

To select the identification settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  

2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 
SmartCard dialog box is displayed.  

3. Select the Security Settings Tab near the top of the dialog box. 
 

 
  

4. Set the Pin Code, which is required to set the calibration and alarm settings on the 
DriveRight device. 

5. If desired, you can enable the tamper indicator. If enabled, the tamper indicator on the 
DriveRight LCD screen will be displayed when a tamper event has been detected.  

6. If desired, you can disable Login from the console so that a driver can log into the device 
using only the SmartCard. Check the Disable Login on Console box to disable console 
Login. This application is available for DriveRight 600E devices only. 

7. Click Set to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight settings. 

See Also: 

Identification Settings 

Calibration Settings 
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Unit Settings 

Safety Settings 

Timer Settings 

Alarm Settings 

GPS Settings 

Back to Transfer to DriveRight | SmartCard Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

GPS Settings - SmartCard 

Use this command to view and edit the GPS settings that can be used by the specified vehicle. 

Note: Even if this feature is toggled on an off, it will only work with corresponding DriveRight 600 
units with GPS modules. 

To set  GPS logging settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  

2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 
SmartCard dialog box is displayed. 

3. Select the GPS Settings tab near the top of the dialog box. The GPS settings options are 
displayed.  

 

4. Click On to turn the GPS logging feature on for all the units with a GPS module. Select 
Off to turn off the GPS feature for all DriveRight Devices. Select DriveRight Speed Only to log 
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and track only the DriveRight Speed. This feature logs and tracks only the DriveRight speed for 
DriveRight 600 devices that are not assembled with a GPS module. 

5. If On or the DriveRight Speed only button has been selected, select the Logging 
interval time and corresponding time unit in the Log Data Every text field. The amount of logging 
hours this used for this feature are displayed in Logging Hours. 

6. Click Set to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 

See also: 

Identification Settings 

Calibration Settings 

Unit Settings 

Safety Settings 

Timer Settings 

Alarm Settings 

Security Settings 

Back to Transfer to DriveRight | SmartCard Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Drivers List 

The Drivers List dialog box allows you to set the user identifications assigned to the SmartCard 
currently inserted on the desktop reader.  

Note: The Drivers List dialog box should not be used in conjunction with DriveRight 500 devices. 
This feature is compatible with DriveRight 600 devices and allows you to select up to 100 drivers 
per device. 

To access the Drivers List: 

1. Select Transfer to DriveRight from the SmartCard Menu.  

2. Select Drivers List from the Transfer to DriveRight submenu. The Set Drivers List dialog 
box is displayed. 
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3. Select the driver name/identification number the card is assigned to, and/or select 
Unknown Driver (none) if all drivers in your fleet have privileges to the same card, and 
click the >> button. The selected drivers display in the Drivers List (to set in 
SmartCard) combo box. If you wish to take off a driver from this list, select the driver 
name and click the << button.  

4. Click Set to SmartCard to program the new SmartCard with this information or click 
Cancel to exit without saving the new information to the SmartCard. 

 

Back to Transfer to DriveRight | SmartCard Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Clock Adjustment 

The Clock Adjustment  dialog box allows you to set control clock changes to the DriveRight using 
the SmartCard..  

To adjust the DriveRight clock: 

1. Select Transfer to DriveRight from the SmartCard Menu.  
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2. Select Clock Adjustment from the Transfer to DriveRight submenu. The Clock 
Adjustment dialog box is displayed. 
 

 
  

3. Click the + Hour button set the DriveRight clock1 hour ahead, the - Hour set the clock 
back an hour. Use the Add and Subtract buttons to add or subtract a specified number 
of minutes from the DriveRight clock time. 

4. Click OK to save the new clock settings, or Cancel to exit the Clock Adjustment dialog 
box without saving. 

 

Back to Transfer to DriveRight | SmartCard Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

SmartCard Clear Transfer Data 

The Clear Transfer Data dialog box allows you to clear all of the settings and transfer information 
you stored on the SmartCard. 

To clear the transfer data: 

1. Select Clear Transfer Data from the SmartCard Menu. The Clear Transfer Data dialog 
box is displayed: 
 

 
  

2. Click Yes to clear the transfer data or No to exit the dialog box without clearing the data. 

 

Back to SmartCard Menu | Menu Commands 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

SmartCard Erase 

The Erase dialog box allows you to erase all the stored information on your SmartCard. 

To erase the SmartCard: 

1. Select Erase from the SmartCard Menu. The Erase dialog box is displayed: 
 

 
  

2. Click Yes to erase the SmartCard or No to exit the dialog box without erasing the 
SmartCard. 

 

Back to SmartCard Menu | Menu Commands 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Wireless Menu 

Wireless Menu 

The Wireless Menu contains commands for configuring wireless devices, controlling the wireless 
communication and downloading features for the Wireless Download System. These new 
features, along with the Base Station (# 8130), Wireless On-Board Module (# 8129), and the 
Configuration Cable for Wireless On-Board Module (# 8131) give your fleet the ability to 
download data directly from the DriveRight devices to FMS without physically removing the 
DriveRight devices from the vehicle. The data moves wirelessly from the vehicle to FMS.  

Note: Before using the Wireless Download feature, the Base Station(s) and Wireless On-Board 
Module(s) must be configured using FMS. See the Base Station Installation Manual and 
Configuration Cable for Wireless On-Board Module Installation Manual for more information. 

The following Wireless Menu commands are available: 

Add New Base Station 

Add New Wireless On-Board Module 

Scan Wireless On-Board Modules 

Setup Automatic Wireless Download 

Start Manual Wireless Download 
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Upgrade Firmware 

Select Operating Region 

   
Back to Menu Commands 

   
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Add New Base Station 

The Add New Base Station dialog box configures the Base Station to wirelessly communicate 
with Wireless On-Board Modules and allows you to assign a position to it that makes it easily 
identifiable throughout FMS. 

To add a new Base Station: 

1. Connect your Base Station to the computer's USB port. 

2. Select Add New Base Station from the Wireless Menu. If this is the first time a Base 
Station or Wireless On-Board Module has been added to FMS, the Select Operating 
Region dialog box displays. 
 

 

3. Select among the three choices displayed: North America, Europe, or Other. The 
operating region determines the power level of the wireless devices. Select Europe if the 
power levels of the wireless devices must not exceed CE certification requirements of 
less than 10 dBm. Select North America if the power levels of the wireless devices must 
not exceed FCC or IC certification requirements of less than 30 dBm. Select Other if the 
operating region is not North America or Europe. 

4. Click OK to save the operating region information or click Cancel to exit without saving. 
The Add New Base Station dialog box displays. 
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The dialog box displays the location and the Position text field. If the Base Station 
belongs to a different location, select the correct location from the Current Location dialog 
box before adding the Base Station. 

5. Enter a position description in the Position text box. The maximum number of characters 
for the Position text box is 32. 

6. Click Add to add the new Base Station or Cancel to exit the dialog box without saving 
the new Base Station. 
 
If you clicked Add, a dialog box is displayed to confirm that the Base Station has been 
added to FMS. 
 

 
  

7. Click OK to exit the dialog box. 

See Also: 

How to Add a Base Station 

Back to Wireless Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Add New Wireless On-Board Module 

To add a new Wireless On-Board Module: 

1. Use the Configuration Cable to connect the Wireless On-Board Module to your computer. 

2. Select Add New Wireless On-Board Module from the Wireless Menu.  
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If this is the first time a Base Station or Wireless On-Board Module has been added to 
FMS, the Select Operating Region dialog box displays. 
 

 

3. Select among the three choices displayed: North America, Europe, or Other. The 
operating region determines the power level of the wireless devices. Select Europe if the 
power levels of the wireless devices must not exceed CE certification requirements of 
less than 10 dBm. Select North America if the power levels of the wireless devices must 
not exceed FCC or IC certification requirements of less than 30 dBm. Select Other if the 
operating region is not North America or Europe. 
Once an operating region has been selected, the Add New Wireless On-Board Module 
dialog box displays. 
 

 
 
The dialog box displays the location the Wireless On-Board Module belongs to and the 
Vehicle ID/Lic. Plate drop-down list box.  

4. Select a Vehicle ID or license plate number from the Vehicle ID/Lic Plate drop-down list 
box, or select Automatic. Selecting a Vehicle ID or License plate from the drop down list 
assigns the Wireless On-Board Module to that vehicle. Click Browse to display the 
Vehicles database table. Review the full list of available vehicles to better determine the 
vehicle that gets assigned to the Wireless On-Board Module. Select Automatic if you do 
not want to select a vehicle at this time. The next time either Scan Wireless On-Board 
Modules or Start Manual Wireless Download is selected, or an Automatic Wireless 
Download has occurred, the correct Vehicle ID will be assigned to the Wireless On-Board 
Module based on the vehicle information stored on the DriveRight or CarChip device.  

5. Click Add to add the new Wireless On-Board Module or Cancel to exit the dialog box 
without saving the new Wireless On-Board Module. 
 
If you clicked Add, the New Wireless On-Board Module dialog box displays, confirming 
that the Wireless On-Board Module has been added to the FMS database and is 
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configured for use with your wireless fleet. 
 

 
  

6. Click OK to exit the dialog box. 

Once the Wireless On-Board Module has been added to the FMS database, it can be installed in 
its assigned vehicle or any vehicle in your fleet if you selected Automatic in the Vehicle ID/Lic 
Plate drop-down list box. See the GPS/Wireless System Installation Manual for more 
information on its installation and proper usage. 

Note: The Wireless On-Board Module should only be installed to its assigned vehicle unless 
Automatic is selected when adding the module. 

 

Back to Wireless Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Scan Wireless On-Board Modules 

The Scan Wireless On-Board Modules dialog box uses the Base Station(s) to scan all of the 
Wireless On-Board Modules in the current location and displays the wireless communication 
status of each Wireless On-Board Module. 

Note: At the top of each hour, the Wireless On-Board Module is turned off by the DriveRight or 
Carchip device for up to five minutes. This is done to allow the DriveRight  or CarChip to turn on 
the GPS module to refresh the satellite position periodically. This occurs even without a GPS 
module being physically connected to your DriveRight or Carchip device. FMS will not be able to 
communicate with the Wireless On-Board Module(s) during this time. 

1. Select Scan Wireless On-Board Modules from the Wireless Menu. The Scan Wireless 
On-Board Modules displays a list of all the Wireless On-Board Modules in your 
database associated with the currently selected location. 
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2. Click Start to scan all of the Wireless On-Board Modules. As the Base Station scans for 
the Wireless On-Board Modules, the status of each of the modules displays under the 
Status column.  
 

 
 
  

The color box provides a visual representation of the status for each of the Wireless On-Board 
Modules in the database. The color is updated throughout the scan process. The Status column 
on the right hand side of the dialog box also documents the status for each module. The possible 
statuses are: 
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  Not Yet - The Base Station has not yet scanned for the Wireless On-Board Module. 
 

  Searching for Vehicle - The Base Station is currently searching for the Wireless On-
Board module. 
 

  Successful - The Base Station has successfully found and communicated with 
Wireless On-Board Module. 
 

  Failed - The Base Station has not successfully communicated with or found errors in 
communicating with the Wireless On-Board Module. The scan will continue to search for 
the "Failed" Wireless On-Board Modules until the maximum of 10 retries has been 
reached. The following is a status list that corresponds to the red color box: 

 Vehicle ID Mismatch  - The Wireless On-Board Module is not installed in the assigned 
vehicle. To correct this problem, select the Wireless On-Board Module's record in the 
Wireless Devices database table and click Edit. The Edit Wireless On-Board Module 
dialog box displays information about the On-Board Module. Change the Vehicle ID field 
of the Wireless On-Board Module to Automatic to allow FMS to find the Vehicle's ID 
automatically. You can also install the Wireless On-Board Module into the assigned 
vehicle. 

 Device Not Assigned - The DriveRight has not been assigned to a vehicle, the Carchip 
has not been assigned to a vehicle or a driver, or the DriveRight or CarChip has not been 
added to the FMS Database. Add the DriveRight or CarChip and assign it to the 
corresponding vehicle or driver. 

 Device Not Available - FMS is able to communicate with the Wireless On-Board 
module, but is not able to get a response from the device (DriveRight or CarChip) which 
is connected to the Wireless On-Board Module. Try to restore power to the device or 
reconnect the device to fix the problem. 

 Vehicle Not Found - The Vehicle and Wireless On-Board Module are not within range of 
the Base Station. This status also occurs when there is an error communicating with the 
DriveRight or CarChip device. See Wireless Device Communication Problems for more 
information. 

3. Click Stop to abort the scan before it is completed or click Close to close the dialog box 
once the scan has completed. Please note that if you stop scanning before it completes the scan, 
the last vehicle it scans automatically contains a failed status. 

Note: Since it is not required to select a vehicle when adding a new Wireless On-Board Module, 
Unknown is displayed under the Vehicle ID column to indicate that a vehicle has not been 
assigned to a Wireless On-Board Module.  

 

Back to Wireless Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Setup Automatic Wireless Download 

The Setup Automatic Wireless Download dialog box lets you select when to automatically 
download some or all vehicles that are wirelessly connected to FMS.  

Note: FMS has to be running for the Automatic Wireless Download to occur. 
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1. Select Setup Automatic Wireless Download from the Wireless Menu. The Setup 
Automatic Wireless Download dialog box lets you select the vehicles you want to 
automatically download daily.  
 
By default, a vehicle associated with a newly added Wireless On-Board Module is 
automatically placed in the Vehicles in Download Queue list. This also applies to 
"Unknown" vehicles.  
 

 
 
The Available Vehicles list shows all available vehicles for the current location. The 
Vehicles in the Download Queue list shows the vehicles selected for automatic wireless 
download. 

2. Click >>, All>>,  <<, or All<< to move the vehicles between these two lists. 

3. Enter the time FMS will begin the automatic download process in the Start Time box or 
click the Up or Down arrow buttons to change the start time. The default time is 6:00 PM.  

4. Enter the amount of time you would like FMS to search for the selected vehicles in the 
Duration box or click the Up or Down arrow buttons to increment or decrement the 
hours. The duration allows you to prolong the time for retries when the Wireless On-
Board Modules are not immediately available for download, because they are either out 
of range or currently powered off. 

5. Check the Include Weekend box to automatically download all seven days of the week. 
"Weekend" is defined in the Night and Weekend Settings dialog box. If the start time 
selected in this dialog box falls within the "weekend"  time frame selected in the Night 
and Weekend Settings dialog box, download will not take place during the day or days 
included in the "weekend" definition unless the Include Weekend box is checked. 
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6. Click OK to save the automatic wireless download settings and prepare FMS to 
automatically download the Wireless On-Board Modules or click Cancel to exit without 
saving. 

Note: Since it is not required to select a vehicle when adding a new Wireless On-Board Module, 
Unknown is displayed under the Vehicle ID column to indicate that a vehicle has not been 
assigned to a Wireless On-Board Module. 

Note: Only one wireless download process is allowed at a time. If an automatic download is 
scheduled during a manual download, the automatic download will be delayed until the manual 
download is completed. If the duration period for the Automatic Download has expired before the 
manual download has finished, Automatic Download will not take place for that day.   

Note: Use the Night and Weekend Settings dialog box to enter the night and weekend definitions 
used when you select the Include Weekend checkbox. 

   
Back to Wireless Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Start Manual Wireless Download 

Different from the Automatic Wireless Download, The Start Manual Wireless Download dialog 
box lets you select some or all vehicles in your fleet to wirelessly download immediately once you 
press Start Download.  

1. Select Start Manual Wireless Download from the Wireless Menu or click the Manual 
Wireless Download Icon from the toolbar. The Start Manual Wireless Download dialog 
box lets you select the vehicles you want to download at this time.  
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The Available Vehicles list shows all available vehicles for the displayed location. The 
Vehicles in the Download Queue list shows the vehicles selected for manual wireless 
download. 

2. Click >>, All>>,  <<, or All<< to move the vehicles between these two lists. 

3. Enter the amount of time you would like FMS to search for the selected vehicles in the 
Duration box or click the Up or Down arrow buttons to increment or decrement the 
hours. The duration allows you to prolong the time for retries when the Wireless On-
Board Modules are not immediately available for download, because they are either out 
of range or currently powered off. 

4. Click Start Download to start the download or click Cancel to cancel the manual 
download. 
 
The Wireless Download Status dialog box displays when you click Start Download. 

Note:  Since it is not required to select a vehicle when adding a new Wireless On-Board Module, 
Unknown is displayed under the Vehicle ID column to indicate that a vehicle has not been 
assigned to a Wireless On-Board Module. 

Note: Only one wireless download process is allowed at a time. If you select Start Manual 
Wireless Download from the Wireless Menu while an automatic wireless download is in progress 
or the Wireless Download Status dialog box is currently displaying, the Do You Want to Suspend 
Automatic Wireless Download dialog box displays. If you click Yes, the Automatic Download will 
be suspended until the manual download is completed. If the duration period for the Automatic 
Download  expires before the manual download has finished, Automatic Download will not take 
place for that day.  

 

   
Back to Wireless Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Wireless Download Status 

The Wireless Download Status dialog box displays when the time set in the Automatic Wireless 
Download dialog box has occurred or when you click Start Download in Start Manual Wireless 
Download dialog box. 

Note: At the top of each hour, the Wireless On-Board Module is turned off by the DriveRight or 
Carchip device for up to five minutes. This is done to allow the DriveRight  or CarChip to turn on 
the GPS module to refresh the satellite position periodically. This occurs even without a GPS 
module being physically connected to your DriveRight or Carchip device. FMS will not be able to 
communicate with the Wireless On-Board Module(s) during this time. 
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The Wireless Download Status dialog box displays the progress and status of the vehicles you 
selected to download. 
 

 

The Wireless Download Status dialog box displays a table with all the vehicles selected for 
download and their download status, as well as their assigned vehicle and driver information.  

The color box provides a visual representation of the status for each of the Wireless On-Board 
Modules in the download list. The color is updated throughout the download process. The Status 
column on the right hand side of the dialog box also documents the status for each module. The 
possible statuses are: 

  Not Yet - The Base Station has not yet scanned for the Wireless On-Board Module. 
 

  Searching for Vehicle - The Base Station is currently searching for the Wireless On-
Board Module. 
 

  In Progress - The Base Station is currently downloading DriveRight data through the 
Wireless On-Board Module. 
 

  Successful - The Base Station has successfully found and downloaded the Wireless 
On-Board Module. 
 

  Failed - The Base Station has not successfully communicated with or found errors in 
communicating with the Wireless On-Board Module. The download will continue to retry 
for the failed vehicles until the duration period you selected in the Setup Automatic 
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Wireless Download or Start Manual Wireless Download dialog box has elapsed. The 
following is a status list that corresponds to the red color box: 

 Vehicle ID Mismatch - The Wireless On-Board Module is not installed in the assigned 
vehicle. To correct this problem, select the Wireless On-Board Module's record in the 
Wireless Devices database table and click Edit. The Edit Wireless On-Board Module 
dialog box displays information about the On-Board Module. Change the Vehicle ID field 
of the Wireless On-Board Module to Automatic to allow FMS to find the Vehicle's ID 
automatically. You can also install the Wireless On-Board Module into the assigned 
vehicle. 

 Device Not Assigned - The DriveRight has not been assigned to a vehicle, the Carchip 
has not been assigned to a vehicle or a driver, or the DriveRight or CarChip has not been 
added to the FMS Database. Add the DriveRight or CarChip and assign it to the 
corresponding vehicle or driver. 

 Device Not Available - FMS is able to communicate with the Wireless On-Board 
module, but is not able to get a response from the device (DriveRight or CarChip) which 
is connected to the Wireless On-Board Module. Try to restore power to the device or 
reconnect the device to fix the problem. 

 Vehicle Not Found - The Vehicle and Wireless On-Board Module are not within range of 
the Base Station. This status also occurs when there is an error communicating with the 
DriveRight or CarChip device. See Wireless Device Communication Problems for more 
information. 

 Set Clock Failed - The wireless download was completed successfully, but FMS failed to 
reset the clock on the DriveRight or Carchip. If the Synchronize time and date after 
every download box is checked in the Download Options dialog box, FMS synchronizes 
the DriveRight's internal time and date clock with the computer's clock after every 
download is completed.  

Note: If there is a problem in synchronizing your DriveRight's clock, manually make sure the 
DriveRight clock is still correct, otherwise subsequent data logging may have incorrect time 
stamps. 

Click Abort Download to stop the wireless download before it is completed or click Close to 
close the dialog box once the download has completed. Please note that if you abort the 
download before it completes the download, the last vehicle it scans will automatically contain a 
failed status. 

Note:  Since it is not required to select a vehicle when adding a new Wireless On-Board Module, 
Unknown is displayed under the Vehicle ID column to indicate that a vehicle has not been 
assigned to a Wireless On-Board Module. 

 

Back to Wireless Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Upgrade Firmware 

The Upgrade Firmware dialog box lets you update the firmware for both the wireless Base 
Station and Wireless On-Board Modules. 
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Note: To upgrade the firmware, connect the wireless device(s) to the USB port(s) of the 
computer. Both the Wireless On-Board Module and the Base Station share the same firmware. 

To upgrade the firmware: 

1. Select Upgrade Firmware from the Wireless Menu.  
 
If this is the first time any wireless device has been connected  to FMS, the Select 
Operating Region dialog box displays. 
 

 

2. Select among the three choices displayed: North America, Europe, or Other. The 
operating region determines the power level of the wireless devices. Select Europe if the 
power levels of the wireless devices must not exceed CE certification requirements of 
less than 10 dBm. Select North America if the power levels of the wireless devices must 
not exceed FCC or IC certification requirements of less than 30 dBm. Select Other if the 
operating region is not North America or Europe. 

3. Once an operating region has been selected, the Upgrade Firmware dialog box 
displays. 
 

 
  

4. Select a wireless device that you would like to upgrade from the Select Device to 
Upgrade drop-down list. The device is listed either as Base Station or Wireless On-Board 
Module. If you have multiple Base Stations connected, select the Base Station by its 
position. 
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5. Click Upgrade if the Current Firmware Version is not the same as the Latest Firmware 
Version to upgrade the device firmware. A dialog box is displayed to confirm that the 
firmware has been upgraded successfully: 
 

 

6. Click OK to exit the dialog box. 

7. Click Refresh if you have connected another device to your computer. The Select 
Device to Upgrade drop-down list refreshes to include the newly connected device(s).  

8. Click Close once you are finished upgrading all the wireless devices. 

 

Back to Wireless Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Select Operating Region 

The Select Operating Region dialog box lets you select an operating region to the wireless 
device(s). Selecting a region adjusts the operating legal power of the  wireless device(s). 

1. Select Select Operating Region from the Wireless Menu. The Select Operating 
Region dialog box displays. 
 
The Select Operating Region dialog box displays automatically the first time you select 
Add New Base Station, Add New Wireless On-Board Module, or Upgrade Firmware from 
the Wireless Menu. The same operating region selection applies to all wireless devices 
added to the database. 
 

 

2. Select among the three choices displayed: North America, Europe, or Other. The 
operating region determines the power level of the wireless devices. Select Europe if the 
power levels of the wireless devices must not exceed CE certification requirements of 
less than 10 dBm. Select North America if the power levels of the wireless devices must 
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not exceed FCC or IC certification requirements of less than 30 dBm. Select Other if the 
operating region is not North America or Europe. 

3. Click OK to save the operating region information or click Cancel to exit without saving. 

Note: Changing the operating region at any time only affects the settings of the subsequently 
added wireless devices, not the ones that have been previously added to the system. To re-
configure the setting for previously added devices, remove the wireless device(s) from the 
Wireless Devices database table in the Database menu, reconnect the device(s), change the 
operating region for the device(s), then add the wireless device(s) back into the database. 

 

Back to Wireless Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Database Menu 

Database Menu 

Use the Database Menu options to open individual database tables. In the database table you 
can view and print records. You can also add, edit or delete records. 

Caution: Take extra care before deleting Company Location, DriveRight, CarChip, Driver or 
Vehicle records. 

The following Database Menu options are available: 

Company Locations 

DriveRights 

CarChips  

Wireless Devices 

Driver Groups 

Drivers 

Fleets 

Vehicles 

Trips 

Accident Logs 

Tamper Logs 

Trip Addresses 

Days 

Download Dates 

GPS 
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Odometer Logs 

Safety Score 

Trouble Codes 

Readiness Codes 

CarChip Parameter Logs 

Maintenance 

Back to Menu Commands 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Company Locations 

Use this command to view and edit data for company locations. 

Caution: We strongly advise against changing a location name if you use FTP Export/FTP 
Import, since location name plays a very important role in these operations. If you do any 
kind of centralized data collection do not alter location name. 

To view or edit data for company locations: 

1. Select Company Locations from the Database menu. The Company Locations 
database table is displayed. 

2. Click the Add New button to add a new company location. 

3. Highlight a record in the database table and click Edit, or double-click a record to update 
the company location information. 

4. Highlight a record in the database table and click Delete to delete that record. 

5. Click Close to exit the database table. 

6. Click Print to print the database table. 

See also: 

Add Company Location 

Update Company Location 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRights 

Use DriveRights to view or edit data for installed DriveRight devices. 
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Note: You can only change the assigned vehicle when editing a DriveRight record. 

To view or edit DriveRight data: 

1. Select DriveRights in the Database menu. The DriveRights database table is displayed. 

2. Click the Add New button to add a new DriveRight to the database. This button starts the 
Add New DriveRight Wizard. 

3. Highlight a record in the database table and click Edit, or double-click a record to edit the 
information for a specific DriveRight device. 

4. Highlight a record in the database table and click Delete to delete that record. 

5. Click Close to exit the database table. 

6. Click Print to print the database table. 

See also: 

Edit DriveRight Setup 

Print DriveRights 

Add New DriveRight Wizard 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

CarChips 

Use the CarChips database table to view or edit data for installed CarChip devices. 

To view or edit CarChip data: 

1. Select CarChip from the Database menu. The CarChip database table displays. 
 

 

2. Click Add New to add a new CarChip to the database. The  Add New CarChip Wizard 
displays. 

3. Highlight a record in the database table and click Edit, or double-click a record to edit the 
information for a specific CarChip device. 

4. Highlight a record in the database table and click Delete to delete that record. 
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5. Click Close to exit the database table. 

6. Click Print to print the database table. 

Note: You can only change the assigned vehicle or the assigned driver, and the Next Wireless 
Download Action when editing a CarChip record in the database table.  

See also: 

Edit CarChip Setup 

Add New CarChip 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Driver Groups 

Use Driver Groups in the Database menu to view or edit driver group data.  

To view or edit driver group data: 

1. Select Driver Groups in the Database menu. The Driver Groups database table is 
displayed. 

2. Click Add New to add a new driver group to the database. 

3. Highlight a record in the database table and click Edit, or double-click a record to edit the 
record. 

4. Highlight a record in the database table and click Delete to delete that record. 

5. Click Close to exit the database table. 

6. Click Print to print the database table. 

See also: 

Add Drivers Group 

Edit Drivers Group 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Wireless Devices 

Use Wireless Devices to view or edit data for the wireless device(s) in your fleet. 

To view or edit wireless device information: 
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1. Select Wireless Devices from the Database menu. The Wireless Devices database 
table is displayed. 

2. Highlight a record in the database table and click Edit. The Edit Base Station or Edit 
Wireless On-Board Module dialog box displays. 

3. Highlight a record in the database table and click Delete to delete that record. 

4. Click Close to exit the database table. 

5. Click Print to print the database table. 

 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Drivers 

Use Drivers in the Database menu to view or edit driver data.  

To view or edit driver data: 

1. Select Drivers in the Database menu. The Drivers database table is displayed. 

2. Click the Add New button to add a new driver to the database. 

3. Highlight a record in the database table and click Edit, or double-click a record to edit the 
record. 

4. Highlight a record in the database table and click Delete to delete that record. 

5. Click Close to exit the database table. 

6. Click Print to print the database table. 

See also: 

Add Driver 

Edit Driver 

Print Drivers 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Fleets 

Use Fleets from the Database menu to view or edit fleet data.  

To view or edit fleet data: 

1. Select Fleets from the Database menu. The Fleets database table is displayed. 
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2. Click the Add New button to add a new fleet to the database. 

3. Highlight a record in the database table and click Edit, or double-click a record to edit the 
record. 

4. Highlight a record in the database table and click Delete to delete that record. 

5. Click Close to exit the database table. 

6. Click Print to print the database table. 

See also: 

Add Fleets 

Edit Fleets 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Vehicles 

Use Vehicles from the Database menu to view or edit vehicle data.  

To view or edit vehicle data: 

1. Select Vehicles from the Database menu. The Vehicles database table is displayed. 

2. Click the Add New button to add a new vehicle to the database. 

3. Highlight a record in the database table and click Edit, or double-click a record to edit the 
record. 

4. Highlight a record in the database table and click Delete to delete that record. 

5. Click Close to exit the database table. 

6. Click Print to print the database table. 

See also: 

Add Vehicle 

Edit Vehicle 

Print Vehicles 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Trips 
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Use Trips from the Database menu to view, edit, or map trip data. 

To view or edit trip data:  

1. Select Trips from the Database menu. The Filter For Trips dialog box is displayed. 

2. Select your desired filter options.  

3. Click OK to show the Trips database table or click Cancel to exit the dialog box without 
opening the database table. 

4. Click Add New to create a new record. 

5. Click Set Filter to change the filter for the displayed records. 

6. Highlight a trip record and click Edit to view or edit that record in the Update window. 

7. Highlight a trip record and click Delete to delete the record. 

8. Click Close to exit the database table. 

9. Click Print to print the database table. 

10. Highlight a trip record then click Export GPS to export GPS data from that trip, or, press 
Control-D to export GPS data for the entire day of the currently selected record. 

11. Highlight a trip record then click Map to generate a Trip Mapping Report for that trip, or, 
press Control-D to generate a Day Mapping Report showing all trips taken the same day as the 
selected trip. 

See also: 

Filter for Trips 

Add Trip 

Edit Trip 

Print Trips 

Export: GPS to Mapping Software 

Trip Mapping Report 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Accident Logs 

Use the Accident Logs command in the Database menu to open the Accident Logs database 
table.  

To open the Accident Logs database table: 

1. Select the Accident Logs command in the Database menu. The Filter For Accident 
Logs dialog box is displayed. 

2. Select your desired filter options.  
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3. Click OK to show the Accident Log database table or click Cancel to exit the dialog box 
without opening the database table. 

4. Click Set Filter to change the filter for the displayed accident logs. 

5. Highlight a specific accident record and click Edit to view that record in the Update 
Accident Log window. 

6. Highlight a specific accident record and click Delete to delete a specific accident log 
record. 

7. Click Close to exit the database table. 

8. Click Print to print the database table. 

 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Tamper Logs 

Use Tamper Logs from the Database menu to view tamper log data. 

To view the Tamper Log data: 

1. Select Tamper Logs from the Database menu. The Filter For Tamper Logs dialog box is 
displayed. 

2. Select your desired filter options.  

3. Click OK to show the Tamper Logs database table or click Cancel to exit the dialog box 
without opening the database table. 

4. Click Set Filter to change the filter for the displayed records. 

5. Highlight a specific record and click Edit to view that record in the Update window. 

Note: You cannot edit tamper log data. 

6. Highlight a specific record and click Delete to delete that record. 

7. Click Close to exit the database table. 

8. Click Print to print the database table. 

See also: 

Filter for Tamper Logs 

Edit Tamper Log 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Trip Addresses 

Use Trip Addresses from the Database menu to view or edit trip address data.  

To view or edit trip address data: 

1. Select Trip Addresses from the Database menu. The Trip Addresses database table is 
displayed. 

2. Click the Add New button to add a new trip address to the database. 

3. Highlight a record in the database table and click Edit, or double-click a record to edit the 
record. 

4. Highlight a record in the database table and click Delete to delete that record. 

5. Click Close to exit the database table. 

6. Click Print to print the database table. 

See also: 

Add Trip Address 

Edit Trip Address 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Days 

Use Days in the Database menu to view or edit day data. Day data summarizes vehicle 
information by day. As the day data is composed from the trip database in the case of Trip 
Computer, Trip 500AL or DriveRight 600, you cannot add any data in this dialog box. While 
downloading data from a DriveRight, the day data will be processed and placed into the 
database.  

To view or edit the day data: 

1. Select Days in the Database menu. The Filter For Days dialog box is displayed. 

2. Select your desired filter options.  

3. Click OK to show the Days database table or click Cancel to exit the dialog box without 
opening the database table. 

4. Click Set Filter to change the filter for the displayed records. 

5. Highlight a specific record and click Edit to view that record in the Update window. 

6. Highlight a specific record and click Delete to delete that record. 

7. Click Close to exit the database table. 

8. Click Print to print the database table. 
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9. Highlight a trip record then click Export GPS to export GPS data for trips taken on that 
day.  

10. Highlight a trip record then click Map to create a Day Map for trips taken on that day.   

See also: 

Filter for Days 

Edit Days 

Print Days 

Export: GPS to Mapping Software 

Creating a Day Map 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Download Dates 

Use Download Dates in the Database menu to view or edit the download dates data.  

To view or edit the download dates data: 

1. Select Download Dates from the Database menu. The Filter For Download Dates dialog 
box is displayed. 

2. Select your desired filter options.  

3. Click OK to show the Download Dates browse window or click Cancel to exit the dialog 
box without opening the browse window. 

4. Click Add New to create a new record. 

5. Click Set Filter to change the filter for the displayed records. 

6. Highlight a specific record and click Edit to view that record in the Update window. 

7. Highlight a specific record and click Delete to delete that record. 

8. Click Close to exit the database table. 

9. Click Print to print the database table. 

 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

GPS 

Select GPS from the Database menu to view or edit GPS or speed sample data. 
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To view or edit GPS data: 

1. Select GPS from the Database menu. The Filter For GPS dialog box is displayed. 

2. Select your desired filter options.  

3. Click OK to show the GPS database table. The GPS database table displays. 

4. Click Set Filter to change the filter for the displayed records. 

5. Highlight a specific record and click Edit to view the selected record. 

6. Highlight a specific record and click Delete to delete that record. 

7. Click Close to exit the database table. 

8. Click Print to print the database table. 

Note: See the GPS Status Descriptions for more information on the Status column and what the 
values in the field mean for a given record. 

See also: 

Filter for GPS 

Filter for Deleting GPS 

Edit GPS 

Print GPS 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Odometer Logs 

Use the Odometer Logs command in the Database menu to view or edit odometer log data.  

To view or edit odometer log data: 

1. Select Odometer Logs from the Database menu. The Filter For Odometer Logs dialog 
box is displayed. 

2. Select your desired filter options.  

3. Click OK to show the Odometer Logs database table or click Cancel to exit the dialog 
box without opening the database table. 

4. Click Set Filter to change the filter for the displayed records. 

5. Highlight a specific record and click Edit to edit the selected record. 

6. Highlight a specific record and click Delete to delete that record. 

7. Click Close to exit the database table. 

8. Click Print to print the database table. 
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See also: 

Filter for Odometer Logs 

Edit Odometer Log 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Safety Score 

Use Safety Score  from the Database menu to view Safety Score data or to edit a driver's 
exempt status for a given month.    

To display the Safety Score database table: 

1. Select Safety Score in the Database menu. The Filter For Safety Score dialog box is 
displayed. 

2. Select your desired filter options.  

3. Click OK to show the Safety Score database table or click Cancel to exit the dialog box 
without opening the database table. 

4. Click Set Filter to change the filter for the displayed records. 

5. Highlight a specific record and click Edit to edit the selected record. 

6. Highlight a specific record and click Delete to delete that record. 

7. Click Close to exit the database table. 

8. Click Print to print the database table. 

See also: 

Filter For Safety Score 

Edit Safety Score 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Trouble Codes 

Use Trouble Codes from the Database menu to view any trouble codes logged by a CarChip. 

Note: The Trouble Code database table and resulting data is only logged by a CarChip device.  

To view the Trouble Code data: 

 

1. Select Trouble Codes from the Database menu. The Filter For Trouble Codes dialog 
box is displayed. 
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2. Select your desired filter options.  

3. Click OK to view the Trouble Code database table or click Cancel to exit the dialog box 
without opening the database table. The Trouble Code database table displays the Trouble Code, 
description and a sample of the engine reading taken at the time the trouble code was recorded. 

 

4. Click Set Filter to change the filter for the displayed record or highlight a specific record 
and click Edit to view that record. 

Note: You cannot edit trouble code records but you can view the individual record's 
detailed information. 

5. Highlight a specific record and click Delete to delete that record. 

6. Click Close to exit the database table. 

7. Click Print to print the database table. 

See also: 

Filter for Trouble Codes 

Edit Trouble Code Record 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Readiness Codes 
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Use Readiness Codes from the Database menu to view the readiness codes logged by a 
CarChip. A readiness code is used to indicate whether or not monitored emissions control 
systems have been tested by the OBDII system. Each emissions control system has its own 
monitor and related code.  Some emission control components are tested continuously 
throughout a trip and others are tested intermittently when predetermined operating conditions 
are met.  

Note: The Readiness Code database table and resulting data is only logged by a CarChip device 
at the beginning of a trip. The readiness code database displays readiness codes from the last 
recorded trip for every CarChip and assigned vehicle in the database. One readiness code record 
is available for each assigned vehicle. 

To view the Readiness Code data: 

 

1. Select Readiness Codes from the Database menu. The Filter For Readiness Codes 
dialog box is displayed. 

2. Select your desired filter options.  

3. Click OK to view the Readiness Code database table or click Cancel to exit the dialog 
box without opening the database table. The Readiness Code database table displays the eleven 
possible readiness codes, whether or not the readiness code is supported for the vehicle and if 
the readiness monitor completed or did not complete a test at the time the readiness code 
monitors were recorded (usually at time of vehicle start-up) for each of the available readiness 
codes.  
 
The monitored readiness codes are: 
 
Catalyst 
Heated Catalyst 
Evaporative System 
Secondary Air System 
A/C System Refrigerant 
Oxygen Sensor 
Oxygen Sensor Header 
EGR System 
Misfire 
Fuel System 
Comprehensive Component 
 
Not all eleven monitors displayed on the list may be supported, or monitored by your vehicle's 
systems. If "Not Supported" displays in the supported column, it simply means that the monitor 
does not exist or is not be monitored by your vehicle. See your vehicle's manual or supporting 
documentation for emission monitors that your vehicle does support.  
 
The Status column displays "Complete" or "Not Complete" for the readiness codes that are 
supported in your vehicle and "--" for all the readiness codes that are not supported. A 
"Complete" means a test of that emissions monitor was completed at the time of CarChip 
recorded the readiness codes. A "Not Complete" could mean that the OBD system has not yet 
completed testing of that component or system or that a component failure may exist, but has not 
been identified because system testing has not been complete. Most states allow for two unset 
readiness codes during OBD or smog check testing. If three or more unset, non-continuous 
codes are present, vehicle may be deemed as "Unable to complete OBD Testing". See your 
state's rules and regulations for more details. 
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4. Click Set Filter to change the filter for the displayed record or highlight a specific record 
and click Edit to view that record. 

Note: You cannot edit trouble code records but you can view the individual record's 
detailed information. 

5. Highlight a specific record and click Delete to delete that record. 

6. Click Close to exit the database table. 

7. Click Print to print the database table. 

See also: 

Filter for Readiness Codes 

Edit Readiness Code Record 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

CarChip Parameter Logs 

Use CarChip Parameter Logs to view vehicle speed parameter logs for a selected CarChip or all 
CarChips available in the database. 

To view the CarChip Parameter Log data: 

1. Select CarChip Parameter Logs from the Database menu. The Filter for CarChip 
Parameter Logs dialog box displays. 
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2. Select your desired filter options.  

Click OK to display the CarChip Parameter Logs database table or click Cancel to exit 
the dialog box without opening the database table. The CarChip Parameter Logs 
database table displays. 
 

 

3. Highlight a record in the database table and click Delete to delete that record. 

4. Click Set Filter to change the filter for the displayed records. 

5. Click Close to exit the database table. 

6. Click Print to print the database table. 

See also: 

Filter for Carchip Parameter Logs 

Print CarChip Parameter Logs 

Filter for Deleting CarChip Parameter Logs 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Maintenance 

Maintenance 

Use Maintenance sub-menu under the Database menu to perform data maintenance 
procedures, such as deleting records or batch editing records in the database.  
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Select Delete Data from the Maintenance sub-menu to delete selected records for record 
types displayed in the drop down list. The record types for deletion are:  

 Trips 

 Accident Logs 

 Tamper Logs 

 Days 

 Download Dates 

 GPS 

 Odometer Logs 

 CarChip Parameter Logs 

Select Batch Editing from the Maintenance sub-menu to reassign certain database 
records to another driver or to re-calibrate speed readings for certain vehicles or drivers.  
  

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Filter For Deleting Trips 

Use this filter to select trip records for deletion. 

 

To select trip data for deletion:  

 

1. Select Maintenance from the Database menu. 

2. Select Delete Data and then select Trips in the drop-down menu. The Filter For 
Deleting Trips dialog box is displayed. 
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3. Select one of four options: 
 
Click the Delete All to delete all records.  
Click Driver Name and select a driver from the drop-down list to delete the records for a specific 
driver.  
Click DriveRight ID and select an ID from the drop-down list to delete the records for a specific 
DriveRight.  
Click Veh ID/Lic and select an ID from the drop-down list to delete the records for a specific 
vehicle. 

4. Check Trips Between and select a Start Date and End Date to delete records from a 
specific time period. 

5. To delete records with a high speed over a specified speed, enter a speed in the High 
Speed >= text box. 

6. Click OK to delete the selected records or click Cancel to exit the dialog box. 

 

Back to Database Menu | Maintenance 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Filter For Deleting Accident Logs 

Use this filter to select Accident Log data to be deleted. 
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To select Accident Log data for deletion:  

 

1. Select Maintenance from the Database menu. 

2. Select Delete Data from the Maintenance sub-menu and then select Accident Log in 
the drop-down menu. The Filter For Deleting Accident Log dialog box is displayed. 

 

3. Select one of three options: 
Click the Delete All to delete all records.  
Click Driver Name and select a driver from the drop-down list to delete the records for a specific 
driver.  
Click DriveRight ID and select an ID from the drop-down list to delete the records for a specific 
DriveRight. 

4. Check Accident Logs Between and select a Start Date and End Date to delete records 
from a specific time period. 

5. Click OK to delete the selected records or click Cancel to exit the dialog box. 

 

Back to Database Menu | Maintenance 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Filter For Deleting Tamper Logs 

Use this filter to select Tamper Log data to be deleted. 

 

To select tamper log data for deletion:  
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1. Select Maintenance from the Database menu. 

2. Select Delete Data and then select Tamper Logs from the drop-down menu. The Filter 
For Deleting Tamper Logs dialog box is displayed. 

 

3. Select one of four options: 
Click the Delete All to delete all records.  
Click Driver Name and select a driver from the drop-down list to delete the records for a specific 
driver.  
Click DriveRight ID and select an ID from the drop-down list to delete the records for a specific 
DriveRight.  
Click Veh ID/Lic and select an ID from the drop-down list to delete the records for a specific 
vehicle. 

4. Check Tamper Logs Between and select a Start Date and End Date to delete records 
from a specific time period. 

5. Click OK to delete the selected records or click Cancel to exit the dialog box. 

 

Back to Database Menu | Maintenance 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Filter For Deleting Days 

Use this filter to select Days Table records to be deleted. 

 

To delete Days Table records:  
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1. Select Maintenance from the Database menu. 

2. Select Delete Data and then select Days in the drop-down menu. The Filter For 
Deleting Days dialog box is displayed. 

 

2. Select one of three options: 
Click Delete All to select all records for deletion.  
Click Driver Name and select a driver from the drop-down list to select the records for a specific 
driver for deletion.  
Click DriveRight ID and select an ID from the drop-down list to select the records for a specific 
DriveRight for deletion. 

3. Check Days Between and select a Start Date and End Date to select records from a 
specific time period for deletion. 

4. To select for deletion only records with a high speed over a specified speed, enter a 
speed in the High Speed >= text box. 

5. Click OK to delete the selected records or click Cancel to exit. If you click OK, a 
confirmation dialog box appears. 

6. Click Yes to confirm deletion or click no to cancel the deletion. 

 

Back to Database Menu | Maintenance 

 

Home | Getting Started |Quick Reference | Menu Commands | Troubleshooting 

Filter For Deleting Download Dates 
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Use this filter to select Download Dates records for deletion. 

 

To select Download Dates data for deletion:  

 

1. Select Maintenance from the Database menu. 

2. Select Delete Data and then select Download Dates in the drop-down menu. The Filter 
For Deleting Download Dates dialog box is displayed. 

 

2. Select one of three options: 
 
Click Delete All to delete all records.  
Click Driver Name and select a driver from the drop-down list to delete the records for a specific 
driver.  
Click DriveRight ID and select an ID from the drop-down list to delete the records for a specific 
DriveRight. 

3. Check Download Dates Between and select a Start Date and End Date to delete 
records for a specific time period. 

4. Click OK to delete the selected records or click Cancel to exit the dialog box. 

 

Back to Database Menu | Maintenance 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Filter For Deleting GPS 
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Use this filter to select GPS data to be deleted. 

 

To select GPS data for deletion:  

 

1. Select Maintenance from the Database menu. 

2. Select Delete Data and then select GPS in the drop-down menu. The Filter For Deleting 
GPS dialog box is displayed. 

 

2. Select one of three options: 
Click Delete All to delete all records.  
Click Driver Name and select a driver from the drop-down list to delete the records for a specific 
driver.  
Click DriveRight ID and select an ID from the drop-down list to delete the records for a specific 
DriveRight. 

3. Check GPS Between and select a Start Date and End Date to delete records from a 
specific time period. 

4. To delete records with a high speed over a specified speed, enter a speed in the High 
Speed >= text box. 

5. Click OK to delete the selected records or click Cancel to exit the dialog box. 

 

Back to Database Menu | Maintenance 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Filter For Deleting Odometer Logs 

Use this filter to select Odometer Log data to be deleted. 

 

To select odometer log data for deletion:  

 

1. Select Maintenance from the Database menu. 

2. Select Delete Data and then select Odometer Logs in the drop-down menu. The Filter 
For Deleting Odometer Logs dialog box is displayed. 

 

2. Select one of three options:  
Click Delete All to delete all records.  
Click Driver Name and select a driver from the drop-down list to delete the records for a specific 
driver.  
Click DriveRight ID and select an ID from the drop-down list to delete the records for a specific 
DriveRight. 

3. Click OK to delete the selected records or click Cancel to exit the dialog box. 

 

Back to Database Menu | Maintenance 

 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Filter for Deleting CarChip Parameter Logs 

Use Filter for Deleting CarChip Parameter Logs to set the filter for deleting certain parameter 
log records for a selected CarChip or all CarChips in the available in the database. 

To filter the CarChip Parameter Logs data for selecting logs you want to delete: 

1. Select Maintenance from the Database menu.  
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2. Select Delete Data from the Maintenance sub-menu.  

3. Select CarChip Parameter Logs. 

4. The Filter for Deleting CarChip Parameter Logs dialog box displays. 
 

 

2. Select one of two options: 
 
Click Browse All to select all records.  
Click CarChip ID and select a CarChip ID from the drop-down list to select the records for a 
specific CarChip.  

3. Check Logs Between and select a Start Date and Time and End Date and Time to 
select records for a specific time period. 

4. Click OK to set the filter or click Cancel to exit the dialog box. The Confirm Deletion 
dialog box displays. 
 

 
  

5. Click Yes to delete the parameter logs selected or No to cancel the deletion. 

See also: 

CarChip Parameter Logs 
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Print CarChip Parameter Logs 

Filter for CarChip Parameter Logs 

Back to Database Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Reports Menu 

Reports Menu 

DriveRight can produce a number of useful reports. The reports can be displayed on the screen 
or printed. 

The following reports are available: 

Accident Log Report 

Driver Safety Score 

Driver Safety Score Summary 

Exception Reports 

Database Reports 

Usage Report 

Trip Summary Report 

Vehicle Activity Report 

Graphical Day Report 

Tamper Logs Report 

Odometer Report 

Relationship Report 

Days Since Last Download 

Wireless Download Status Report 

 

Back to Menu Commands Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Accident Log Report 
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The Accident Log report allows you to view, print, export, or map the contents of the Accident 
Log.  

 

To create an Accident Log Report: 

1. Select Accident Log Report from the Reports Menu. The Accident Report dialog box 
is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 

3. Select the DriveRight ID to be used in the report. 

4. Select the Start Date and the End Date for the accident logs to be listed in the report. 

5. Select the type of output for the report: Excel, Report Viewer, Map, or both Map and 
Excel. 

6. Click OK to create the report or click Cancel to exit the dialog box. 

See also: 

Mapping Quick Reference Menu 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Driver Safety Score Report 

The Driver Safety Score report allows you to customize, view, print, email, or export the Driver 
Safety Score.  
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To create the Driver Safety Score Report: 

1. Select Driver Safety Score Report from the Reports Menu. The Driver Safety Score 
dialog box is displayed. 

 

2. Click on the company locations to be used in the report. The selected locations are 
highlighted. 

3. Select the Start Date and the End Date for the driver safety data to be included in the 
report. 

4. Use the "Compare with last ___ months" text box to enter the number of months back 
from the start date that you want to include in the calculation of the "cumulative" score.  The 
cumulative score will be calculated from the start date minus X months up to and including the 
end date. 

5. Use the Sort by options to sort the output by current score, cumulative score, or the 
driver's name.  If you sort by current score and choose "Use Color", the coloring is done based on 
the current score.  If you sort by cumulative score, the coloring is done based on cumulative 
score.  If you sort by driver's name, coloring is done based on the current score. 

6. Select the type of output for the report: Excel, Report Viewer, or Email. Click Use Color to 
enable color printing. 

7. Check Group By Location to group together the scores for each location. Check Drivers 
With Mileage Only to display only drivers with trips/mileage listed to their identification. Check 
Corporate Report to generate the Driver Safety Score Report based on the corporate hierarchy 
structure created in the Corporate Structure dialog box.  

8. Click on the Formula button to view or change the Driver Safety Score parameters. 
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9. Click OK to create the report or click Cancel to exit the dialog box. 

See also: 

Driver Safety Score Formula 

Output to Excel 

Output to Email 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Driver Safety Score Summary Report 

The Driver Safety Score Summary command creates a Driver Safety Score Summary Report 
based on the Safety Score Reports stored in the Safety Score Table.  

 

To create the Driver Safety Score Summary Report: 

1. Select Driver Safety Score Summary Report from the Reports Menu. The Driver 
Safety Score Summary dialog box displays. 

 

2. Click on the company locations to be used in the report. The default location is the 
current location, and the selected locations are highlighted. 
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3. Select the Duration of the report. This is the number of months to be included in the 
report. 

4. Select the End Date for the report. FMS will calculate the Start Date based on the 
Duration and End Date. 

5. Use the Sort by options to sort the output by Current Score, Report Average, or Driver 
Name.  If you sort by current score and choose Use Color, the coloring is done based on the 
current score.  If you sort by report average, the coloring is done based on report average score. 
 If you sort by driver's name, coloring is done based on the current score. 

6. Select the type of output for the report: Excel, Report Viewer, or Email. Click Use Color 
to enable color printing. 

7. Check Group By Location to group together the scores for each location. 

8. Check Recalc data for all months to have the monthly scores recalculated for this 
report. 

9. Click the Formula button to view or change the Driver Safety Score parameters. 

10. Click OK to create the report, or click Cancel to exit the dialog box without saving 
changes. 

See also: 

Driver Safety Score Formula 

Output to Excel 

Output to Email 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Exception Reports 

Exception Reports 

Exception Reports can be printed for Vehicles, Drivers, and Trip Addresses. 

Excessive Speed Report 

Night Driving Report 

Hard Braking Report 

Hard Acceleration Report 

Time Over Speed 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Excessive Speed Report 

Use the Excessive Speed Report to identify drivers that exceed a set speed. 

 

To create an Excessive Speed Report: 

 

1. Select Excessive Speed Report from the Exception Reports submenu in the Reports 
Menu. The Excessive Speed Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 

3. Select the Sort By criteria by clicking next to either Driver Name or Date. 

4. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 

5. If you are creating the report for specific drivers, select the driver's name in the list.  

o Click once to select the name and click a second time to clear the name.  

o Multiple drivers can be selected for the report. 

222 



DriveRight FMS Help 

6. Check "Show Most Recent Dates First" to list trips from the most recent trip to the oldest. 
If this box isn't checked the trips will be listed from the oldest trip to the most recent. 

7. Select Trips Between to create a report that only lists trips taken between specific dates. 
If you select Trips Between, then indicate the Start Date and End Date for the reported trips. 

8. Enter the Top Speed in the edit box. Trips with speeds in excess of the top speed will be 
listed in the report. 

9. Click OK to create the report or click Cancel to exit the dialog box. 

10. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 

 

Back to Reports Menu | Exception Reports 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Night Driving Report 

Use the Night Driving Report to list trips that occur during user-defined nighttime hours. Use this 
report to track unauthorized night driving.  

 

To create a Night Driving Report: 

1. Select Night Driving from the Exception Reports submenu in the Reports Menu. The 
Night Driving Report dialog box is displayed. 
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2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 

3. Select the Sorting criteria by clicking next to either Driver Name or Date. 

4. Check "Show Most Recent Dates First" to list trips from the most recent trip to the oldest. 
If this box isn't checked the trips will be listed from the oldest trip to the most recent. 

5. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 

6. If you are creating the report for specific drivers, click on the drivers name in the list.  

o Click once to select the name and click a second time to clear the name.  

o Multiple drivers can be selected for the report. 

6. In the Define Night box enter the night times for the report. Night will begin at the After 
time. Night will end at the Before time. 

7. In the Choose Limit box you can configure the report to list trips with at least the minimum 
amount of night driving time that you specify for a single trip, or you can choose to list trips for 
drivers with at least the minimum amount of total night driving time during the chosen date 
interval.  

8. In the Choose Interval box, set  the start and end dates for the trips to be included in the 
report. 

9. Click OK to create the report or click Cancel to exit the dialog box. 

10. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 

 

Back to Reports Menu | Exception Reports 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Hard Braking Report 

Use the Hard Braking Report to identify drivers that use the brakes excessively. 

 

To create a Hard Braking Report: 

 

1. Select Hard Braking from the Exception Reports submenu in the Reports Menu. The 
Hard Braking Report dialog box is displayed. 
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2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 

3. Select the Sort By criteria from the drop-down list: Driver name, Date, Decel count and 
Decel count rate. 

4. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 

5. If you selected Driver Names, click on the names of drivers to be included in the report. 

o Click once to select the name. You can click a second time to clear the name.  

o Multiple drivers can be selected for the report. 

6. Check "Show Most Recent Dates First" to list trips from the most recent trip to the oldest. 
If this box isn't checked the trips will be listed from the oldest trip to the most recent. 

7. In the Choose Limit box you can configure the report to include all trips with at least the 
indicated number of deceleration counts or you can include the trips for all drivers that exceed the 
minimum number of deceleration counts during the chosen date interval. 

8. In the Choose Interval box, set the start and end dates for the trips to be included in the 
report. 

9. Click OK to create the report or click Cancel to exit the dialog box. 

10. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 

 

Back to Reports Menu | Exception Reports 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Hard Acceleration Report 

1. Select Hard Acceleration from the Exception Reports submenu in the Reports Menu. 
The Hard Acceleration Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 

3. Select the Sort By criteria from the drop-down list: Driver Name, Date, Accel Count, or 
Accel Count Rate. 

4. Select All Drivers to print a report for all drivers, or select Driver Names to create a 
report for specific drivers. 

5. If you selected Driver Names, click on the names of drivers you want to include in the 
report. 

o Click once to select the name. Click a second time to clear the name.  

o Multiple drivers can be selected for the report. 

6. Check Show Most Recent Dates First to list trips from the most recent trip to the oldest. 
If this box isn't checked, the trips will be listed from the oldest trip to the most recent. 

7. In the Choose Limit box you can configure the report to include all trips with at least the 
indicated number of acceleration counts or you can include the trips for all drivers that 
exceed the minimum number of acceleration counts during the chosen date interval. 

8. In the Choose Interval box, set the start and end dates for the trips to be included in the 
report. 

9. Click OK to create the report or click Cancel to exit the dialog box. 
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Clear the report using the Clear Screen command in the File Menu or by clicking on the Clear 

Screen icon: . 

 

Back to Reports Menu | Exception Reports 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

Time Over Speed 

Use the Time Over Speed Report to identify drivers that speed excessively. 

To create a Time Over Speed Report: 

1. Select Time Over Speed from the Exception Reports submenu in the Reports Menu. 
The Time Over Speed Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 

3. Select the Sort By criteria from the drop-down list: Driver name, Date, Time over speed 
and % of time over speed.. 

4. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 
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5. If you selected Driver Names, click on the names of drivers to be included in the report. 

o Click once to select the name. You can click a second time to clear the name.  

o Multiple drivers can be selected for the report. 

6. In the Choose Interval box, set the start and end dates for the trips to be included in the 
report. 

7. Check "Show Most Recent Dates First" to list trips from the most recent trip to the oldest. 
If this box isn't checked the trips will be listed from the oldest trip to the most recent. 

8. In the Choose Limit box, configure the report to include all single trips with at least the 
amount of time over the speed limit or you can configure the report to show total time over the 
speed limit.. 

9. Click OK to create the report or click Cancel to exit the dialog box. 

10. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 

 

Back to Reports Menu | Exception Reports 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Database Reports 

Database Reports 

Database Reports can be printed for Vehicles, Drivers, and Trip Addresses. 

Vehicles Report 

Trip Addresses Report 

Drivers Report 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Vehicles Report 

To print a Vehicles Report: 

1. Select Vehicles Report from the Database command in the Reports Menu. The Vehicles 
Report dialog box is displayed. 
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2. Verify the Company Location. Use  Current Location in the Setup Menu to change the 
location if necessary. 

3. Select the Sorting criteria by clicking next to the desired parameter. 

4. Select View for to display vehicles from a specific fleet or of a specific type. 

5. Click OK to create the report or click Cancel to exit the dialog box. 

6. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 

 

Back to Reports Menu | Database Reports 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Trip Addresses Report 

The Trip Addressees Report displays a list of the trip addresses in your database. 

To view the Trip Addresses Report: 

1. Select Trip Addresses Report from the Database submenu in the Reports Menu. The 
Trip Addresses Report is displayed. 

2. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 
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Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Drivers Report 

To print a Drivers Report: 

1. Select Drivers Report from the Database submenu in the Reports Menu. The Drivers 
Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 

3. Select the sorting criteria by clicking next to the desired parameter. 

4. Select View by to display drivers from a specific group. 

5. Click OK to create the report or click Cancel to exit the dialog box. 

6. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 

 

Back to Reports Menu | Database Reports 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Usage Report 

The Usage Report provides a quick and easy-to-read summary of driver or vehicle mileage. 
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To create a Usage Report: 

1. Select Usage Report from the Reports Menu. The Usage Report dialog box is 
displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 

3. Select the criteria for sorting the report from the Sort By drop-down list. 

4. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 

5. If you are creating a report for specific drivers, click on the driver's name in the list.  

o Click once to select the driver and click a second time to de-select the driver.  

o Multiple drivers can be selected for the report. 

6. Select All Vehicles to print the report for all vehicles, or select Veh ID/ Lic. No to create 
the report for specific vehicles. 

7. If you are creating a report for specific vehicles, click on the vehicle's ID in the list.  

o Click once to select the vehicle and click a second time to de-select the vehicle.  

o Multiple vehicles can be selected for the report. 
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9. Check Show Mileage By Trip Type to include a breakdown of the trip mileage by type of 
trip. DriveRight supports the following trip types: business, personal, commute, and other. 

10. To specify a start date and end date for the report, check Trips Between and then enter 
the starting and ending dates. 

11. Select the type of output for the report: Excel, Report Viewer, or Email. 

12. Click OK to create the report, or click Cancel to exit the dialog box. 

 

Note: Use the Night and Weekend Settings dialog box to enter the night and weekend definitions 
used in this report. 

 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Trip Summary Report 

The Trip Summary Report provides a quick and easy-to-read summary of trips taken by either 
drivers or vehicles. The report also calculates the total trip time, idle time, and distance for each 
driver. 

 

To create a Trip Summary Report: 

1. Select Trip Summary Report from the Reports Menu. The Trip Summary Report 
dialog box is displayed. 
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2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 

3. Select the Sorting criteria from the drop-down list. 

4. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 

5. If you are creating a report for specific drivers, click on the drivers name in the list.  

o Click once to select the drive and click a second time to de-select the driver.  

o Multiple drivers can be selected for the report. 

6. Select All Vehicles to print the report for all vehicles, or select Veh ID/ Lic. No to create 
the report for specific vehicles. 

7. If you are creating a report for specific vehicles, click on the vehicle's ID in the list.  

o Click once to select the vehicle and click a second time to de-select the vehicle.  

o Multiple vehicles can be selected for the report. 

9. Check "Show Most Recent Dates First" to list trips from the most recent trip to the oldest. 
If this box isn't checked the trips will be listed from the oldest trip to the most recent. 

10. To specify a start date and end date for the report, check Trips Between and then enter 
the starting and ending dates. 

11. Select the type of output for the report: Excel, Report Viewer, or Email. 
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12. Click OK to create the report or click Cancel to exit the dialog box. 

13. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 

 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Vehicle Activity Report 

The Vehicle Activity Report provides a quick and easy-to-read summary of driver or vehicle 
activities. 

To create a Vehicle Activity Report : 

1. Select Vehicle Activity Report from the Reports Menu. The Vehicle Activity Report 
dialog box is displayed. 
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2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 

3. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 

4. If you are creating a report for specific drivers, click on the driver's name in the list.  

o Click once to select the driver and click a second time to de-select the 
driver.  

o Multiple drivers can be selected for the report. 

6. Select All Vehicles to print the report for all vehicles, or select Veh ID/ Lic. No to create 
the report for specific vehicles. 

7. If you are creating a report for specific vehicles, click on the vehicle's ID in the list.  

235 



DriveRight FMS User's manual 

o Click once to select the vehicle and click a second time to de-select the 
vehicle.  

o Multiple vehicles can be selected for the report. 

8. When the Show vehicles with distance only check box is checked, the drivers or 
vehicles that don't have any trip data, or the trip distance is 0 (zero), will not be shown in the 
report. 

9. Select the criteria for sorting the report from the Sort By drop-down list. 

10. The limit settings in the Choose Limits section are for display purposes only in the 
Vehicle Activity Report. If you select the Highlight Exceptions check box, these limits are 
available for you to change. If a driver or vehicle exceeds any limit, that value will be highlighted 
with red text in the report. 

11. To specify a start date and end date for the report, check Trips Between and then enter 
the starting and ending dates. 

12. If trip Start Date and End Date are the same, the Daily Vehicle Activity Report will be 
generated for that one day. If trip Start Date and End Date are not the same, the Vehicle Activity 
Report for the selected period will be generated.   

13. Select the type of output for the report: Excel, Report Viewer, or Email. 

14. Click OK to create the report, or click Cancel to exit the dialog box. 

Note: Use the Night and Weekend Settings dialog box to enter the night and weekend definitions 
used in this report. 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

Graphical Day Report 

The Graphical Day Report provides a quick and easy-to-read summary of driver or vehicle by day 
and date 

To create a Graphical Day Report: 

1. Select Graphical Day Report from the Reports Menu. The Graphical Day Report 
dialog box is displayed. 
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2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 

3. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 

4. If you are creating a report for specific drivers, click on the drivers' names in the list.  

o Click once to select the driver; click a second time to de-select the driver.  

o Multiple drivers can be selected. 

6. Select All Vehicles to print the report for all vehicles, or select Veh ID/ Lic. No to create 
the report for specific vehicles. 

7. If you are creating a report for specific vehicles, click on the vehicle's ID in the list.  

o Click once to select the vehicle; click a second time to de-select the 
vehicle.  

o Multiple vehicles can be selected for the report. 

8. To specify a start date and end date for the report, check Trips Between and then enter 
the starting and ending dates. 

9. If trip Start Date and End Date are the same, the Graphical Day Report will be 
generated for that one day. If trip Start Date and End Date are not the same, the Graphical Day 
Report for the selected period will be generated.   

10. If you would like to view trip types (Business, Commute, Personal, Other ) in different 
colors, click the Show trip type with different colors box.   

11. Day and Night trips (as defined in the Setup Screen > Preferences > Night and Weekend 
Settings) are shown divided by a line. 
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12. For vehicles with CarChip, you can also see idle times. Click the Show accumulated 
idle time at the end of the trip box to see a total of idle time for each trip.  The graph will show 
any idle times equal to or longer than what you specify in the Show Idle Time > = box.   

13. Click OK to create the report, or click Cancel to exit the dialog box. 
 

 

 

13. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 

 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

 

 

Tamper Logs Report 
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The Tamper Logs Report allows you to view the tamper logs for the selected drivers. The report 
is displayed by the DriveRight FMS Report Viewer. 

To view the Tamper Logs Report: 

1. Select Tamper Logs Report from the Reports Menu. The Tamper Logs Report dialog 
box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 

3. Select the Sort by criteria by clicking next to either Driver Name or Date. 

4. Check "Show Most Recent Dates First" to list trips from the most recent trip to the oldest. 
If this box isn't checked the trips will be listed from the oldest trip to the most recent. 

5. Check All Drivers to create an Tamper Logs Report for all drivers in the database.  

6. Check Driver Names to create an Tamper Logs Report for specific drivers in the 
database. 

7. If you are creating the report for specific drivers, select the driver name from the list.  

o Click once to select a driver. Click a second time to de-select.  

o Multiple drivers can be selected for the report. 
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8. Select Tamper Logs Between to create a report that only lists Tamper Logs recorded 
between specific dates. If you select Tamper Logs Between, then indicate the Start Date and 
End Date for the report. 

9. Enter the maximum allowable time between unplugging the DriveRight and downloading. 
The report will include all include all times the limit was exceeded. 

10. Enter the maximum allowable time between downloading the DriveRight and 
reconnecting to the vehicle. The report will include all include all times the limit was exceeded. 

11. Click OK to create the report or click Cancel to exit the dialog box. 

12. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 

 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Odometer Report 

The Odometer Report allows you to view the odometer reading for vehicles in the database, as 
well as the number of days since the last download for that vehicle and the date the last odometer 
adjustment was made. A report option allows you to included the default driver for each vehicle 
listed in the report. 

 

To view the Odometer Report: 

 

1. Select Odometer Report from the Reports Menu. The Odometer Report dialog box is 
displayed. 
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2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 

3. Check All Vehicles to create an Odometer Report for all vehicles in the database.  

4. Check Veh ID/Lic. No to create an Odometer Report for specific vehicles in the 
database. 

5. If you are creating the report for specific vehicles, select the vehicle's ID from the list.  

o Click once to select the vehicle and click a second time to clear the vehicle.  

o Multiple vehicles can be selected for the report. 

6. Select the Sort By criteria from the drop-down list: Vehicle ID, License or Odometer. 

7. Check Show Default Driver if you want the name of the default driver for each vehicle 
included in the report. 

8. Click OK to create the report or click Cancel to exit the dialog box. 

o If you click OK, the report is displayed using the Report Viewer.  

o You can print the report using the Print command in the File Menu. 

9. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 

 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Relationship Report 

The Relationship Report displays the vehicle and default driver assigned to each of the 
DriveRight devices in your database. 

To view the Relationship Report: 

1. Select Relationship Report from the Reports Menu. The report is displayed using the 
DriveRight FMS Report Viewer. 

2. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 

 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Days Since Last Download 

The Days Since Last Download Report allows you to quickly see the number of days that have 
elapsed since a DriveRight or CarChip device has been downloaded into the DriveRight FMS 
database. The report is sorted by the number of days since the last download. Devices with the 
most number of days since the last download are listed first. 

 

To create the Days Since Last Download Report: 

1. Select Days Since Last Download from the Reports Menu. The Days Since Last 
Download Report dialog box is displayed. 

 

2. Select All Locations to create a report for all DriveRight and CarChip devices in all 
locations in your database, or select Location Names to create a report for specific locations, 
then select the locations from the list.  
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 Click once to select a location and click a second time to clear the location from 
the report.  

 Multiple locations can be selected for this report. 

3. Click OK to create the report or click Cancel to exit. 

o If you click OK, the report is displayed using the Report Viewer.  

4. To print the report, use the Print command in the File Menu. 

5. To clear the report from the screen, use the Clear Screen command in the File Menu or 

click on the Clear Screen icon: . 

 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Wireless Download Status Report 

The Wireless Download Status Report allows you to view the wireless download status for all the 
vehicles wirelessly linked to FMS. The report is displayed in the DriveRight FMS Report Viewer. 

To view the Wireless Download Status Report: 

1. Select Wireless Download Status from the Reports Menu. The Wireless Download 
Status Report dialog box is displayed. 
 

 
  

2. Select the company locations in the Select Locations box. 

3. Select an option in the Sort By box by clicking the radio button next to the option. The 
sort options are Vehicle ID, Driver Name, Last Download Status, and Days Since Last Download. 

4. Click OK to create the report or click Cancel to exit the dialog box. 
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5. You can clear the report by selecting Clear Screen in the File Menu or by clicking the 

Clear Screen icon:  

   
Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Mapping Menu 

Mapping Menu 

Note: DriveRight FMS Mapping requires Microsoft MapPoint, Google EarthTM, or Google MapsTM. 
To use Google Earth you must have the Google Earth application installed on your computer (go 
to http://earth.google.com/ for a free download). To use Google Maps you must have any of the 
following three web browsers installed on your computer: 

 Internet Explorer 

 Firefox 

 Safari 

The following commands are available in the Mapping Menu: 

Open Map 

Save Map 

E-Mail Map 

Select Mapping Tool 

Set Speed Range 

See also: 

Mapping Quick Reference Menu 

DriveRight FMS Mapping Requirements 

Back to Menu Commands 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Open Map 

Use the Open Map command to view a previously saved DriveRight GPS map.  

To open a map: 
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1. Select Open Map in the Mapping menu. The Open dialog box is displayed. 

 

2. Click the map file you wish to view and then click Open, or just double-click the file to 
open it. 
 
If MapPoint is selected as the mapping tool, the map is opened in the FMS window; if Google 
MapsTM is selected, the map will open in a web browser; if Google EarthTM is selected, the map will 
open in Google Earth. 

3.  Click the Clear Screen Icon  to remove the map from the FMS window, or use the 
File Menu Clear Screen command. 

 

 

See Also: 

Viewing Maps 

Back to  Mapping Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Save Map 

Use the Save Map command to save a DriveRight GPS map.  

Note: This command is only available if you have chosen MapPoint as your mapping tool. If you 
have chosen Google EarthTM or Google MapsTM as your mapping tool, maps can be saved using 
the menu commands provided by Google Earth or your chosen web browser. 

To save a map: 

1. Select Save Map in the Mapping menu. The Save As dialog box is displayed. 
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2. Enter the file name for the map file then click Save to save the map or click Cancel to 
exit the dialog box without saving the map.  

Note: The Maps directory is located in the DriveRight FMS program folder. 

See Also: 

Viewing a Map 

Back to  Mapping Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

E-Mail Map 

Use the E-Mail Map command to e-mail a DriveRight GPS map.  

Note: This command is only available if you have chosen MapPoint as your mapping tool. 

Note: DriveRight FMS can only e-mail the map currently displayed in the program window. 
Requires MS Outlook. 

To e-mail a map: 

1. Select E-Mail  Map in the Mapping menu. DriveRight FMS opens a new mail message 
window in MS Outlook with the map included as an attachment. 

2. Address the message and edit the subject and content as you desire.  

3. Click Send to send the message or close the message window to cancel the e-mail . 

See also: 

Viewing Maps 
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Back to  Mapping Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Select Mapping Tool 

Use the Select Mapping Tool command to select MapPoint North America, MapPoint Europe, 
Google EarthTM, or Google MapsTM. 

To select your mapping tool: 

1. Select Select Mapping Tool from the Mapping menu. The Select Mapping Tool dialog 
box displays. 

 

2. Select the mapping tool by clicking its adjacent radio button. 

3. Click OK to change the current mapping tool, or click Cancel to exit the dialog box 
without changing the mapping tool. 

When a mapping tool is selected, that tool will be used for all mapping activities until you 
choose a different mapping tool. 

 

Back to  Mapping Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Set Speed Ranges 

You set up to 8 speed ranges to identify vehicle speed in DriveRight FMS mapping reports.  

To set the speed ranges: 

1. Click Set Speed Ranges in the Mapping menu. The Set Speed Ranges dialog box is 
displayed. 
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2. Select the number of speed ranges to be used in mapping reports. Each range will be 
represented by a push-pin of the indicated color when a map is created. 

3. Edit the "To" column to adjust the speeds indicated for each range. 

4. Click OK to save the changes or click Cancel to exit without saving the changes. 

See also: 

Mapping Overview 

Back to  Mapping Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Help Menu 

The following commands are available in the Help Menu: 

 Help Topics 

Opens the Help Topics window showing the Contents, Index, and Search options. 

 About DriveRight FMS 

Displays the program version information, the database type, and the copyright 
information. 
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Back to Menu Commands 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Troubleshooting 

Troubleshooting Menu 

If you encounter problems installing or using DriveRight FMS, please contact Davis Instruments 
Technical Support. 

Note: If you encounter any type of problems, the errors are logged in the log file eventLog.txt, 
present in DriveRight FMS install directory. 

The following DriveRight FMS troubleshooting help is available: 

Device Communication Problems 

Database Connection Problems 

Wireless Device Communication Problems 

SmartCard Desktop Reader Device Communication Problems 

Miscellaneous Problems 

Contacting Davis Instruments 
  

Back to Home 
  

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Device Communication Problems 

Take the following steps if the software does not communicate with a DriveRight or CarChip 
device: 

1. DriveRight devices only - Check to make sure the  DriveRight console is in the 
CURRENT mode instead of in sleep mode. If the LCD screen is blank, the console is in 
sleep mode. Press the MODE key to put the console in active mode..  

2. Check that the correct Serial Port is selected.  

3. If you have other programs running which use the serial port, such as the Palm HotSync 
Manager and the CarChip software, close those programs and try again. 

4. Check if the hardware is ok and that you have a working communication port. If 
necessary, contact your PC supplier. 

See also: 

Communications Port - DriveRight 

Communications Port - CarChip 
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Back to Troubleshooting Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Database Connection Problems 

Since DriveRight FMS supports multiple database systems, things could go wrong during 
database connection due to various reasons. 

 

Database Setup Error 

Refer to the instructions in the message box if you get the following error message: 

 

Database Not Setup Properly 

Refer to the instructions below if you get the following error message: 

 

o If you are using MS Access: The database does not exist at the specified location. 

o If you are using any other database: Either the database server is not running, or you do 
not have enough permissions to connect. Please refer to database configuration in the 
DriveRight FMS Database Selection Guide. 

 

Back to Troubleshooting Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Wireless Device Communication Problems 
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Make sure the Base Station is connected to the USB port of the computer and the bottom LED is 
green. Otherwise, contact Davis Instruments technical support. 

Driver installed successfully but is not communicating with the Wireless Device 

1. Ensure that the Wireless Device driver is correctly installed from the CD. Go to the 
Device Manager on your computer and view the Universal Serial Bus Controllers list. Left 
click on the controller labelled USB Serial Converter and select Properties from the 
menu. If this controller is not listed, see the FMS Getting Started Guide for instructions on 
installing the Wireless Device Drivers. There may be multiple "USB Serial Converter" 
drivers listed depending on the number of wireless devices connected to the computer. 
The Device Properties dialog box displays. The Device Type displayed should be 
"Universal Serial Bus Controllers" and the Manufacturer displayed should be "FTDI". 
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2. Select the Advanced Tab. In the Configuration box, make sure the Load VCP check 
box is unchecked. 
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3. Select the Driver Tab. If the Driver Date is anything other than 5/19/2006, reinstall the 
Wireless Device Driver by clicking Update Device Driver.  A Found New Hardware 
dialog box should display through your operating system.  
 
If the dialog box does not display, check the connection between the hardware and your 
computer, or see your operating system’s documentation for more information. If the 
dialog box still does not display, contact Davis Technical Support for help with this 
problem. 
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4. Click the No, not at this time field and click Next. It is important that you do not allow 
your operating system to automatically check the web for drivers because it could install 
versions of drivers that may have compatibility issues with the accessory or FMS. The 
second dialog box displays. 

 

5. Click Install from a list or specific location and click Next. The Please Choose Your 
Search and Installation Options dialog box displays. 
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6. Click Search for the best driver in these locations and select the check box Include this 
location in the search. 

7. Click Browse. 

8. Navigate to the DriveRight directory. A list of subfolders displays. 
 
When DriveRight FMS is installed, the drivers for the wireless devices are stored under 
the DriveRight directory so that they can be installed at any time wireless devices are 
introduced into FMS. The wireless device drivers are located in the "FTDI Drivers" 
subfolder. 
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9. Select the "FTDI Drivers" folder and click OK.  

10. Install the driver only once, even if installing both the Base Station and the Configuration 
Cable. The driver works seamlessly with both. 

11. Once the installation is complete, click Finish. 

12. Test the communication between FMS and the Base Station by Starting a Wireless Scan 
or Manually Downloading Wireless On-Board Modules. The bottom LED on the Base 
Station should flash orange if it is communicating successfully with the computer. If FMS 
is still having trouble communicating with the Base Station, contact Davis Instruments 
Technical support. 

Base Station Drivers added successfully, still not finding vehicles 

The Base Station can only communicate with the Wireless On-Board Module(s) that belong to the 
same location it was assigned. Check the assigned location for the Base Station and Wireless 
On-Board Modules in the Wireless Devices database table. If they do not share the same 
location, delete the device(s) and re-add them, assigning them all to the correct location. 

Guidelines for setting up Wireless Devices 

Use the following guidelines to ensure good communication between the Base Station and the 
Wireless On-Board Modules in the field. 

 The path between them should be line-of-sight, and not through walls or trees, or around 
corners. 

 The distance between the Wireless On-Board Module and the base station should be 
600ft (200m) or less. 

  With the wire tail up, the Wireless On-Board Module should be mounted high on the 
vehicle windshield and oriented as shown in the GPS/Wireless Interface System 
Installation Manual. 
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 The Base Station should be mounted in a high location with its antenna pointing straight 
up. 

 The Base Station should be mounted away from any other radio transmitters or 
microwave ovens. 

Guidelines for Extending Communication Range 

 Install more than one Base Station to cover a wider area. 

 Due to the limited USB cable length, use a 3rd party device to extend distance between 
the Base Station and the computer. Refer to the Base Station Installation Manual for 
more information. 

 Using non-metallic and weather-proof housing in which to store the Base Station(s) 
outside. 

 Place the Base Station antenna outside where it is visible to the vehicles and use a short 
antenna connection cable. 

 

Back to Troubleshooting Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

SmartCard Desktop Reader Device Communication 
Problems 

Installing Drivers for the SmartCard Desktop Reader 

The DriveRight SmartCard Desktop Reader (# 8108) works with the DriveRight SmartCard 
System to upload data from a DriveRight 600 or 600E to a computer running DriveRight FMS 
version 3.3 or later. The SmartCard Desktop Reader connects to a computer via a USB port. 

USB drivers must be installed for the SmartCard Desktop Reader to properly communicate with 
DriveRight FMS. This can be done during DriveRight FMS installation or at any time a SmartCard 
Desktop Reader is present for set up. A SmartCard Desktop Reader must be available, so it can 
be configured during driver installation. 

Note: The following installation was completed in a Windows XP operating system. The process 
may vary depending on your operating system. 

1. Navigate to the DriveRight directory via MicroSoft Windows Explorer or some other 
means. A list of subfolders displays. 

2. Select SmartCard USB Drivers. Double-click ACS Setup.exe The Installation Wizard 
starts. 
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I  

3. Click Install. The confirmation dialog box displays, alerting you that the driver is being 
installed. Click Yes.  The warning  dialog box displays. 

 

 

4. Disconnect USB SmartCard Reader if it is connected and click OK. The information 
dialog displays. 
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5. Plug in the accessory to an available USB Port and click OK. A Found New Hardware 
dialog box should display through your operating system.  
 
If the dialog box does not display, check the connection between the hardware and your 
computer, or see your operating system’s documentation for more information. If the 
dialog box still does not display, contact Davis Technical Support for help with this 
problem. 

 

6. Click the No, not at this time field and click Next. It is important that you do not allow 
your operating system to automatically check the web for drivers because it could install 
versions of drivers that may have compatibility issues with the accessory or FMS. The 
second dialog box displays. 
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7. Click Install the Software Automatically and click Next. The Hardware Installation 
dialog box displays. 

 

8. Click Continue Anyway. The new drivers install automatically.  

9. Click Finish once the installation is complete.  
 
Once the installation is complete,  ACR38 USB Smart Card Reader (Proprietary Mode) 
should display in the Device Manager under the Universal Serial Bus Controllers list. 
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FMS can now properly recognize the SmartCard Desktop Reader and the correct driver 
displays in the SmartCard Reader Setup dialog box. 

 

 

 

Back to Troubleshooting Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Miscellaneous Problems 

If you selected the wrong database type during the initial program configuration, you can 
manually reset the database type in the config.txt file and then start over all again.  

1. If DriveRight FMS is open, close it. 

2. First locate the configuration file config.txt present in DriveRight FMS install directory. 

3. Open the file (it should come up in MS Notepad), and you’ll see the following text near 
the beginning of the file: 

 

############################################## 

# this variable represents the database type  
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# used to store the data 

# 0- represents Database connection is not yet configured 

# 1- represents MS Access 

# 2- represents MySQL 

# 3- represents Oracle 

# 4- represents MSDE/MS SQL 

############################################## 

DATABASE_TYPE=2 

 

4. Edit the last line, and replace the number by 0 (zero, not capital O). After you edit the 
variable, the text in the file looks like this: 

DATABASE_TYPE=0 

 

5. Save the file and close MS Notepad. 

6. Run DriveRight FMS again and you will prompted to select the database type. If you 
need assistance, refer to the database installation instructions in the DriveRight FMS Database 
Selection Guide. 

 

Back to Troubleshooting Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Contacting Davis Instruments 

You may contact Davis Instruments for technical support or product information using any of the 
methods shown below. 

Technical Support 

Our Technical Support Team is available Monday through Friday, 7:00 a.m. to 5:30 p.m. Pacific 
Time. Or use our website, fax, fax-back, or e-mail any time day or night. 

Phone Technical Support: 510-732-7814  

Fax Technical Support: 510-670-0589  

E-Mail Technical Support 

Automotive Support Web Site  

The Automotive Support section of our web site is your source for DriveRight FAQs, instruction 
manuals, software downloads, and spec sheets. 

Other Ways to Contact Davis Instruments 
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Sales (US & Canada): 800-678-3669  

Sales (Outside the US & Canada): 510-732-9229  

Fax: 510-670-0589  

E-Mail to our Customer Service Department: sales@davisnet.com  

E-Mail comments or general information to info@davisnet.com  

Davis Instruments Web Site 

Visit the Davis instruments web site to find additional products  

 

Back to Menu Commands | Troubleshooting Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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